
Oracle® WebCenter Sites
User’s Guide 

11g Release 1 (11.1.1) Bundled Patch 1 

October 2012



Oracle® WebCenter Sites User’s Guide, 11g Release 1 (11.1.1) Bundled Patch 1

Copyright © 2012 Oracle and/or its affiliates. All rights reserved.

Primary Author: Melinda Rubenau

Contributor: Kannan Appachi, Sean Cearley, Avadhani Chandrashekar, Saikat Chaudhuri, Ravi Khanuja, 
Tatiana Kolubayev, Cory Lum, Deephan Mohan, Patrice Palau, Vijayalakshmi Rajan

This software and related documentation are provided under a license agreement containing restrictions on 
use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your 
license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, 
license, transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means. 
Reverse engineering, disassembly, or decompilation of this software, unless required by law for 
interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If 
you find any errors, please report them to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on 
behalf of the U.S. Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS Programs, software, databases, and related documentation and technical 
data delivered to U.S. Government customers are "commercial computer software" or "commercial technical 
data" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental 
regulations. As such, the use, duplication, disclosure, modification, and adaptation shall be subject to the 
restrictions and license terms set forth in the applicable Government contract, and, to the extent applicable 
by the terms of the Government contract, the additional rights set forth in FAR 52.227-19, Commercial 
Computer Software License (December 2007). Oracle America, Inc., 500 Oracle Parkway, Redwood City, 
CA 94065.

This software or hardware is developed for general use in a variety of information management applications. 
It is not developed or intended for use in any inherently dangerous applications, including applications that 
may create a risk of personal injury. If you use this software or hardware in dangerous applications, then you 
shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its 
safe use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this 
software or hardware in dangerous applications.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of 
their respective owners.

Intel and Intel Xeon are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are 
used under license and are trademarks or registered trademarks of SPARC International, Inc. AMD, 
Opteron, the AMD logo, and the AMD Opteron logo are trademarks or registered trademarks of Advanced 
Micro Devices. UNIX is a registered trademark of The Open Group.

This software or hardware and documentation may provide access to or information on content, products, 
and services from third parties. Oracle Corporation and its affiliates are not responsible for and expressly 
disclaim all warranties of any kind with respect to third-party content, products, and services. Oracle 
Corporation and its affiliates will not be responsible for any loss, costs, or damages incurred due to your 
access to or use of third-party content, products, or services.



3

Table of

Contents
About This Guide  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .11
Audience . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
Related Documents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
How This Guide Is Organized  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Figures and Diagrams . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Conventions Used in This Guide  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Third-Party Licenses . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Part 1. Introduction

1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  17
Introduction to Oracle WebCenter Sites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

From the Content Entry Form to the Website . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
Content Entry Modes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
Previewing Content . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

Exploring Content Management Concepts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
Content: Asset Types and Assets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
Structured Content Assets and Document Assets . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
Multilingual Assets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
Design Assets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
WebCenter Sites Data Models. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
Content Management Sites  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

What Can You Do in the Contributor Interface?. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
Features in the Contributor Interface  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
Oracle WebCenter Sites User’s Guide



Table of Contents
4

Part 2. Working in the Contributor Interface

2 Getting Started . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41
Sample Sites Used in This Guide . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
Logging In . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
Quick Tour  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

Create an Asset  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
Find and Open an Asset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
Switch Between Form Mode and Web Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
Edit an Asset in Form Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
Edit an Asset in Web Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
Preview an Asset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
Additional Ways of Accessing Assets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60
Switch to a Different Site  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
Log out of WebCenter Sites  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
Congratulations!  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

3 Creating, Sharing, and Editing Assets in Form Mode  . . . . . . . . . . . . . . . . .  63
Creating Assets in Form Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

How Many Ways Can You Create an Asset? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64
Creating a New Asset in Form Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64
Creating an Asset by Copying an Existing Asset  . . . . . . . . . . . . . . . . . . . . . . . . . . . 70

Sharing Assets with Other Sites  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
Which Assets Can You Share?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
How Do You Share Assets with Other Sites? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73

Editing Assets in Form Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
Working with Attribute Editors. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

Working with the CKEditor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78
Working with the Image Picker. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79
Working with the Clarkii Online Image Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
Working with the Date Picker . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83

4 Creating, Sharing, and Editing Assets in Web Mode . . . . . . . . . . . . . . . . . .  85
Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86

What is a Slot? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87
What is the Difference Between Web Page Layout and Content Layout? . . . . . . . . 88

Creating Assets in Web Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90
How Many Ways Can You Create Assets? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90
If You Use Web Mode, Will You Need to Switch to Form Mode?  . . . . . . . . . . . . . 90
Creating a New Asset in Web Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90
Creating a New Asset by Copying an Existing Asset . . . . . . . . . . . . . . . . . . . . . . . . 99

Sharing Assets With Other Sites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99
Editing Assets in Web Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99

Editing the Content of an Asset in Web Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99
Changing Web Page Layout  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101
Oracle WebCenter Sites User’s Guide



Table of Contents
5

Changing Content Layout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104
Editing Associations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107

5 Deleting Assets  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  121
Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 122
Asset Deletion Rules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 122
How Do I Delete Assets?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123

6 Finding and Organizing Assets  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  125
Finding Assets  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126

Search Behavior in the WebCenter Sites Contributor Interface . . . . . . . . . . . . . . . 126
Search Guidelines  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126
Searching for Assets  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128

Conducting an Advanced Search. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133
Organizing Assets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135

Bookmarking Assets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 136
Accessing Bookmarked Assets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 137
Unbookmarking Assets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 138
Accessing Assets from the ‘History’ Node . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139

7 Previewing Assets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  141
Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 142
How Do I Preview Assets? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 143
Previewing Future Sites. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 145

About Start and End Dates  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 146
About Future Preview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 146
Impact of Start and End Dates on Future Preview  . . . . . . . . . . . . . . . . . . . . . . . . . 146
Assigning Start and End Dates  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 147
Previewing a Site as It Will Appear at a Future Time. . . . . . . . . . . . . . . . . . . . . . . 149
Approval for Publishing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151

8 Associating Assets  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  153
Working with Asset Associations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 154

Types of Associations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 155
Associating Assets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 156
Disassociating Assets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 159

Parent-Child Relationships . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 161
Working with Grouped Assets  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 163

Working with Collections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 163
Building a Collection. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 164
Working with Recommendations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 166

9 Creating a Site’s Navigation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  169
Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 170
Placing and Unplacing Pages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 171
Oracle WebCenter Sites User’s Guide



Table of Contents
6

Placing a Page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 171
Unplacing a Page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 173

10 Linking Assets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  175
Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 176
Linking Two Assets Directly. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 177

Prerequisites. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 178
To Create a Hypertext Link to Another Asset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 179
To Link Two Assets by Inclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 182

Linking Two Assets via an Image Asset  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 185
Prerequisites. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 185
Linking via an Image from the “Bookmarks” Node . . . . . . . . . . . . . . . . . . . . . . . . 188
Linking via an Image from the Image Picker  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 191

Linking Assets to URLs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 197

11 Working with Multilingual Assets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  201
Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 202
Setting or Changing an Asset’s Locale Designation  . . . . . . . . . . . . . . . . . . . . . . . . . . . 204
Creating a Translation of an Asset  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 205
Examining the Available Translations of an Asset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 209
Changing the Master Asset of a Multilingual Set . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 211

12 Approval for Publishing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  213
Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 214

Dependencies. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 214
Approval States . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 215

Approval Tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 215
Approving an Asset for Publishing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 215
Checking an Asset’s Approval Status . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 219
Removing Assets from the Publishing Queue . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 220

13 Revision Tracking  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  223
Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 224

Checkout and Checkin. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 224
Rollback and Revision History . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 225

Checking Out Assets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 226
Examining Your Checkouts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 228
Undoing a Checkout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 228
Checking In Assets  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 230
Examining Revision History . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 232
Reverting to a Previous Version (Rollback) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 233

14 Workflow. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  235
Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 236

Workflow and Assets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 236
Oracle WebCenter Sites User’s Guide



Table of Contents
7

States and Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 236
Users, Roles, and Participants . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 237
Workflow Assignments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 238
Deadlocks  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 239

Sample Workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 240
Sample Workflow States and Steps. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 240
Sample Workflow Scenario. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 241

Viewing Your Assignments  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 243
Using Workflow Functions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 244

Assigning an Asset to a Workflow  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 244
Setting a Process Deadline. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 247
Setting an Assignment Deadline . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 248
Finishing Your Assignments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 250
Delegating Your Assignments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 253
Abstaining from Voting. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 255
Resolving Deadlocks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 256
Removing an Asset from Workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 257
Viewing an Asset's Participant (Assignee) List. . . . . . . . . . . . . . . . . . . . . . . . . . . . 258
Setting Workflow Participants. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 259
Examining the Workflow Progress of an Asset. . . . . . . . . . . . . . . . . . . . . . . . . . . . 260

Part 3. Using Oracle WebCenter Sites: Engage Assets

15 Oracle WebCenter Sites: Engage Overview  . . . . . . . . . . . . . . . . . . . . . . . .  265
About Merchandising Assets  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 266
Using Segments to Categorize Visitors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 266
Making Recommendations to Segmented Visitors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 266
Basing Promotions on Buying Patterns . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 267

16 Grouping Visitors into Segments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  269
About Segments  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 270

Segments and Visitor Data Assets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 270
Developing Segments: Process Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 270

About the Segment Forms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 271
“Segment Filtering Criteria” Form  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 271
The “Segment Definition” Form . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 273

Creating Segments  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 275
Step 1: Name and Define the Segment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 275
Step 2: Create Segment Filtering Criteria with Visitor Attributes  . . . . . . . . . . . . . 277
Step 3: Create Segment Filtering Criteria with History Definitions . . . . . . . . . . . . 279
Step 4: Define the Segment with Shopping Cart Criteria . . . . . . . . . . . . . . . . . . . . 290

Sample Segment Assets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 292
Publishing Segments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 292
Oracle WebCenter Sites User’s Guide



Table of Contents
8

After You Publish . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 292

17 Creating and Configuring Recommendations. . . . . . . . . . . . . . . . . . . . . . .  293
Recommendation Assets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 294
Asset Selection Factors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 296

Ratings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 296
Confidence. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 298
Selection Criteria  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 299
Sort Criteria . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 300

Asset Recommendation Processes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 301
Static Lists in List Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 301
Static Lists in Recommendation Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 301
Dynamic Lists  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 302
Related Items . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 302

Creating Recommendation Assets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 303
Recommendation Development Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 303
Creating Static Lists Recommendations in List Mode  . . . . . . . . . . . . . . . . . . . . . . 304
Creating Static Lists Recommendations in Recommendation Mode  . . . . . . . . . . . 307
Creating Dynamic Lists Recommendations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 314
Creating Related Items Recommendations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 319

Editing Recommendation Assets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 323
Configuring Assets to Be Recommended . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 325

Assigning Ratings to an Asset  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 326
Configuring Asset Relationships Using Related Items Recommendations. . . . . . . 327

Verifying Recommendation Assets  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 330
Publishing Rated Flex Assets  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 330

18 Creating Promotions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  331
About Promotions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 332

About Promotions and Recommendations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 332
When Promotions Overlap  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 332

Creating Promotions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 334
Step 1: Name and Define the Promotion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 334
Step 2: Define the Goals for the Promotion. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 336
Step 3: Define Which Visitors Are Eligible for the Promotion. . . . . . . . . . . . . . . . 336
Step 4: Define the Discount. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 337
Step 5: Define the Promotion’s Duration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 340
Step 6: Advertise the Promotion on Your Site  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 341

Sample Promotion Asset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 342
Publishing Promotions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 342

Appendices
Oracle WebCenter Sites User’s Guide



Table of Contents
9

A. The Flex Asset Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .345
Overview of the Flex Asset Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 346

B. Navigational Reference  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .347
Menu Bar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 348
Navigation Pane  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 349
Workspace: Home Tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 350

Bookmarks Widget  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 351
SmartLists Widget . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 352
Assignments Widget  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 352
Checkouts Widget . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 353

Workspace: Asset Tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 354
Asset Toolbar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 355
Form Section Selector . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 356

Search/Browse Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 357
Split View: Asset Tab and Search Results List  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 359
Icons. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 360

Index of Procedures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .363

Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .367
Oracle WebCenter Sites User’s Guide



Table of Contents
10
Oracle WebCenter Sites User’s Guide



11
About This Guide
This guide provides an overview of the functionality provided by Oracle WebCenter Sites 
that you as a content provider will utilize to create, edit, and approve content for 
publication on your organization’s online site. 

The Oracle WebCenter Sites application, discussed in this guide, is a former FatWire 
product. Oracle WebCenter Sites is the current name of the application previously known 
as FatWire Content Server. In this guide, Oracle WebCenter Sites is also called WebCenter 
Sites.

Audience
This guide was written especially for content providers — anyone who creates, reviews, 
and approves content from the Oracle WebCenter Sites Contributor interface. Typically, 
content providers are specialists in fields such as corporate communications, finance, 
human resources, sales, and marketing. The content providers’ expertise is rooted in the 
content, not in the software used to manage it. Technical proficiency is not required.

This guide is also helpful to individuals who support content providers, perform their 
functions, or simply need to understand basic concepts of WebCenter Sites. For example, 
this guide is helpful to the WebCenter Sites administrator, who supports content providers 
by developing and customizing the installation to meet their needs. Furthermore, the 
administrator maintains the installation and provides the business users with technical 
services. 

Related Documents
For more information, see the following documents:

• Oracle WebCenter Sites Developer’s Guide.

• Oracle WebCenter Sites Administrator’s Guide.
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How This Guide Is Organized
To help you navigate through the information in this guide, the guide is divided into parts. 
Each part deals with a particular aspect of the Contributor interface, and is divided into 
chapters, each dealing with a particular concept or process. The parts are as follows:

• Part 1: Introduction

This part provides an introduction to WebCenter Sites and its underlying architecture. 
It describes the basic concepts and dependencies on which WebCenter Sites constructs 
are based. 

• Part 2: Working in the WebCenter Sites Contributor Interface

This part describes how to use the WebCenter Sites Contributor interface. It explores 
the basics of the navigation and interaction with the Contributor interface, explains 
tasks common to working with all asset types, and goes on to describe specific tasks 
and processes that you as a content provider will need to accomplish when working 
with WebCenter Sites. 

• Part 3: Working with WebCenter Sites: Engage Assets

The part describes tasks and responsibilities performed by marketers who want to 
target site visitors for marketing campaigns. This part describes Engage and the 
process of working with segments, recommendations, and promotions.

• Part 4: Appendices

This part contains appendix material helpful in further understanding some of the 
concepts presented in this guide.

• Other Helpful Information

The end of the guide includes an index of procedures to help you quickly navigate to 
content management steps, as well as a general index containing most important terms 
and keywords used in this guide which you can use as a quick reference.

Figures and Diagrams
This guide contains figures and diagrams that use parts of the WebCenter Sites 
Contributor interface running the avisports sample site and the FirstSite II sample site. 
Due to the highly customizable nature of WebCenter Sites, your interface might appear 
slightly different from the depictions used in this guide. Because of that, all such 
depictions are for reference only.

Conventions Used in This Guide
To help you navigate and comprehend the information in this guide more easily, the 
following typographical conventions are used throughout:

• bold type – indicates names of buttons, links, fields, and form sections displayed in 
the interface, as well as any information you might be asked to enter verbatim into the 
WebCenter Sites interface. 

• “text in quotes” – indicates names of forms, screens, and drop-down lists displayed in 
the interface.

• italicized type – indicates names of variables, as well as any text that varies depending 
on your selection.

• monospaced type – indicates a URL, a file system path, or a piece of code.
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Third-Party Licenses
Oracle WebCenter Sites and its applications include third-party libraries. For additional 
information, see Oracle WebCenter Sites 11gR1 Bundled Patch 1: Third-Party Licenses.
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Par t  1

Introduction
This part provides an introduction to Oracle WebCenter Sites. It contains the following 
chapter:

• Chapter 1, “Overview”
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Chapter 1

Overview
As a content provider, you create, manage, and deliver website content. Your expertise is 
rooted in the content, not in the software used to manage it. Since this guide is written 
specifically for content providers, it is intended to help you use Oracle WebCenter Sites 
efficiently to perform your content management tasks, without requiring technical 
proficiency.

This chapter contains the following sections:

• Introduction to Oracle WebCenter Sites

• Exploring Content Management Concepts

• What Can You Do in the Contributor Interface?

• Features in the Contributor Interface
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Introduction to Oracle WebCenter Sites
Oracle WebCenter Sites is a software suite that allows you to create and manage content 
for publication to your website. The content is stored in the WebCenter Sites database. 
You create and manage the content using the WebCenter Sites Contributor interface, 
which provides a simple and intuitive way of accessing and working with the database.

The content that you manage depends on the nature of your organization: a news site 
might produce articles, photos, and video clips; a human resources department might 
manage job postings and personnel policies; an online retailer might offer product 
descriptions, special offers, coupons, and so on. Content can be moved from its creation 
on the content management (CM) system to its completion in steps, from person to person, 
in a process called workflow. Along the way, collaborators can modify and comment on 
the content and use revision tracking to audit changes made to the content. Your end goal 
is to publish content so that site visitors can view it. Publishing functions are available in 
the WebCenter Sites Admin interface. 

From the Content Entry Form to the Website
When creating and editing content in WebCenter Sites, you use content entry forms which 
are located on the CM system. Their purpose is to give you an easy, intuitive way to store 
content in the WebCenter Sites database, without having to access the database directly. 
When ready for public delivery, the content can be published to the website using either 
dynamic or static publishing. (For more information about publishing, see the Oracle 
WebCenter Sites Administrator’s Guide)

For example, when the dynamic publishing method is used, the content is published 
(copied) from the CM system to the delivery system. The delivery system then delivers 
that content to the website. The steps for dynamically publishing content to the website are 
shown in Figure 1 and Figure 2, and explained below: 

Step 1, Figure 1. When you populate a content entry form (for example, the “Article” 
form) and save the content, WebCenter Sites stores the content in its CM 
system database. 

Step 2, Figure 1. After you or another user approves the content and initiates the 
publishing process, the content is copied to the delivery system.

Step 3, Figure 1. When the content is requested by a site visitor, it is automatically 
retrieved from the delivery system, formatted, and laid out by code. This 
code is written by developers according to site designers’ specifications.

Step 4, Figure 2. The formatted content is delivered to the visitor’s browser.

In simple terms, a content entry form accepts raw content for storage in the CM system 
database. When published content is requested by a site visitor, the delivery system 
renders the content (unless it is already cached) in viewer-ready form in the visitor’s 
browser.

Note

As a content provider, and throughout this guide, you will work with the CM 
system to create, modify, and perform other processes on the content that is 
delivered to the website.
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A content entry form represents an asset (which is described later in this chapter). Content 
entry forms can be displayed in two modes:

• Form Mode displays a traditional form view that allows you to enter content into 
fields (shown in Figure 1, on page 20 and on the left in Figure 3, on page 22). You can 
then use the Preview option to see how the content would be displayed on the website 
if it were published.

• Web Mode allows you to enter information into the web page view of the content 
(shown on the right in Figure 3, on page 22), which shows you how the content you 
are creating will be displayed when published to the website as you are creating it. 

Content entry forms offer the following advantages:

• Users don’t need to learn the specifics of the WebCenter Sites database.

A content entry form can be thought of as a window into the WebCenter Sites 
database. Content that you enter into a form is stored in the database. Content that you 
retrieve is read from the database and displayed in an editorial version of the content 
entry form.

Because a content entry form provides a standard interface to the variety of databases 
that WebCenter Sites supports, it spares users from having to learn the specifics of any 
database in particular. If one database is replaced with another (for example, SQL 
Server is replaced with DB2) the switch is transparent to users.

• Users don’t need to know HTML or other markup languages.

No content entry form requires its users to format the content they enter or edit. A 
default format (specified in the templates) is applied when a user-defined format is 
unavailable. And when a field displays a WYSIWYG editor (“What You See Is What 
You Get”), you can use its tools to format the field’s content – without having to know 
HTML. As a content provider, you have the option to remain strictly focused on the 
content, or to determine its appearance, as well.

• Work in a drag and drop environment

Certain fields in a content entry form may display a Drop Zone. Drop Zones support 
drag and drop functionality, which provides an easy way to associate one piece of 
content with another. Users can quickly find the desired content (by performing a 
search or so on), drag that content to the desired field’s Drop Zone, and then drop the 
content into the field. 

• Reusability and consistency are maximized.

Each piece of content that you enter into a form can be reused as many times as 
necessary, in as many formats as necessary, in as many locations within the website as 
necessary. Reusability ensures consistency across the site by eliminating the need for 
re-creating content each time it must be used. 
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      Code

rm (Web Mode)
Figure 1: Content entry form (displayed in Form Mode and Web Mode)
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Figure 2: Website (online site)

4 Formatted content is 
displayed on the website.
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Content Entry Modes
In the Contributor interface you can work with content entry forms using either Form 
Mode (shown in Figure 1, on page 20 and on the left in Figure 3) or Web Mode (shown on 
the right in Figure 3).  

Figure 3: Content entry form displayed in Form Mode and Web Mode

As you can see in Figure 3, Form Mode displays a content entry form in its traditional 
form view, which contains clearly labeled fields into which you can enter information for 
the content you are creating. On the other hand, Web Mode allows you to work with the 
web page view of a content entry form. Instead of fields, Web Mode displays slots, 
predefined sample information, and other editable areas into which you can enter 
information. The information you enter will be displayed on the website (once the content 
is published) exactly as it is displayed to you in Web Mode.

In addition to the ability to work in two different modes, the Contributor interface supports 
drag and drop functionality which is available in both Form Mode and Web Mode.

ntent entry form displayed in Form Mode Content entry form displayed in Web Mode
Oracle WebCenter Sites User’s Guide



Chapter 1.  Overview

 Introduction to Oracle WebCenter Sites  
23
Working With a Drop Zone in Form Mode
When you work with content in Form Mode, you may see fields that support drag and 
drop functionality. A field that supports drag and drop functionality displays a Drop Zone. 
To populate a drag and drop field, you select a piece of content from a search results list or 
navigation tree and drop (place) that content into the field’s Drop Zone.

Figure 4: Working with Drop Zones (drag and drop fields)

For detailed information and instructions about working with content in Form Mode, see 
Chapter 3, “Creating, Sharing, and Editing Assets in Form Mode.”

Content entry form displayed in Form Mode containing drag and drop 
fields into which you can drag and drop content such as an image.

Drag the content to the field 
displaying a Drop Zone 
(drag and drop field).

When you drop the content 
into the Drop Zone, the 
name of the content is 
displayed in the field.
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t) 
 

Working With a Slot (Coded with a Drop Zone) in Web Mode
When working with content in Web Mode, you may see slots that support drag and drop 
functionality. These slots are coded with a Drop Zone. A slot that is coded with a Drop 
Zone allows you to select a piece of content, from a tree or search results list, and then 
drag and drop (place) the selected content into it. The content is displayed in the slot as it 
would be displayed on the website, which enables you to visualize the associations you 
make between the pieces of content in your WebCenter Sites system.

Figure 5: Working with a slot coded with a Drop Zone 

For detailed information and instructions about creating content in Web Mode, see 
Chapter 4, “Creating, Sharing, and Editing Assets in Web Mode”

When you drop the content 
into the slot, (if the slot 
supports that type of conten
the content is rendered as it
will be displayed on the 
website once the content is 
published.

Article asset displayed in Web Mode with slots into which you can drag and drop content 

Drag the content to the 
appropriate slot
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Previewing Content
The Preview function enables you to view how the content you create or edit would look if 
it were published to the website. Unlike working with content in Web Mode, when you 
preview a piece of content you are not able to edit it (as shown in Figure 6).

Figure 6: Previewing content

The preview function displays only the web page view of the content. It does not provide 
any options for editing the content you are previewing. If you wish to edit the content, you 
must work with it in either Form Mode or Web Mode. For information about switching to 
either Form Mode or Web Mode to edit an asset that you are currently previewing, see 
step b on page 59 in the section “Preview an Asset.” 
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Exploring Content Management Concepts
WebCenter Sites defines content in terms of assets, and asset types, which are used 
throughout this guide. 

Content: Asset Types and Assets
Content items that you manage using WebCenter Sites are called assets, for example, 
articles, product descriptions, advertisements, photos, and video clips. 

An asset type is an object that defines to WebCenter Sites users the type of content they 
are expected to provide. An asset type is used to create assets of that type. For example, if 
you publish magazine articles and sports car advertisements, you would create the 
magazine articles from the “Article” asset type and the advertisements from the “Sports 
Car” asset type. 

Each asset type is represented in the WebCenter Sites interface as a content entry form 
(such as the one you see in Figure 1, on page 20) whose field names map to the column 
headings of a database table (or multiple tables), used to store your field values. Because 
the set of field names defines the asset type, it also defines the type of content you are 
expected to provide. When you type in field values and save them, you create a record—
an “asset”—in the WebCenter Sites database table. That asset is content, which you can 
edit or delete, pass through a workflow, and publish.  

Figure 7 illustrates the concept of asset type and asset by relating a news article to the 
“Article” asset type.

Note

By entering information into the content entry form, you never have to access the 
database directly.
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Figure 7: Relation between an asset and its asset type  

Headline Abstract Author Body
Firm Announc New Technology Jane Doe NEW YORK, Oct

Headline Abstract Author Body

Firm 
Announc

New 
Technology

Jane Doe NEW YORK, 
Oct

“Article” Asset Type

When you save an asset 
(a news article in this 
example), it is stored in 
the database as a line 
item in one or more 
tables. Because of the 
content entry form, you 
never have to access the 
database directly.

New Technology Announced

Firm Announces New Techno

Jane Doe

NEW YORK, October 1, 2010 (A2Z 
Media)--. A major technology firm 
announced a new product line that will 
embed computer technology into area 
rugs and welcome mats. The new “step-
on” technology will sense body weight 
and temperature and has any number of 
uses, including security, weight 
management, and disease control. “We 
are currently working with the 
Department of Defence to design area 
rugs for their offices,” said a key

Field values 
(entered by a 
content provider) 
define the asset.

Field names 
(created by 
a developer) 
define the 
asset type.
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An asset type is reusable, allowing you to create many unique assets from a single content 
entry form. Each asset is an instance of its asset type.

In our example in Figure 7, on page 27, we have the “Article” asset type from which a 
content provider created a news article on the subject of Technology. Other content 
providers created the Finance Article asset, the Gardening Article asset, the Sports Article 
asset, and the Music Article asset (shown below), all of which are instances of the 
“Article” asset type. Each instance is stored as a record in the “Articles” database table.

In the next example, we have the “Sports Car” asset type, with a different set of fields, 
from which content providers created the Lotus, Ferrari, Maserati, and Bugatti assets. All 
are instances of the “Sports Car” asset type. Each instance is stored as a record in a 
database table named “Sports Car.”  

Finance
Article

 Gardening
Article

 Music
Article

Sports
Article

 Lotus
Esprit

 Ferrari

Maserati

200SI

    330

Bugatti
Type 35B
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Typically, developers create many different asset types, giving you an appropriate range 
and type of content to create and publish. Each asset type has its own content entry form, 
formatted as shown on page 27, but with a unique set of fields. When saved, an asset is 
stored in the WebCenter Sites database. The asset can be edited, inspected, deleted, 
duplicated, placed into workflow, tracked through revision tracking, searched for, and 
delivered to the website.

Note

To be technically accurate, field names in a content entry form are attributes. The 
distinction is important to administrators and developers, but does not affect the 
content provider’s work or understanding of content management in WebCenter 
Sites. For this reason, the terms “field” and “attribute” are used interchangeably 
throughout this guide.
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Structured Content Assets and Document Assets
As a content provider, you are likely to manage two kinds of assets: structured content 
assets and document assets. The difference is that a structured content asset requires you 
to enter prescribed pieces of content directly into the WebCenter Sites interface, whereas a 
document asset requires you to provide a file with the content (or layout) of your choice. 
The developer who creates the asset type specifies whether the asset type supports 
structured content, or documents, or both.

Structured content is used to enforce uniformity, standards, and reusability. By contrast, 
file-based content is used when a free-style approach is acceptable. File-based content 
gives you the freedom to compose content of your own choice, and to present it in your 
own format.

• When creating a structured content 
asset, you enter the content directly 
into a form (as explained earlier). The 
fields impose content structuring by 
prompting you for specific 
information—for example, a 
headline, a byline, and body text (as 
shown in the inset).

When the content is published, its 
format and layout (predetermined by 
site designers) are implemented in the 
template that you choose to render the 
content.

• When creating a document asset, 
you enter content into a file of the 
format of your choice (for example, a 
Word document), then attach the file 
to the document asset. Optionally, 
you enter information describing the 
content, such as name, file size, 
format, or associated keywords, into 
the additional fields that developers 
might have created to help you 
describe the file and its content.

Depending on how your site is 
designed by developers, you might 
encounter assets that accept both 
structured and document-based 
content – for example, an “Article” 
asset that accepts an image file to 
accompany the article text. You will 
provide both types of content when 
creating or editing such assets.

Structured Content Asset

Document Asset
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Multilingual Assets
If your organization maintains localized sites for different geographic regions, each piece 
of content you create is likely to be translated into languages other than the one in which 
the content was originally created.

WebCenter Sites allows you to assign a locale designation to each asset, and to group 
together assets that are translations of one another. This way, you can easily track, manage, 
and publish multiple translations of your content.

For example, a global press release written in English can be translated into French, 
Spanish, and German, and the translations published on the respective regional sites. The 
press release and its translations exist in the WebCenter Sites database as separate assets, 
linked with each other into a multilingual set. Members of multilingual sets can be 
managed, passed through workflow, approved, and published to one or more destinations 
just like their non-localized counterparts.

On the other hand, you are free to create assets in different languages and assign locale 
designations to them independently of one another, without creating the translation links. 
For example, you would treat in this way content that is specific to one region only and 
should not be translated nor published elsewhere.

When configuring your site for multilingual support, your developers provide the site 
visitors with a way to specify their preferred language. The delivery system then 
determines (by checking which locales are enabled for the site, and through locale 
filtering, if applicable) which translation of each asset is displayed on the website.

Design Assets
Structured content assets are called design assets if they are used to format and organize 
website content. Design assets are created by developers for your use. Your access to 
design assets depends on which design assets were created and on the permissions granted 
to you by your WebCenter Sites administrator. The following list describes the design 
assets you can use (given the appropriate permissions).

• “Template” assets create the look and feel of the website. As a content provider, you 
assign “Template” assets to structured content assets to apply specific formatting to 
your content. Each “Template” asset formats assets of a specific type. How your site 
developers code the templates determines how an asset’s content entry form is 
displayed in Web Mode and how the asset will be displayed on the website. Consult 
your site developers for instructions on how to work with the “Template” assets 
available to you. 

• “Page” assets are “containers” that reference the assets constituting a page (or a 
portion of a page) in the website; they provide the structure and organization for the 
displayed content.  

When you create a page asset, you determine its appearance by selecting a layout 
(template asset) from the options provided to you by your developers. You can also 
modify an existing page asset by invoking it from the Site Tree or a list of search 
results. 
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WebCenter Sites Data Models
Asset data models define how content is stored in the WebCenter Sites database—in either 
a flat (single-level) or hierarchical (multi-level) structure. In WebCenter Sites, the flat 
model is referred to as the basic model, and the hierarchical model as the flex model.

The data model is chosen by the developers during asset type creation to suit site design 
requirements. In most of your tasks as a content provider, the distinction between the asset 
models is not relevant, since the majority of the functions you perform in WebCenter Sites 
are the same whether you are working with basic or flex assets. This guide indicates when 
a function or situation is unique to either basic or flex assets. Consult your administrator to 
determine the assets model(s) used on your site.

Basic vs. Flex
The differences between the basic and flex asset models are summarized below:

• Basic assets are instances of basic asset types and always have the same set of 
properties (attributes), as defined by the asset type. They can be associated with other 
assets to form single-level “parent-child” dependencies, but they cannot inherit each 
other’s properties. Thus, no complex hierarchies can be created with the basic asset 
model.

• Flex assets have the ability to inherit structure and content from multiple parents and 
grandparents, which makes them excellent for building complex hierarchical data 
structures (for example, creating large online catalogs of products). Unlike basic 
assets, flex assets in a given flex family can have different properties (attributes) based 
on the established hierarchy and inheritance rules set up by the administrator. For 
more information, see Appendix A, “The Flex Asset Model.”
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Content Management Sites
A content management (CM) site is the backend for the website or one of its sections, and 
like everything else in WebCenter Sites, it is stored in the WebCenter Sites database. A 
CM site is the structural and logical framework that references several types of 
information:

• A CM site references all of the assets, asset types, and asset relationships that 
constitute the actual website (or a section of it).

You can view a hierarchical representation of the site design for the CM site you are 
logged in to by clicking the Site Tree bar in the navigation pane. For example, a 
section of the site tree for the avisports sample site looks like this:

Notice the hierarchical structure in which the content is organized.

• A CM site also references the users, roles, and workflow processes used to manage 
and organize the site’s content. The WebCenter Sites administrator is responsible for 
managing these objects. Which CM sites you can work with is determined by the 
permissions granted to you by the WebCenter Sites administrator. 

If you have permissions to work with more than one site, a site select screen appears 
when you log in to Oracle WebCenter Sites, allowing you to select the CM site and the 
application you want to work with. If you have permissions to work with more than 
one application that is associated with the site, select the icon for the Contributor 
interface. You can also switch between CM sites during your session using the “Sites” 
drop-down menu located on the applications bar. To access the applications bar, click 
the down-arrow at the extreme right of the menu bar.

Once you are granted access to a site, the administrator also grants you permissions to 
perform specific tasks within the site. For example, you may have the permissions to 
edit assets but not delete them.

It is important to note that a CM site is not synonymous with the website that visitors see 
in their browsers. For example, a small website might have all of its assets contained in 
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one CM site. A very large web site, on the other hand, might be divided into several 
sections, each contained in and managed through a separate CM site. A WebCenter Sites 
CM site is thus the supporting structure behind the actual website (or a section of it), but 
they are not one and the same.

What Can You Do in the Contributor Interface?
The Contributor interface provides the features listed in Table 1, on page 35 which you 
will use to work with assets. Whether you can access the assets and how you can work 
with them is determined by the following:

• The role(s) assigned to your user name by the administrator. These roles grant you the 
permissions to work with features of the Contributor interface. If you do not have the 
right permissions, the function (such as creating content) is unavailable to you – it is 
either grayed out, hidden from your interface, or it produces an error message when 
you attempt to use it. 

• Your access permissions (which are roles-based) determine the content management 
functions you can perform on individual assets (functions such as creating, viewing, 
or editing assets). 

• Whether an asset is part of a workflow and whether that asset is assigned to you or 
another user. If the asset is assigned to another user, you will not be able to work with 
it.

• If revision tracking is enabled and another user has checked out the asset you wish to 
work with, you will not be able to edit or delete that asset until the user checks the 
asset back in.

• If an asset exists on your current site because it was shared from another site, you can 
work with that asset only in its native site (the site on which it was created).

• If a publishing session is running and the asset you are accessing is being published, 
you will not be able to edit or delete that asset until the publishing session is complete.

Note

Throughout this guide, the phrase “current site” refers to the CM site you are logged 
in to at the time, and not the website that the visitors access.
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Features in the Contributor Interface
Table 1 lists the features available in the Contributor interface. Features that are not 
supported by the Contributor interface, are available only in the WebCenter Sites Admin 
interface. 

Table 1: Features in the Contributor interface

Feature Contributor Admin

Administrative Controls

Perform administrative tasks 

Work with system-defined asset types:

Template

CSElement

SiteEntry

DimensionSet

Dimension

Parent Definitions

Attributes

Flex Definitions

The following system-
defined asset types can 
be inspected from the 
Contributor interface, but 
can be created and edited 
only in the Admin 
interface.



Work with system-defined asset types for 
application registration:

FW_Application

FW_View



Asset Model

Work with basic assets 

Work with flex assets 

Editorial Functions

Create and copy assets in Form Mode 

Create and copy assets in Web Mode 

Edit assets in the Form Mode 

Edit assets in the Web Mode 

Add, replace, remove, and position assets on a 
page (Web Mode)



Delete assets 

Finding Assets

Perform simple searches Powered by Lucene 
search engine

Form-based search for 
system-defined types o
assets
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Perform advanced searches Powered by Lucene 

search engine
Form-based search for 
system-defined types o
assets

Sort search results  

Save search criteria  

Search attribute values 

Visually browse a site’s structure (site plan)  

Visually browse flex family hierarchies  

Organizing Assets

Work with the History list (which lists assets 
you have worked with in the current session)



Share assets across sites  

Bookmark assets for future reference  

WYSIWYG Editors

Work with CKEditor 

Work with the DatePicker 

Work with the Image Picker 

Work with the Clarkii Online Image Editor 
(Clarkii OIE)

Only in Form Mode

Preview Assets

Set start/end dates when assets can be 
previewed.



Preview assets as they will appear at the current 
time



Preview assets as they will appear at a future 
date (“Site Preview”)



Asset Associations

Associate assets with other assets 

Assign templates to assets 

Assign assets to pages 

Work with collections 

Place and unplace pages  

Linking Assets using CKEditor

Create a hypertext link to another asset 

Table 1: Features in the Contributor interface

Feature Contributor Admin
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Link two assets by inclusion 

Link two assets via an image asset 

Link two assets via “Image Picker” 

Create a link to a URL 

Embedding Links 

Note:  Applies to standard text fields and fields enabled with a supported 
WYSIWYG editor (CKEditor).

Embed links to other assets 

Embed contents of other assets by reference 

Embed links to external web sites 

Multilingual Assets

Assign locale designations to assets 

Work with linked translations of content 

Workflow

Pass assets through workflow 

Work with workflow groups 

Work with workflow reports 

Engage

Work with segments 

Rate assets for segments 

Work with promotions 

Work with recommendations 

Publishing

Approve assets for publishing 

Remove assets from the publishing queue 

Publish assets 

Monitor and manage publishing sessions 

Revision Tracking

Track revisions to assets 

Roll assets back to previous versions 

Table 1: Features in the Contributor interface

Feature Contributor Admin
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Working in the Contributor Interface
Assets are objects that serve as the building blocks of websites. They can be created, 
edited, inspected, deleted, duplicated, translated, assigned to workflow, tracked through 
revision tracking, searched for, previewed, and approved for publishing. Although there 
can be many different types of assets, you work with all of them in similar ways, using the 
same procedures. 

This part describes how to use the WebCenter Sites Contributor interface to perform 
simple and advanced asset management tasks. It contains the following chapters:

• Chapter 2, “Getting Started”

• Chapter 3, “Creating, Sharing, and Editing Assets in Form Mode”

• Chapter 4, “Creating, Sharing, and Editing Assets in Web Mode”

• Chapter 5, “Deleting Assets”

• Chapter 6, “Finding and Organizing Assets”

• Chapter 7, “Previewing Assets”

• Chapter 8, “Associating Assets”

• Chapter 9, “Creating a Site’s Navigation”

• Chapter 10, “Linking Assets

• Chapter 11, “Working with Multilingual Assets

• Chapter 12, “Approval for Publishing”

• Chapter 13, “Revision Tracking”

• Chapter 14, “Workflow”
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Chapter 2 

Getting Started
This chapter describes how to log in to and use the WebCenter Sites Contributor interface.

It includes the following sections:

• Sample Sites Used in This Guide

• Logging In

• Quick Tour
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Sample Sites Used in This Guide
Procedures in this guide use the avisports and FirstSite II sample sites to illustrate how to 
use content management functions in the WebCenter Sites Contributor interface. You will 
have access to these sample sites only if they were installed with your WebCenter Sites 
system. If no sample sites were installed, contact your WebCenter Sites administrator.

The sample sites used in this guide are:

• avisports – a sports-centric sample site containing sports articles illustrated with 
images. In this guide, avisports is used to illustrate features in the WebCenter Sites 
Contributor interface such as creating and editing assets in Form Mode and Web 
Mode, deleting assets, associating assets, linking assets, approving assets for 
publishing, finding and organizing assets, tracking assets with revision tracking, and 
creating a site’s navigation.

• FirstSite II – an online electronics retail site that includes articles, images, a product 
catalog with several product entries, documents, and sample user accounts. In this 
guide, FirstSite II is used to illustrate the workflow, multilingual, and preview features 
in the WebCenter Sites Contributor interface. FirstSite II is also used to describe 
Engage and the process of creating and working with segments, recommendations, 
and promotions in the Contributor interface.

FirstSite II and avisports both utilize the best practices in WebCenter Sites CM site 
development. Additionally, the code for both sample sites can be reused and modified to 
suit your organization’s business needs.

Logging In
Follow instructions in this section to log in to the WebCenter Sites Contributor interface.

To log in to Oracle WebCenter Sites

1. Open your browser and enter the Oracle WebCenter Sites URL.

http://<server>:<port>/<context>/login

where <server> is the host name or IP address of the server running WebCenter 
Sites, <port> is the port number of the WebCenter Sites application, and <context> 
is the name of the WebCenter Sites application that was deployed on the server.

Note

• If you need login information, see your WebCenter Sites administrator for 
the following: WebCenter Sites URL, your user name and password, and the 
list of supported browsers. 

• To more easily follow the steps in this guide, you can log in to either the 
avisports or FirstSite II sample site. Both sites are used, interchangeably, 
throughout this guide to illustrate the WebCenter Sites application. In step 2, 
use the following credentials:

Username: fwadmin
Password: xceladmin
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The Oracle WebCenter Sites login form is displayed. 

2. Log in to WebCenter Sites:

a. Enter your user name and password into the login screen.

b. If you want WebCenter Sites to store your credentials and enter them 
automatically the next time you log in, select Remember me. 

c. Click Login.

3. If you are logging in for the first time, the following screen is displayed; otherwise, 
you are logged in to the application you last visited:

Select the site to which the Contributor application is assigned, and the Contributor 
interface icon. 

The WebCenter Sites Contributor interface loads. 
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- If you logged in to avisports, you will see the following:

- If you logged in to FirstSite II, you will see the following:

4. Proceed to the “Quick Tour,” on page 45. 
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1. If you are not already logged in to WebCenter Sites, log in as the fwadmin user 

(password: xceladmin) and access avisports. For instructions, see “Logging In,” on 
page 42.

WebCenter Sites opens the Contributor interface, which displays your dashboard, 
located on the Home tab (Figure 8).

2. Browse the Contributor interface to familiarize yourself with the different content 
management operations you can perform.

Figure 8: The Contributor interface dashboard for the avisports sample site

Menu bar

- Content – Create assets, save, approve for publishing, bookmark, share 
assets with different sites, and change the access permissions of an asset

- Edit – Inspect, modify, copy, and delete assets, work with revision tracking, 
and change the layout (template) assigned to an asset

- View – Preview assets, view an asset’s status summary (including its workflow 
and approval status), and toggle between Form Mode and Web Mode

Search functions
Enter your search criter

Navigation Pane

- Access assets via the 
Site Tree, Content Tree, 
and My Work tree.

- Place and unplace pages 
on your site.

Your Dashboard/Workspace

- View and work with the items in your dashboard (in the Home tab) such as 
SmartLists, bookmarked assets, assignments, and assets that are checked out
you.

- Work with assets in either Form Mode or Web Mode. WebCenter Sites opens a
new tab for each asset you select to work with.

- Navigate search results and other asset lists. 

Open the applications
to switch to another site
application, or to log ou
WebCenter Sites

b
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Your dashboard displays widgets that provide quick access to your saved search 
criteria (SmartLists), bookmarked assets, workflow assignments, and assets you have 
checked out using revision tracking.  

In the rest of this section, you will complete the following exercises:

- Create an asset (page 47)

- Find and open an asset (page 49)

- Switch between Form Mode and Web Mode (page 52)

- Edit an asset in Form Mode (page 53)

- Edit an asset in Web Mode (page 56)

- Preview an asset (page 58)

- Additional ways of accessing assets (page 60)

- Switch to a different site (page 61)

- Log out (page 61)

Note

What are your permissions to content? Here, you logged in as fwadmin 
which grants you access to the entire Contributor interface. In reality, the access 
you have to the Contributor interface is focused on certain tasks such as creating 
or editing content or both. For more information about permissions, see 
“Features in the Contributor Interface,” on page 35.
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Create an Asset
1. In the menu bar, select Content > New > select the type of asset you wish to create (in 

this example, we select the Article asset type).

2. The Contributor interface provides two modes for working with assets – Form Mode 
and Web Mode. The mode in which you create assets is determined by your site 
administrator. Continue to one or both of the following sections:

- To create an asset in Form Mode

- To create an asset in Web Mode 

To create an asset in Form Mode

If the asset type is configured such that all assets of that type open in Form Mode, the 
content entry form for the new asset is displayed in the tab. 

a. Fill in the fields. For information about the different fields, see step 4 on page 66.

Note

In the Contributor interface, most content management functions are accessible 
from the menu bar.
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b. Save the asset and close the tab. In the menu bar, select Content > Save & Close.

WebCenter Sites saves the asset to the database, unless:

- You have left out one or more required fields in one or more sections

- An entry or selection you have made in one or more sections is not permitted

If either of the above is true, WebCenter Sites displays an error message indicating 
the offending fields. Correct the errors, then save the asset.

To create an asset in Web Mode

If the asset type is configured such that all assets of that type open in Web Mode:

a. In the “Create Asset” dialog box, select the desired layout, enter a name for the 
asset you are creating, and then click Continue.

The tab displays the new asset’s Create view in Web Mode:

b. Point to the different areas of the asset to determine which areas accept content. 
Areas that accept content become highlighted when you point to them.
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c. Click in the highlighted areas to determine the type of content each area supports. 
Then, populate the asset’s Create view. For information about the different fields, 
see step 7 on page 94. 

d. Depending on how your developers have coded the layout (template) assigned to 
the asset, certain fields may only be available in Form Mode. In this case, switch 
to Form Mode and fill in the fields. For instruction about switching between Form 
Mode and Web Mode, see “Switch Between Form Mode and Web Mode,” on 
page 52.

e. Save that asset and close the tab. In the menu bar, select Content > Save & Close.

WebCenter Sites saves the asset to the database, unless:

- You have left out one or more required fields in one or more sections

- An entry or selection you have made in one or more sections is not permitted

If either of the above is true, WebCenter Sites displays an error message indicating 
the offending fields. Correct the errors, then save the asset.

Find and Open an Asset
Now that you have created an asset, you can find it by performing a search in the 
Contributor interface. For example, say the asset you created in the previous section 
contains the word “ski”:

1. In the Search field, enter ski. 

a. If you want to narrow your search results down to a specific asset type, click the 
down-arrow icon in the Search field. In the “Search Type” list, select the desired 
asset type.

If you do not narrow your search down by asset type, WebCenter Sites will search 
for any asset that contains the word “ski.”

b. If you want to further narrow your search down (such as searching for a specific 
attribute) you can conduct an advanced search:

1) In the Search field, click the down-arrow icon.

2) In the “Search Type” list, click Advanced Search.

3) In the “Advanced Search” form, enter the desired search criteria into the 
available fields.

For more information about searching for assets, see Chapter 6, “Finding and 
Organizing Assets.”

2. If you are running a regular search or an asset type search, click the magnifying glass 
( ) button in the Search field. If you are running an advanced search, click Run 
Advanced Search in the “Advanced Search” form.

Click t
button
field, t
asset 
an ad
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A “Search” tab opens in the workspace displaying a list of assets matching your 
search criteria.

The search results list shows a brief summary of information about each item in the 
list, such as name, asset type, and modification date. 

3. In the list of search results, do the following:

a. Click a column heading to sort the search results by the selected criterion. To 
reverse the sort order, click the same column heading again.

b. Click the Next ( ) arrows at the bottom right of the screen to go to the next 
page of results; click the Previous ( ) arrows to go to the previous page.

c. Bookmark select assets to easily retrieve them at a future time. Bookmarking an 
asset adds it to the Bookmarks node in the My Work tree (in the navigation pane) 
and in the “Bookmarks” widget on your dashboard. 

For instructions on bookmarking assets, see “Bookmarking Assets,” on page 136. 
For information about accessing assets from the trees in the navigation pane, see 
“Additional Ways of Accessing Assets,” on page 60.

4. Open an asset’s Inspect view from the search results list:

a. In the list of search results, click the name of the desired asset (in this example, we 
open the 25 Nevada Resorts Serving Snow “Article” asset).
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You can also right-click the name of an asset to render a menu of content 
management functions you can perform.

A tab opens in the workspace, showing the asset’s Inspect view in either Form 
Mode or Web Mode. In this example the asset is displayed in Form Mode.      

Form section 
selector

Asset
display
asset 
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Name of the asset on 
which you are working

Asset 
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b. Inspect your asset, and any information relating to it. 

- If you are in Form Mode, select different sections of the form. The form 
sections you see are determined by how your WebCenter Sites developers 
have configured the asset’s type. 

- If you are in Web Mode, the tab displays the asset as it would be displayed on 
the website. Therefore, you will not see a form section selector. Depending on 
how your developers coded the layout (template) assigned to the asset, certain 
fields (that you see in Form Mode) may not be shown in Web Mode. To view 
and modify these fields you will have to switch to Form Mode. 

Switch Between Form Mode and Web Mode
When working with an asset, you can switch between Form Mode and Web Mode. For 
example, if an asset opens in Form Mode and you want to work with the asset in Web 
Mode, you can use the Mode switch in the asset’s toolbar to switch to Web Mode and vice 
versa.

1. If the asset is not already open, find and open the desired asset. For instructions, see 
“Find and Open an Asset,” on page 49.

A tab opens displaying the asset’s Inspect view in either Form Mode or Web Mode.

2. Switch between Form Mode and Web Mode. Do the following:

- If the asset opens in Form Mode, switch to Web Mode by clicking the Mode 
switch in the asset’s toolbar.

The tab re-displays the asset in Web Mode. 

Mode switch
Oracle WebCenter Sites User’s Guide



Chapter 2.  Getting Started

 Quick Tour
53
- If the asset opens in Web Mode, switch to Form Mode by clicking the Mode 
switch in the asset’s toolbar.

The tab re-displays the asset in Form Mode.

Edit an Asset in Form Mode
When an asset opens in Form Mode, you will see its content entry form displayed in a tab. 
You can make changes to the asset by modifying the information displayed in the fields of 
the form. 

1. If the asset is not already open, find and open the desired asset in its Inspect view. For 
instructions, see “Find and Open an Asset,” on page 49.

2. If the asset opened in Web Mode, switch to Form Mode. For instructions, see “Switch 
Between Form Mode and Web Mode,” on page 52.

3. Edit the asset in Form Mode. For example, if you found some errors in the content and 
want to correct them, you would do the following:

a. In the asset’s toolbar, click the Edit ( ) icon.

Mode switch
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The tab displays the asset in its editable form. 

Both the asset type and the name of the asset are displayed directly below the 
asset’s form section selector.

b. Make changes to the content of the Name and Headline fields.

Note that fields whose names have an asterisk next to them are required, which 
means you cannot leave them blank. If you leave a required field blank, 
WebCenter Sites will not let you save the asset. 

Note

Depending on how your site is set up, one or more of the asset’s fields may 
be WYSIWYG-enabled. A WYSIWYG-enabled field allows you to apply 
MS Word-style formatting to your content right in the asset’s Edit view. For 
more information, see “Working with the CKEditor,” on page 78.

oolbar

ype and name 
sset you are 
 on

ith an asterisk 
them are 
d

ection Selector
Oracle WebCenter Sites User’s Guide



Chapter 2.  Getting Started

 Quick Tour
55

 

c. Click within the Body field to load CKEditor. 

When CKEditor appears, make changes to the displayed text. If you are familiar 
with Microsoft Word, explore the features available in CKEditor – its 
functionality mimics that of Word.

d. Once you have finished making your changes, save the asset. In the asset’s 
toolbar, click the Save ( ) icon

When you click the Save icon, WebCenter Sites saves the changes you have made 
to the asset so far, but keeps the Edit view of the asset open. (You can also select 
Content > Save from the menu bar for the same result.)

e. Inspect the asset. In the asset’s toolbar, click the Inspect ( ) icon.

The tab re-displays the asset’s Inspect view in Form Mode, showing the changes 
you have made to the asset.

WYSIWYG
editor 
controls
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Edit an Asset in Web Mode
Web Mode offers in-context editing, which means you can create and edit an asset in the 
context of the website. Web Mode displays an asset as it would be displayed on the 
website if it were published. To edit the content of an asset in Web Mode, do the 
following:

1. If the asset is not already open, find and open the desired asset. For instructions, see 
“Find and Open an Asset,” on page 49.

2. If the asset is displayed in Form Mode, switch to Web Mode. For instructions, see 
“Switch Between Form Mode and Web Mode,” on page 52.

The tab displays the asset’s Inspect view in Web Mode:

3. In the asset’s toolbar, click the Edit ( ) icon.

The tab displays the asset’s Edit view in Web Mode.
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4. Point to the different areas of the asset to determine which areas are editable. Editable 
areas will be highlighted when you point to them.

5. Click in the highlighted areas to determine the type of content each area supports.

- When you click in a slot, a toolbar is displayed with content management options 
you can perform on the asset contained within the slot, as shown below.

You can replace the content of the slot with another asset by dragging and 
dropping an asset from the Content Tree, My Work tree, or a search results list 
into the desired slot. You can also edit the content of the asset currently contained 
within the slot or change how the asset will be displayed on the website by 
changing the layout of the slot containing the asset.

Slot toolba
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- When you click in a text area, you will either see a simple text field or a 
WYSIWYG-enabled text field, as shown below:

For more information about working with slots and text areas, see step 7 on page 94.

6. If you are finished with your changes, click the Save ( ) icon to save your changes.

Preview an Asset
Previewing assets enables you to see how the asset will look when published to the 
website. Unlike working with an asset in Web Mode, when you preview an asset, you 
cannot make any changes to the asset’s content. You do, however, have the choice to view 
the asset with a different layout (template) or wrapper.

1. If the asset is not already open, find and open the desired asset. For instructions, see 
“Find and Open an Asset,” on page 49.

2. In the asset’s toolbar, click the Preview ( ) icon.

Simple text
area

WYSIWYG
enabled tex
area
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3. If the asset does not have a template assigned to it, the “Select Preview Template” 
dialog box opens. Select the template you wish to use to preview the asset and then 
click Apply.

The tab displays the preview of the asset (which is how the asset will appear on the 
website once it is published).

a. In the preview of the asset, review the content you have edited. Note any changes 
to the asset you still want to make.

b. If you would like to make additional changes to the asset, do the following:

1) In the asset’s toolbar, click the Go Back ( ) icon.

The tab re-displays the asset’s Inspect view (in either Form Mode or Web 
Mode).

2) In the asset’s toolbar, click the Edit ( ) icon.

3) Make the desired changes and then save the asset.
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Additional Ways of Accessing Assets
In addition to performing a search, you can also access assets using the Site Tree, 
Content Tree, and My Work tree, which are located in the navigation pane.

1. In the navigation pane, click one of the following 
bars:

- Site Tree – Allows you to browse pages that have 
been or will be published to your website, 
according to the hierarchy in which they are 
organized on the site.  

- Content Tree – Allows you to visually browse 
the flex asset hierarchies present in your site.

- My Work – Contains the Bookmarks and 
History nodes. 

For detailed information about the trees, see the 
section “Navigation Pane,” on page 349. For 
information about using the nodes in the My Work 
tree, see “Organizing Assets,” on page 135.

The navigation pane displays the appropriate tree.

2. Browse the assets in the tree. Right-click an asset to 
open a context menu containing content management 
options you can perform on that asset. Do the 
following:

a. Drill down the hierarchy. Click the plus sign 
next to a node to expand the node and display its associated assets. If you are 
working with the Content Tree, double-click the desired parent asset to open a 
“Browse” tab containing a list of its children.

b. Right-click the desired asset. WebCenter Sites opens a context menu with 
content management functions you can perform on the asset. The example below 
shows the right-click menu for the “Surfing” page asset in the Site Tree: 

Assets in the Content Tree or My Work tree may have different content 
management options in their context menus, depending on the type of asset you 
select in the tree and your assigned permissions in the site.
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Switch to a Different Site
When working in WebCenter Sites, you can switch between the sites you have 
permissions to work in, without having to log out and back in to WebCenter Sites.

To switch to another site

1. If the applications bar is not already open, open it by clicking the down-arrow icon, 
located at the extreme right of the menu bar.

2. In the Site drop-down list, select the site you wish to switch to.

WebCenter Sites logs you in to the site you selected.

Log out of WebCenter Sites
Log out of WebCenter Sites to end your session. Do the following: 

1. If the applications bar is not already open, open it by clicking the down-arrow icon, 
located at the extreme right of the menu bar.

The applications bar is displayed above the menu bar.

2. In the applications bar, click Logout.

Congratulations! 
You are now familiar with asset management tasks that you may be performing every time 
you work in the Contributor interface. Log back in and continue to work in the Contributor 
interface. The rest of this guide gives you more information about the exercises you 
completed in this section. A summary of the Contributor interface and its features is 
available in Appendix B, “Navigational Reference.”

Note

The Site drop-down list contains only sites for which you have the appropriate 
permissions.
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Chapter 3

Creating, Sharing, and Editing Assets in 
Form Mode
This chapter describes the basic procedures for creating and editing assets in Form Mode, 
illustrated with examples from the avisports sample site.

This chapter contains the following sections:

• Creating Assets in Form Mode

• Editing Assets in Form Mode

• Working with Attribute Editors
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Creating Assets in Form Mode
The WebCenter Sites Contributor interface is designed to be used by content providers, 
rather than developers. Therefore, the following system-defined asset types can be 
displayed (inspected) in the Contributor interface, but they cannot be created (or edited) in 
the Contributor interface: Template, CSElement, SiteEntry, DimensionSet, Dimension, 
Attribute Editor, Parent Definitions, Attributes, and Flex Definitions. Similarly, the 
following system-defined asset types are not accessible from the Contributor interface: 
FW_Application, and FW_View. Assets of these types can be created (edited) and 
displayed only in the WebCenter Sites Admin interface. 

Creating assets is permission based as well. If you have the right permissions, you can 
create brand new assets “from scratch,” using the WebCenter Sites Contributor interface. 
If the new asset that you want to create is similar to an existing one, you can copy the 
existing asset and make changes to the copy, which saves you a few steps. If an asset 
currently exists on one site and you need to create the same asset for a different site, you 
can share the asset so that you do not have to create it more than once. All of these 
methods are described later in this chapter.

If the administrator configured an asset type such that all assets of that type open in Form 
Mode, when you create an asset of that type, a content entry form containing predefined 
fields into which you can enter information for the asset being created is displayed.

How Many Ways Can You Create an Asset?
• Create assets from scratch

• Copy existing assets and then work with the copied asset

The assets you can create are determined by how the administrator has personalized the 
“New” menu (Content > New) for your role. The purpose of personalizing the contents of 
the “New” menu is to make your job easier. For example, you will see only the asset types 
for which you can create assets. 

Creating a New Asset in Form Mode
If the administrator configured an asset type to be created in Form Mode and listed in your 
“New” menu (Content > New), you can create assets of that type by entering information 
into the fields of a content entry form. 

To create assets in Form Mode

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

Note

The Contributor interface provides two modes for creating new assets – Form 
Mode and Web Mode. This section only provides information about creating 
assets in Form Mode. For detailed information about creating assets in Web Mode, 
see “Creating Assets in Web Mode,” on page 90.
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2. Select the type of asset you want to create. In the menu bar, select Content > New > 
select the type of asset you wish to create. (In this example, we use the “Article” asset 
type).

3. If the administrator configured the asset type such that all new assets of that type are 
placed into workflow upon creation, a tab opens displaying the “Choose Assignees” 
form:

Select at least one user for each required role and click Set Assignees. Any of these 
users can complete the next step in the workflow process. For more information, see 
Chapter 14, “Workflow.”

Note

In the avisports sample site, assets of type “Article” are configured to open in 
Web Mode. Therefore, when you select to create an “Article” asset, the 
“Create Article” dialog box is displayed. 

To follow this procedure (and create an “Article” asset in Form Mode):

1. In the “Create Article” dialog box, do the following:

a. In the “Select Layout” field, select the layout you wish to assign to the 
asset.

b. In the “Name” field, enter a name for the asset. For information about 
naming the asset, see step a on page 66. Then click Continue.  

The asset’s Create view is displayed in Web Mode.

2. Switch to Form Mode. In the asset’s toolbar, click the Mode switch. 

The asset’s Create view is displayed in Form Mode.

3. Continue to step b on page 67.
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The tab displays the asset’s Create view as a content entry form (“Article” asset in this 
example).

4. In the asset’s Create view, do the following:

a. In the “Name” field, enter a name for the asset. Note the following conventions 
when naming the asset:

- The name must be between 1 and 64 alphanumeric characters.

- The following characters are not allowed: single quote (‘), double quote (“), 
semicolon (;), colon (:), question mark (?), percent sign (%), less-than sign 
(<), and greater-than sign (>).

- The name can contain spaces, but cannot start with a space.
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b. Fill in the asset’s content entry form. When populating the form, take note of the 
following: 

- Required fields. You must fill in all required fields (marked with an asterisk) 
before you are permitted to save the asset. Fill in all other fields as necessary.

- WYSIWYG text fields. You may see one or more text fields that are 
WYSIWYG-enabled via a WYSIWYG editor, such as CKEditor. These text 
fields allow you to enter and format your content using controls similar to 
those of Microsoft Word. For example:

To work in a CKEditor-enabled field, you must initiate CKEditor for that field 
by clicking in the field. When you click in the field, the CKEditor toolbar 
opens. For more information, see “Working with the CKEditor,” on page 78.

- Date fields. You may see one or more fields that allow you to select a date. 
For example: 

Clicking the Pick a date ( ) icon invokes the Date Picker attribute editor. 
For more information, see “Working with the Date Picker,” on page 83.

- Image Picker fields. You may see one or more fields that prompt you to 
select an image asset (to be associated with the asset you are creating) through 
the Image Picker attribute editor. In such cases, you will see a Browse button 
under a Drop Zone. For example:

Clicking the Browse button invokes the Image Picker, to the right of the tab 
displaying the asset, showing either names or thumbnails of the image assets 
from which you can select. For more information, see “Working with the 
Image Picker,” on page 79.
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- Clarkii Online Image Editor fields. You may see one or more fields that 
allow you to edit images directly in the asset form, using Clarkii OIE. For 
example:

For detailed instructions, see “Working with the Clarkii Online Image Editor,” 
on page 81.

- Type Ahead fields. You may see one or more fields that display the text 
“Type Ahead” within a drop-down menu. For example: 

To populate this field with an asset, you can either start typing the name of the 
asset you wish to place into the field or use the drop-down menu to select the 
desired asset. Your developers determine the type of asset(s) this field 
supports.

- Upload fields. You may see one or more fields that enable you to upload an 
image file from your local machine. For example:

To populate fields such as this, click the Browse button to upload the desired 
image file from your local machine.

- Asset association fields. You may see one or more fields that display a 
Drop Zone. These fields support drag and drop functionality and prompt you 
to select an asset, from a tree or search results list, to associate with the asset 
you are creating. To populate an association field, do the following:
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1)  In the Content Tree, My Work tree, or a search results list, click the name 
of an asset and hold down the button on the mouse while you drag the 
asset to the association field.

When you hover an asset of an accepted type over the field, a green 
border is displayed around the field. 

2)  Release the button on the mouse to drop the asset into the field.

The populated association field will look similar to the following:

WebCenter Sites links the asset you dropped into the association field to 
the asset you are working with. The name of the associated asset is 
displayed in the association field. More information on associating assets 
can be found in Chapter 8, “Associating Assets.”

c. Select the next section in the form section selector and fill in the fields as outlined 
in step b on page 67. Continue until you have populated all required fields 
(marked with an asterisk). Populate other form sections as necessary.

d. If you plan to create translations of the asset, or if you are required to specify the 
language of the content you create, select the asset’s target language in the 
“Locale” drop-down list (located in the Metadata section of the form). For more 
information, see Chapter 11, “Working with Multilingual Assets.”

5. Save the asset by doing one of the following:

- In the asset’s toolbar, click the Save ( ) icon.

- In the menu bar, select Content > Save.

WebCenter Sites saves the asset to the database, unless:

- You have left out one or more required fields in one or more sections

- An entry or selection you have made in one or more sections is not permitted

If either of the above is true, WebCenter Sites displays an error message indicating the 
offending fields. Correct the errors, then save the asset.

6. Inspect the asset. Do one of the following:

- In the asset’s toolbar, click the Inspect ( ) icon.

- In the menu bar, select Edit > Inspect.

The tab displays the asset’s Inspect view in Form Mode. You cannot modify the 
asset’s content when the asset is displayed in the Inspect view.

7. If the asset is not preassigned to a workflow and you want to use the workflow feature, 
you can assign the asset to a workflow process as described in the section “Assigning 
an Asset to a Workflow,” on page 244.
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8. Preview the asset:

a. In the asset’s toolbar, click the Preview ( ) icon.

b. If the asset does not have a template assigned to it, the “Select Layout” dialog 
opens. Select the desired layout and click Apply.

The tab displays the preview of the asset. For detailed instructions about 
previewing an asset, see Chapter 7, “Previewing Assets.”

c. If you wish to make additional changes to the asset, do the following:

1) In the asset’s toolbar, click the Go Back ( ) icon.

The tab displays the Inspect view of the asset.

2) In the asset’s toolbar, click the Edit ( ) icon.

The tab displays the Edit view of the asset. For information about editing 
assets in Form Mode, see “Editing Assets in Form Mode,” on page 75.”

9. When you are finished working with the asset, save the asset and close the tab. In the 
menu bar, select Content > Save & Close.

WebCenter Sites saves the asset and closes the tab displaying the asset.

Creating an Asset by Copying an Existing Asset
You can create a new asset by copying an existing asset. You can then work on the copy, 
making changes to the content where necessary. You can copy an asset even if it is 
checked out by another user. Assets can be copied using either Form Mode or Web Mode. 

To create a new asset by copying an existing asset

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset you wish to copy. Do one of the following:

- Search for and open the desired asset:

1) In the Search field, enter search criteria identifying the asset and then click 
the magnifying glass ( ) button.

2) In the list of search results, navigate to and click the name of the desired asset.

- If you previously bookmarked the asset, open it from the Bookmarks node in the 
My Work tree:

1) In the My Work tree, expand the Bookmarks node. (If the My Work tree is 
collapsed, expand it by clicking the My Work bar in the navigation pane.)

2) In the list of bookmarked assets, double-click the name of the desired asset.

For more information on finding assets, see Chapter 6, “Finding and Organizing 
Assets.”

A tab opens displaying the Inspect view of the asset (in either Form Mode or 
Web Mode).
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3. Copy the desired asset. In the menu bar, select Edit > Copy.

A tab opens displaying the copied asset’s Edit view in either Form Mode or Web 
Mode. The copied asset’s name is displayed in the tab as “Copy of Asset 
Name_randomly generated number.”

4. If the copy of the asset opens in Web Mode, do one of the following:

- If you wish to work with the copied asset in Web Mode, see “Editing Assets in 
Web Mode,” on page 99. 

- If you wish to work with the copied asset in Form Mode, switch to Form Mode. 

1) In the asset’s toolbar, click the Mode switch. 

2) When the tab displays the asset in Form Mode, continue to the next step.

5. In the Edit view of the copied asset, replace the content in the fields with content for 
the new asset you are creating. Do the following:

a. In the Name field, replace the asset’s system generated name with a name that 
uniquely identifies the copied asset. Note the following conventions when naming 
the asset:

- The name must be between 1 and 64 alphanumeric characters.

- The following characters are not allowed: single quote ('), double quote ("), 
semicolon (;), colon (:), question mark (?), percent sign (%), less-than sign 
(<), and greater-than sign (>).

- The name can contain spaces, but cannot start with a space.

b. (Optional) Set or change the new asset’s locale designation:

1) In the asset’s form section selector, select Metadata.

2) In the “Metadata” section, navigate to the “Locale” drop-down list and select 
the desired locale designation for the asset.

If you do not make a selection, one of the following happens:

- If the source asset has a locale designation, the new asset will retain the locale 
designation of the source asset.

- If the source asset has no locale designation, the new asset will not have a 
locale designation until you manually assign one.

For more information, see Chapter 11, “Working with Multilingual Assets.”

c. Populate the remaining fields with the desired content for the new asset. For 
information about the different fields you may see when working with an asset in 
Form Mode, see step b on page 67.

6. Save the asset. Do one of the following:

- In the asset’s toolbar, click the Save ( ) icon.

- In the menu bar, select Content > Save.

Note

If you do not see a Copy option, stop here. You do not have the appropriate 
permissions to copy the asset. If you have questions about your permissions, 
contact your administrator.
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WebCenter Sites saves the asset to the database, unless:

- You have left out one or more required fields

- An entry or selection you have made in one or more fields is not permitted

If either of the above is true, WebCenter Sites displays an error message indicating the 
offending fields. Correct the errors, then save the asset.

7. Inspect the asset by doing one of the following:

- In the asset’s toolbar, click the Inspect ( ) icon.

- In the menu bar, select Edit > Inspect.

The tab displays the asset’s Inspect view in Form Mode. You cannot edit the asset’s 
content when the asset is displayed in the Inspect view.

8. (Optional) If the asset is not preassigned to a workflow and you want to use the 
workflow feature, you can assign the asset to a workflow process as described in the 
section “Assigning an Asset to a Workflow,” on page 244.

9. Preview the asset:

a. In the asset’s toolbar, click the Preview ( ) icon.

b. If the asset does not have a template assigned to it, the “Select preview template” 
dialog box opens. Select the desired layout and click Apply.

The tab displays the preview of the asset. For detailed instructions about 
previewing an asset, see Chapter 7, “Previewing Assets.”

Sharing Assets with Other Sites
If you are working with an asset that you want to use in more than one site, you can share 
it so that you do not have to create it more than once and maintain it across multiple sites. 

Which Assets Can You Share?
Before you share an asset, keep in mind the following:

• You must have the permissions to share an asset.

• You can share an asset only to sites that you have access to. If you have access to only 
one site, the Share option in the Content menu (Content > Share) is not available to 
you.

• You cannot share “Page” assets.

• Share an asset only if the content it contains does not have to be unique to the target 
site. For example, you can share an asset containing your company’s logo, because the 
same image can probably be used on all of the company’s sites.

Note

To share an asset with another site, make sure that the asset’s type is enabled on the 
site with which you wish to share it.
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If the nature of the content requires a separate, unique version for each site, do not 
share the asset – instead, create a new asset for each site that requires a unique version 
of the content.

• Because of the nature of asset sharing, if a shared asset is deleted, it is automatically 
removed from all of the sites it was shared to.

• If the asset is in a workflow, you and others can change its workflow status only when 
you are working in the asset’s native site.

• It is good practice to share the asset only when you are ready to publish it; that is, wait 
to share the asset until it has been approved.

• If you want to share a localized asset to another site, the asset’s locale must be enabled 
on the target site. 

• If you share an asset that has dependencies, (for example, the shared asset is 
associated with an “Article” asset), you will have to share all of the asset’s dependent 
assets to the target site in order for the primary shared asset to be successfully 
approved for publishing on the site to which you shared it.

If you wish to share an asset with another site, but you do not have the appropriate 
permissions, contact your WebCenter Sites administrator. 

How Do You Share Assets with Other Sites?
1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 

WebCenter Sites Contributor interface.

2. Find and open the asset you want to share to another site. Do one of the following:

- Search for and open the desired asset:

1) In the Search field, enter search criteria identifying the asset and then click 
the magnifying glass ( ) button.

2) In the list of search results, navigate to and click the name of the asset you 
wish to share. 

- If you previously bookmarked the asset, open it from the Bookmarks node in the 
My Work tree:

1) In the My Work tree, expand the Bookmarks node. (If the My Work tree is 
collapsed, expand it by clicking the My Work bar in the navigation pane.)

2) In the list of bookmarked assets, double-click the name of the desired asset.

For more information on finding assets, see Chapter 6, “Finding and Organizing 
Assets.” 

A tab opens displaying the Inspect view of the asset (in either Form Mode or Web 
Mode).

Tip

If you wish to share the asset without first inspecting it, in the search 
results list, right-click the desired asset and select Share from the 
context menu. Continue to step 4.
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3. In the menu bar, select Content > Share.

The “Share Content” dialog box opens.

4. In the “Share Content” dialog box, do the following:

a. In the “Available” list box, select the site(s) to which you wish to share the asset 
and move the site(s) to the “Selected” list box.

b. If you wish to share this asset with all current and future sites, select the Share 
this content with all current and future sites checkbox. 

c. Click Save.

The asset is now accessible in the site(s) to which you shared it.
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Editing Assets in Form Mode
Editing assets is permission based. Your site administrator determines which users can 
work with which assets. If you have the right permissions, you can edit assets in the 
WebCenter Sites Contributor interface. For more information about the permissions 
needed to edit assets, see your administrator. 

If the asset type is configured such that all assets of that type open in Form Mode, a tab 
opens displaying the content entry form of the asset. In Form Mode, you can edit an asset’s 
content by modifying or replacing the information displayed in the fields of the asset’s 
content entry form. 

To edit an asset in Form Mode

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset. Do one of the following:

- Search for and open the desired asset:

1) In the Search field, enter search criteria identifying the asset and then click 
the magnifying glass ( ) button. 

2) In the list of search results, navigate to and click the name of the desired asset.

- If you previously bookmarked the asset, open it from the Bookmarks node in the 
My Work tree:

1) In the My Work tree, expand the Bookmarks node. (If the My Work tree is 
collapsed, expand it by clicking the My Work bar in the navigation pane.)

2) In the list of bookmarked assets, double-click the name of the desired asset.

For more information on finding assets, see “Finding and Organizing Assets,” on 
page 125.

A tab opens displaying the Inspect view of the asset (in either Form Mode or 
Web Mode).

3. Access the asset’s Edit view in Form Mode:

a. If the asset is displayed in Web Mode, switch to Form Mode. In the asset’s toolbar, 
click the Mode switch. 

b. In the asset’s toolbar, click the Edit ( ) icon.

Note

If you need to edit a shared asset, you will have to edit the asset in its native site 
(the site on which the asset was originally created).

Tip

If you wish to edit the asset without first inspecting it, in the list of assets, right-
click the desired asset and select Edit from the context menu. Continue to step 4. 
If the asset’s Edit view is displayed in Web Mode, switch to Form Mode by 
clicking the Mode switch in the asset’s toolbar.
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The tab displays the Edit view of the asset in Form Mode.

4. Make the desired changes to the asset’s content. See step 4 on page 66 for details on 
filling in the fields you may see when working with an asset in Form Mode.

5. Save the asset by doing one of the following:

- In the asset’s toolbar, click the Save ( ) icon.

- In the menu bar, select Content > Save.

WebCenter Sites saves the asset to the database, unless:

- You have left out one or more required fields in one or more sections
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- An entry or selection you have made in one or more sections is not permitted

If either of the above is true, WebCenter Sites displays an error message indicating the 
offending fields. Correct the errors, then save the asset.

6. Inspect the asset by doing one of the following:

- In the asset’s toolbar, click the Inspect ( ) icon.

- In the menu bar, select Edit > Inspect.

The tab displays the Inspect view of the asset in Form Mode. You cannot edit the 
asset’s content when the asset is displayed in the Inspect view.

7. If the asset is not preassigned to a workflow and you want to use the workflow feature, 
you can assign the asset to a workflow process as described in the section “Assigning 
an Asset to a Workflow,” on page 244.

8. Preview the asset:

a. In the asset’s toolbar, click the Preview ( ) icon.

b. If the asset is not assigned a template, the “Select Layout” dialog opens. Select the 
desired layout and click Apply.

The tab displays the preview of the asset. For detailed instructions about 
previewing an asset, see Chapter 7, “Previewing Assets.”

Working with Attribute Editors
This section contains information about the attribute editor enabled fields you may see 
when creating or editing an asset. This section contains the following:

• Working with the CKEditor

• Working with the Image Picker

• Working with the Clarkii Online Image Editor

• Working with the Date Picker
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Working with the CKEditor
CKEditor is a popular third-party WYSIWYG editor that is used as the default editor for 
WYSIWYG-enabled text fields. CKEditor allows you to apply a wide range of MS Word-
style formatting to your content.

Figure 9: CKEditor 

CKEditor also provides advanced features, such as access to your content’s underlying 
HTML code, and the ability to accept pre-formatted content from MS Word documents. 

Most features made available to you in the toolbar are native to CKEditor. To learn more 
about CKEditor and its capabilities, consult the editor’s documentation, available at 
http://docs.cksource.com. 

Several features on the CKEditor toolbar are specific to WebCenter Sites. The features are 
shown and explained below:

Figure 10: WebCenter Sites Specific Features in CKEditor 

• Add asset link – Enables you to create a hypertext link from one asset to another 
asset. For more information, see “Linking Two Assets Directly,” on page 177.

To work more comfortably, click Maximize to expand CKEditor to fill your workspace

To restore CKEditor to normal 
size, click Maximize again.

Pick an image to include

Include asset

Add asset link
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• Include asset – Enables you to render an asset’s previewable content in another asset. 
For more information, see “To Link Two Assets by Inclusion,” on page 182.

• Pick an image to include – Enables you to include an image from the “Image 
Picker,” into the referring asset’s CKEditor enabled field(s). 

Once the image is included in the field, you have the option to link the image to 
another asset. For more information, see “Linking via an Image from the Image 
Picker,” on page 191.

Working with the Image Picker
When working with assets that can be associated with one or more image assets, you may 
see fields that support the Image Picker attribute editor. The Image Picker enables you to 
visually choose an image asset to associate with the asset you are creating or editing. 

To associate an image asset with another asset using the Image Picker

1. In the Create or Edit view of an asset displayed in Form Mode, navigate to the field 
associated with the Image Picker and click Browse.

Note

If the included asset is an image, then you can link the image to another asset. For 
more information, see “Linking Two Assets via an Image Asset,” on page 185.

Note

When configuring the asset type of the parent asset, your developers decide the 
following:

• The fields for which Image Picker is enabled

• The type of image assets displayed by Image Picker
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e asset
Image Picker opens in the search results list (to the right of the asset’s form).

For each image asset, Image Picker shows either a thumbnail of the image as well as 
its file name or only the asset’s file name (depending on the configurations made by 
your developers). 

2. Navigate to the desired image asset and drag and drop 
the image into the field.

The image asset you selected is associated with the 
asset you are working with. If the field was already 
populated with an image asset, the newly selected 
asset replaces the previous one. A thumbnail of the 
corresponding image appears in the field.

3. Click the Save ( ) icon to save your changes to the 
asset.

Thumbnail of imag

File Name
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Clarkii OIE 
enabled by 

Clarkii OIE 
Working with the Clarkii Online Image Editor
The Clarkii Online Image Editor (Clarkii OIE) allows you to edit an image directly in an 
asset’s New or Edit view in Form Mode. For example, you can use Clarkii OIE to crop and 
rotate an image. You can also use Clarkii OIE to enhance an image by adding graphics 
and/or text to it. 

Figure 11 shows an example of an image that was edited in an asset field using 
Clarkii OIE.

Figure 11: Clarkii Online Image Editor rendered in an asset’s field

Clarkii OIE requires you to have Flash installed. If you do not have Flash installed, 
instead of Clarkii OIE you will see a link to download Flash. Click the link to 
download Flash. Once Flash is installed, Clarkii OIE loads in the appropriate field (as 
shown in the figure above).

When you work with an asset field using Clarkii OIE, you can do some or all of the 
following depending on how your developers configured Clarkii OIE:

• Select an image to place on the Clarkii OIE canvas, or select an image that will replace 
the image currently on the canvas. Your developers determine which images will be 
available to you. 

• Use the toolbar and menu options available in the Clarkii OIE window to make other 
edits to the image on the canvas as necessary.

Note

When working with Clarkii OIE, keep in mind the following:

• Clarkii OIE is supported only in Form Mode. 

• Your site developers enable Clarkii OIE on a per-field basis when 
configuring asset types. For more information, see the Oracle WebCenter 
Sites Developer’s Guide.

menu options 
default

canvas
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Your developers have the ability to customize the functions available to you in the 
Clarkii OIE toolbar and menu. These functions are strictly Clarkii OIE related and as 
such are not documented in this guide. For instructions about using the toolbar and 
menu options provided by Clarkii OIE, visit the following URL:

http://www.online-image-editor-clarkii.com/

To edit images with the Clarkii Online Image Editor   

1. Access Clarkii OIE in the desired asset’s Create or Edit view. 

Clarkii OIE is displayed in the field and looks similar to the following:

2. The following instructions are only for the menu options available by default in the 
Clarkii OIE feature out-of-the-box when WebCenter Sites is installed. For example, 
inserting images and making other modifications (such as resizing an image on the 
canvas) as necessary:

- If you wish to insert an image on the Clarkii OIE canvas, replacing any images 
currently existing on the canvas, do the following:

a) In the Clarkii OIE menu, select File > Open.

The “Select file to open” dialog box opens.

b) Select the image file you wish to insert on the Clarkii OIE canvas and click 
Open.

Note

• Before using this feature, make sure that you know which asset forms 
contain an attribute field associated with Clarkii OIE. 

• The instructions in step 2 are guidelines that provide you with examples of 
what you can do when using Clarkii OIE. The functions you can perform 
in this step are determined by how your developers configured the 
Clarkii OIE properties. 

If you have any questions, contact your developers.
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The image is placed on the canvas, and replaces any images that are currently 
existing on the canvas.

c) (Optional) If you wish to replace the image you chose with another one, select 
the desired image by repeating steps a and b.

- If you want to modify the image displayed on the Clarkii OIE canvas (such as 
resizing the image and so on), click the Modify option in the Clarkii OIE menu. 
The following options are available in the Modify menu:

- Rotate

- Crop

- Resample

For instructions on using these and other functions, visit the following URL:

http://www.online-image-editor-clarkii.com/

3. In the asset’s toolbar, click the Save ( ) icon to save the changes you made in the 
asset’s Clarkii OIE enabled field. 

Working with the Date Picker
When working with assets whose forms include a date field (such as a post date, release 
date, start/end date, and so on), you may visually select a date using the Date Picker 
attribute editor, in addition to the standard text box.

The Date Picker is a calendar-like interface similar to date selectors found in many 
personal information management applications (for example, Microsoft Outlook).

To enter a date using the Date Picker

1. In the asset’s Create or Edit view, scroll to the Date Picker enabled field and click the 
Pick a date ( ) icon. 

WebCenter Sites opens the Date Picker pop-up window:

1.  Select the month using the 
left and right single arrows 
(<, >) or the drop-down 
lists accessed by clicking 
the name of the month.

2.  Select the year. The 
year that is displayed 
in the middle is the 
selected year.

3.  To increase/decrease the 
time, click the up and down 
arrows next to the hour, 
minute, and second selection 
menus to increase/decrease 
the units by 1.

4.  Click the desired day. 
(Date Picker closes.)
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2. In the Date Picker pop-up window, select the desired month, year, day, and time. Make 
sure you select the day last. When you click the desired day, the Date Picker pop-up 
window automatically closes and the date you selected is reflected in the 
corresponding field.

3. In the asset’s toolbar, click the Save ( ) icon to save your changes to the asset.
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Chapter 4

Creating, Sharing, and Editing Assets in Web 
Mode
This chapter describes the basic procedures for creating and editing assets in Web Mode, 
illustrated with examples from the avisports sample site.

This chapter contains the following:

• Overview

• Creating Assets in Web Mode

• Editing Assets in Web Mode
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Overview
The WebCenter Sites Contributor interface is designed to be used by content providers, 
rather than developers. Therefore, the following system-defined asset types can be 
displayed (inspected) in the Contributor interface, but they cannot be created (or edited) in 
the Contributor interface: Template, CSElement, SiteEntry, DimensionSet, Dimension, 
Attribute Editor, Parent Definitions, Attributes, and Flex Definitions. Similarly, the 
following system-defined asset types are not accessible from the Contributor interface: 
FW_Application, and FW_View. Assets of these types can be created (edited) and 
displayed only in the WebCenter Sites Admin interface. 

Working with assets is permissions based as well. If you have the right permissions, you 
can create and edit assets using the WebCenter Sites Contributor interface. If an asset type 
is configured such that all assets of that type open in Web Mode, when you create or edit 
an asset of that type, the asset’s web page view will be displayed to you (as shown in 
Figure 12). 

Figure 12: ‘Surfing’ Page asset’s Inspect view displayed in Web Mode

Note

The Contributor interface provides two modes for creating new assets – Form 
Mode and Web Mode. This section only provides information about creating 
assets in Web Mode. For information about creating assets in Form Mode, see 
“Creating Assets in Form Mode,” on page 64.

Depending on the configurations your developers made to your WebCenter Sites 
system, Web Mode might be disabled. In this section, we assume that Web Mode 
is enabled. For more information about whether Web Mode is enabled for your 
installation, see your developers.
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sset. 
Web Mode offers in-context editing, which means you can work with assets directly in 
their published form (web page view). Instead of fields in a content entry form, it is the 
web page layout (template) assigned to the asset that determines the editable areas of an 
asset rendered in Web Mode. Editable areas can include simple text areas, WYSIWYG 
editor enabled text areas, and slots. Below shows an example Edit view of the Surfing 
page asset rendered in Web Mode displaying empty and occupied slots.

Figure 13: ‘Surfing’ Page asset’s Edit view displayed in Web Mode 

What is a Slot?
If the web page layout (template) assigned to the asset is configured to support slots, the 
asset’s Create and Edit views will display empty and/or occupied slots (as shown in 
Figure 13 and Figure 14). Each slot accepts one piece of content – an asset (unless the slot 
is multi-valued, in which case the slot will accept more than one asset). If the slot supports 
drag and drop functionality, you can drag an asset from a tree or search results list and 
drop the asset into the desired slot. If the slot does not support drag and drop functionality, 
it will usually contain a predefined asset (such as a recommendation asset) which your 
developers or administrators have configured in the web page layout (template) assigned 
to the asset.

This slot is empty. 

This slot is occupied by an a
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Figure 14: Empty and Occupied Slots (‘Surfing’ Page asset)  

By adding an asset to a slot, you are creating an association between the asset with which 
you are working and the asset you placed in the slot. The type of asset each slot supports is 
determined by the configurations your developers made to the web page layout (template) 
assigned to the asset. 

When you click in a slot, a toolbar with content management options you can perform on 
the slot is displayed (as shown in Figure 13). Using the toolbar you can edit the content of 
the asset contained within the slot, change the content layout of the slot (which changes 
the appearance of the asset in the slot), view the slot’s properties, and/or remove the asset 
from the slot. If you are working with a multi-valued slot (which accepts multiple assets), 
you will see a Manage option that allows you to reposition the order in which the assets 
contained within that slot are displayed on the web page. The options available in a slot’s 
toolbar are determined by the configurations your developers made to the web page layout 
(template) assigned to the asset with which you are working.

What is the Difference Between Web Page Layout and Content 
Layout?

Web page layout is the layout (template) assigned to the asset with which you are working. 
When working with an asset in Web Mode, the web page layout assigned to the asset 
determines the arrangement of the slots in the asset’s web page view (as shown in 
Figures 13 and 14). Content layout is the layout (template) assigned to an individual slot. 

This slot is empty. You can drag an 
asset from the Content Tree, My Wor
tree, or a search results list and drop 
the asset into the slot.

This slot is occupied by an asset. 
Click in the slot to display the slot’s 
toolbar. This slot allows you to: remov
the asset, replace the asset with 
another asset, change the content 
layout of the slot, view the slot’s 
properties, or edit the asset contained
within the slot.
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Slot 1

 
eb 
The content layout assigned to a slot determines the appearance of the asset contained 
within that slot.

A slot enables you to select a different content layout with which to render the content 
contained within it. When you change the content layout of a slot, the asset contained 
within the slot is rendered using the layout you selected. Figure 15 provides a diagram 
showing the difference between web page layout and content layout.  

Figure 15: Web Page Layout vs. Content Layout

Web Page 1
Web Page Layout 

(slot layout)

Slot 2

Slot 3

Web Page 2

Content Layout 1

Content Layout

Content 
Layout

Content Layout

Content 
Layout 1

Content 
Layout

Content Layout 2

Content Layout

Content 
Layout

The web page layout (template) you select determines the position of the slots displayed on the asset’s web
page view. Selecting a different layout (template) renders slots in different positions, depending on how the w
page layout (template) code is written.

Content Layout

Content 
Layout 2

Content 
Layout

The way the content of a 
slot is rendered is 
determined by the 
content layout (template) 
assigned to the slot.

If you select a different 
content layout (template) 
for a slot, the asset 
contained within the slot 
is rendered by the layout 
(template) you select.
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Creating Assets in Web Mode
The types of assets you can create are determined by the asset types that are available in 
the Contributor interface and your assigned permissions. If you have the right permissions, 
you can create brand new assets “from scratch,” using the WebCenter Sites Contributor 
interface. If the new asset that you want to create is similar to an existing one, you can 
copy the existing asset and make changes to the copy, which saves you a few steps. If an 
asset currently exists on one site and you need to create the same asset for a different site, 
you can share the asset so that you do not have to create it more than once. 

How Many Ways Can You Create Assets?
For information about the different ways you can create assets in the Contributor interface, 
see “How Many Ways Can You Create an Asset?,” on page 64. 

If You Use Web Mode, Will You Need to Switch to Form Mode?
When you are working with an asset in Web Mode, the editable areas you see are 
determined by the configurations your developers made to the web page layout (template) 
assigned to the asset. The fields you see in an asset’s content entry form (when working 
with the asset in Form Mode) are not necessarily the same fields that will be available to 
you when working with the asset in Web Mode. Therefore, certain fields such as date and 
Locale fields may not be available in Web Mode. In addition, certain attribute editors are 
only supported in Form Mode (for example, Clarkii Online Image Editor). In such cases, 
you will have to switch to Form Mode to fill in those fields. For instructions about 
switching to Form Mode, see step 8 on page 98 in the section “Creating a New Asset in 
Web Mode.”

Creating a New Asset in Web Mode
If the administrator configured an asset type to be created in Web Mode and listed in your 
“New” menu (Content > New), you can create assets of that type by entering information 
into the web page view of the asset. 

To create a new asset in Web Mode

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Select the type of asset you wish to create. In the menu bar, click Content > New > 
select the type of asset you wish to create. (To follow this example, select the Article 
asset type.)

The “Create Asset” dialog box is displayed.
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3. In the “Create Asset” dialog box, do the following: 

a. In the “Select Layout” field, select the layout you want to assign to the asset. 

The layout you select determines how the asset’s Create view is displayed in Web 
Mode.

b. In the “Name” field, enter a name for the asset. Keep in mind the following:

- The name must be between 1 and 64 alphanumeric characters.

- The following characters are not allowed: single quote (;), double quote (“), 
semicolon (;), colon (:), question mark (?), percent sign (%), less-than sign 
(<), and greater-than sign (>).

- The name can contain spaces, but cannot start with a space.

c. Click Continue.

4. If the administrator configured the asset type such that all new assets of that type are 
placed into workflow upon creation, you will see the “Choose Assignees” dialog box:

Select at least one user for each required role and click Set Assignees. Any of these 
users can complete the next step in the workflow process. For more information, see 
Chapter 14, “Workflow.”
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A new tab opens displaying the asset’s Create view in Web Mode. (“Article” asset in 
this example.) 

The layout you assigned to the asset determines the editable areas you will see in the 
asset’s Create view. 
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5. Point to the different areas of the asset’s Create view to determine which areas accept 
content. Areas that support drag and drop functionality and other content management 
actions will be highlighted when you point to them (as shown below): 
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6. Click in the highlighted areas to determine the type of content each area supports. The 
types of editable areas you will see and how those areas are displayed in the asset’s 
web page view are determined by how your developers have coded the asset’s web 
page layout (template). Below is an example of the areas you may see when working 
with an asset in Web Mode:

7. Populate the asset’s Create view. Click in an editable area to determine the type of 
content the area accepts. The differences between the editable areas you may see when 
populating the asset are as follows:

- Text Areas. You may see one or more areas that allow you to enter text. These 
areas may display predefined sample text describing the type of content that 
should be entered. When you point to a text area, it becomes highlighted in grey 
and your cursor appears as a text-selecting I-beam. For example:  

Simple text are

WYS
enab

Single-value
coded to ind
that it accep
image. 

ulti-valued slots. 
lick the Edit option to 
ork with the individual 
lots within the multi-
alued slot.
Oracle WebCenter Sites User’s Guide



Chapter 4 Creating, Sharing, and Editing Assets in Web Mode

 Creating Assets in Web Mode
95
Click in the text area to enter the desired text. When you click in the text area, you 
will see one of the following:

- Simple Text field. You can enter text into a simple text field, but you cannot 
format the appearance of that text.    

- WYSIWYG text field. If the text area supports an embedded WYSYWYG 
editor (such as CKEditor), the WYSYWYG editor is displayed. These text 
fields allow you to enter and format your content using controls similar to 
Microsoft Word.

- Date area. You may see one or more areas that allow you to select a date. For 
example:

Clicking in one of these areas invokes the Date Picker attribute editor. For more 
information, see “Working with the Date Picker,” on page 83.

Clicking in a date area 
opens the Date Picker 
attribute editor.
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- Slots. You may see one or more areas that display either predefined content or an 
empty slot. These areas are highlighted with a blue overlay when you point to 
them. 

To work with a slot, do the following:

1) Click in the desired slot to display its toolbar. Depending on how the slot is 
coded in the web page layout (template) assigned to the asset, you may see 
one or more of the following content management options:

From left to right in the toolbar (displayed above), the options are the 
following: 

-    Edit – Allows you to edit the content of the asset contained within the slot 
directly in the web page view of the asset you are creating. For more 
information, see “Editing the Content of an Associated Asset,” on 
page 110. 

-    Open in New Tab – Opens a tab displaying the Inspect view of the asset 
contained within the slot. For more information, see “Editing the Content 
of an Associated Asset,” on page 110.

-    Change content layout – Allows you to select a content layout (template) 
with which to render the slot’s content. For more information, see 
“Changing Content Layout,” on page 104.

-    Slot properties – Provides you with a list of asset types the slot supports. 
For more information, see step 3 on page 97.

-    Clear slot – Removes the content from the slot. For more information, see 
“Removing Associations,” on page 113.

The following option is only available in a multi-valued slot’s toolbar:

-    Manage – Allows you to manage the position of the assets contained 
within a multi-valued slot. For more information about multi-valued slots, 
see “Changing the Position of Content Displayed in a Multi-Valued Slot,” 
on page 115.

Slot displaying predefined content Empty slot
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ts of 
2) If the slot is multi-valued, when you click in the slot, its toolbar displays the 
Edit and Manage options. Click Edit to access the individual slots within the 
multi-valued slot, as shown below:

3) Determine the type of content a slot supports. Click in the slot and then click 
the Slot properties option in the slot’s toolbar.

4) Determine if the slot supports drag and drop functionality by dragging an 
asset from the Content Tree, My Work tree, or a search results list to the 
desired slot. 

-    If the slot’s border turns green, then the slot accepts that type of asset. In 
this case, drop the asset into the slot. 

-    If the slot’s border turns red, the slot either does not accept this type of 
asset or does not support drag and drop functionality.

For more information about adding content to a slot, see “Adding or 
Replacing an Association,” on page 107.

Click the Edit option to 
access the individual slots 
within the multi-valued 
slot.

This slot accepts asse
only type Article
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8. If the web page layout (template) assigned to the asset you are creating is not coded to 
display certain fields in Web Mode, (for example, date and Locale fields), then those 
fields will only be available in Form Mode. To populate these fields, you will have to 
switch to Form Mode:

a. In the asset’s toolbar, click the Mode switch.

The tab re-displays the asset in Form Mode.

b. Fill in the required fields. For instructions, see step b on page 67.

c. Switch back to Web Mode. In the asset’s toolbar, click the Mode switch.

The tab re-displays the asset in Web Mode.

9. Save the asset. Do one of the following:

- In the asset’s toolbar, click the Save ( ) icon.

- In the menu bar, select Content > Save.

WebCenter Sites saves the asset to the database, unless:

- You have left out one or more required fields.

- An entry or selection you have made in one or more of the fields is not permitted.

If either of the above is true, WebCenter Sites displays an error message indicating the 
offending fields. Correct the errors and save the asset.

10. Inspect the asset. Do one of the following:

- In the asset’s toolbar, click the Inspect ( ) icon.

- In the menu bar, select Edit > Inspect.

The tab displays the asset’s Inspect view in Web Mode. You cannot modify the asset’s 
content when the asset is displayed in the Inspect view.

11. (Optional) If the asset is not preassigned to a workflow and you want to use the 
workflow feature, you can assign the asset to a workflow process as described in the 
section “Assigning an Asset to a Workflow,” on page 244.

12. Preview the asset:

a. In the asset’s toolbar, click the Preview ( ) icon.

The tab displays the preview of the asset. For detailed instructions about 
previewing an asset, see Chapter 7, “Previewing Assets.”

b. If you wish to make additional changes to the asset, do the following:

1) In the asset’s toolbar, click the Go Back ( ) icon.

The tab displays the Inspect view of the asset.

2) In the asset’s toolbar, click the Edit ( ) icon.

The tab displays the Edit view of the asset. For more information about 
editing assets in Web Mode, see “Editing Assets in Web Mode,” on page 99. 

13. When you are finished working with the asset, save and close it. In the menu bar, 
select Content > Save & Close.

WebCenter Sites saves the asset and closes the tab displaying the asset.
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Creating a New Asset by Copying an Existing Asset
The procedure for copying assets is the same for both Form Mode and Web Mode. For 
instructions about creating a new asset by copying an existing asset, see “Creating an 
Asset by Copying an Existing Asset,” on page 70.

Sharing Assets With Other Sites
The procedure for sharing an asset with different sites is the same for both Form Mode and 
Web Mode. For instructions about sharing an asset with another site, see “Sharing Assets 
with Other Sites,” on page 72.

Editing Assets in Web Mode
This section provides instructions on editing assets in Web Mode and contains the 
following:

• Editing the Content of an Asset in Web Mode

• Changing Web Page Layout

• Changing Content Layout

• Editing Associations

Editing the Content of an Asset in Web Mode
Web Mode offers in-context editing, which means you can edit the content of an asset 
directly in its web page view. How the asset’s web page layout (template) code is written 
determines the areas you will be able to edit in Web Mode. Certain fields (such as date and 
‘Locale’ fields) may only be accessible when working with an asset in Form Mode. 
Therefore, to edit the content of these fields you will have to switch to Form Mode.

To edit the content of an asset in Web Mode

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset. Do one of the following:

- Search for and open the desired asset:

1) In the Search field, enter search criteria identifying the asset and then click 
the magnifying glass ( ) button.

2) In the search results list, click the name of the asset.

- If you previously bookmarked the asset, open it from the Bookmarks node in the 
My Work tree:

1) In the My Work tree, expand the Bookmarks node. (If the My Work tree is 
collapsed, expand it by clicking the My Work bar in the navigation pane.)
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2) In the list of bookmarked assets, double-click the name of the desired asset.

For more information about finding assets, see Chapter 6, “Finding and Organizing 
Assets.”

A tab opens displaying the Inspect view of the asset in either Form Mode or 
Web Mode. (In this example, we use the 25 Nevada Resorts Serving Snow “Article” 
asset.)

3. If the asset is displayed in Form Mode, switch to Web Mode. 

a. In the asset’s toolbar, click the Mode switch.

b. If the asset is not assigned to a template (web page layout), the “Select Layout” 
dialog box is displayed. Select the desired layout and then click Apply.

The tab re-displays the asset’s Inspect view in Web Mode.

4. Edit the asset:

a. In the asset’s toolbar, click the Edit ( ) icon.

The tab displays the Edit view of the asset in Web Mode.

Tip

If you want to edit the asset without first inspecting it, in the list of assets, right-
click the desired asset and select Edit from the context menu. Continue to step b 
on page 101. If the asset’s Edit view is displayed in Form Mode, switch to Web 
Mode by clicking the Mode switch in the asset’s toolbar.
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b. Make your changes to the asset. See steps 5 – 8 on page 93 for details on the 
editable areas you may see when working with an asset in Web Mode. 

5. Save the asset by doing one of the following:

- In the asset’s toolbar, click the Save ( ) icon.

- In the menu bar, select Content > Save.

WebCenter Sites saves the asset to the database, unless:

- You have left out one or more required field(s).

- An entry or selection you have made in one or more field(s) is not permitted.

If either of the above is true, WebCenter Sites displays an error message indicating the 
offending fields. Correct the errors, then save the asset. 

6. Inspect the asset by doing one of the following:

- In the asset’s toolbar, click the Inspect ( ) icon.

- In the menu bar, select Edit > Inspect.

The tab displays the Inspect view of the asset in Web Mode. When you inspect an 
asset, you cannot modify its content.

7. If the asset is not preassigned to a workflow and you want to use the workflow feature, 
you can assign the asset to a workflow process as described in the section “Assigning 
an Asset to a Workflow,” on page 244.

8. Preview the asset:

a. In the asset’s toolbar, click the Preview ( ) icon.

The tab displays the preview of the asset. For detailed instructions about 
previewing an asset, see Chapter 7, “Previewing Assets.”

b. When you are done previewing the asset, click the Go Back ( ) icon. 

The tab re-displays the asset in Web Mode.

Changing Web Page Layout
The web page layout (template) assigned to an asset determines the position of the slots 
displayed on the web page view of the asset. If you select a different layout (template) for 
the asset, the slots and other editable areas will be rendered in different positions, 
depending on how the web page layout (template) code is written. This section provides 
instruction on selecting a different web page layout (template) for an asset when working 
in Web Mode.

To change the web page layout of an asset

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset. Do one of the following:

- Search for and open the desired asset:

1) In the Search field, enter search criteria identifying the asset and then click 
the magnifying glass ( ) button.

2) In the search results list, click the name of the asset.
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- If you previously bookmarked the asset, open it from the Bookmarks node in the 
My Work tree:

1) In the My Work tree, expand the Bookmarks node. (If the My Work tree is 
collapsed, expand it by clicking the My Work bar in the navigation pane.)

2) In the list of bookmarked assets, double-click the name of the desired asset.

For more information about finding assets, see Chapter 6, “Finding and Organizing 
Assets.”

A tab opens displaying the Inspect view of the asset in either Form Mode or Web 
Mode. (In this example, we use the Home Page asset.)

3. If the asset is displayed in Form Mode, switch to Web Mode. 

a. In the asset’s toolbar, click the Mode switch.

b. If the asset is not assigned to a template (web page layout), the “Select Layout” 
dialog box is displayed. Select the desired layout and then click Apply.

The tab re-displays the asset’s Inspect view in Web Mode.

4. In the asset’s toolbar, click the Edit ( ) icon.

The tab displays the Edit view of the asset in Web Mode.
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5. Change the web page layout (template) of the asset:

a. Do one of the following:

- In the asset’s toolbar, click the Change Page Layout ( ) icon. 

- In the menu bar, select Edit > Change Page Layout.

The “Change Page Layout” dialog opens.

b. Select the web page layout (template) you wish to assign to the asset, then click 
Apply.

WebCenter Sites updates the asset’s web page layout to the layout you selected. 
The web page layout (template) you select determines the position of the slots and 
other editable areas of the asset.

6. Save the asset by doing one of the following:

- In the asset’s toolbar, click the Save ( ) icon.

- In the menu bar, select Content > Save.

WebCenter Sites saves the asset to the database, unless:

- You have left out one or more required field(s).

- An entry or selection you have made in one or more fields is not permitted.

If either of the above is true, WebCenter Sites displays an error message indicating the 
offending fields. Correct the errors, then save the asset. 

7. Inspect the asset by doing one of the following:

- In the asset’s toolbar, click the Inspect ( ) icon.

- In the menu bar, select Edit > Inspect.

The tab displays the Inspect view of the asset in Web Mode. When you inspect an 
asset, you cannot modify its content.

8. Preview the asset: 

a. In the asset’s toolbar, click the Preview ( ) icon.

The tab displays the preview of the asset. For detailed instructions about 
previewing an asset, see Chapter 7, “Previewing Assets.”

b. When you are done previewing the asset, click the Go Back ( ) icon.

The tab re-displays the asset in Web Mode.
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Changing Content Layout
Each slot is assigned a content layout (template). The content layout of a slot determines 
how the asset contained within the slot is displayed. When you change the content layout 
of a slot, a “Slot” asset is created and stored in the WebCenter Sites database. When you 
approve the asset, you must also approve the “Slot” assets associated with that asset. This 
section provides instructions for changing the content layout (template) of a slot.

To change the content layout of a slot

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset. Do one of the following:

- Search for and open the desired asset:

1) In the Search field, enter search criteria identifying the asset and click the 
magnifying glass ( ) button.

2) In the search results list, click the name of the asset.

- If you previously bookmarked the asset, open it from the Bookmarks node in the 
My Work tree:

1) In the My Work tree, expand the Bookmarks node. (If the My Work tree is 
collapsed, expand it by clicking the My Work bar in the navigation pane.)

2) In the list of bookmarked assets, double-click the name of the desired asset.

For more information about finding assets, see Chapter 6, “Finding and Organizing 
Assets.”

A tab opens displaying the Inspect view of the asset in either Form Mode or Web 
Mode. (In this example, we use the Tennis Page asset.)

3. If the asset is displayed in Form Mode, switch to Web Mode. 

a. In the asset’s toolbar, click the Mode switch.

b. If the asset is not assigned to a template (web page layout), the “Select Layout” 
dialog box is displayed. Select the desired layout and then click Apply.

The tab re-displays the asset’s Inspect view in Web Mode.

4. In the asset’s toolbar, click the Edit ( ) icon.
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The tab displays the Edit view of the asset in Web Mode.

5. Change the content layout (template) of a slot containing an asset:

a. Click in the slot whose content layout (template) you wish to change. For 
example:

If the slot is multi-valued, when you click it, two or more slots will be highlighted 
along with the slot whose content layout you wish to change. In this case, the 
toolbar will display only the Edit and Manage options (shown below). Click the 
Edit option. 

Slot toolbar
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Now you can click the individual slots within the multi-valued slot. Click the 
desired slot to display its toolbar.

b. In the slot toolbar, click the Change content layout option.

The “Change Content Layout” dialog opens.

c. Select the desired layout and then click Apply.

The content contained within the slot is rendered with the selected layout. For 
example:

6. Save the asset by doing one of the following:

- In the asset’s toolbar, click the Save ( ) icon.

- In the menu bar, select Content > Save.

WebCenter Sites saves the asset to the database, unless:

- You have left out one or more required field(s).

- An entry or selection you have made in one or more field(s) is not permitted.

Note

If you do not see the Change content layout option in the toolbar, stop 
here. The slot does not support this type of editing.
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If either of the above is true, WebCenter Sites displays an error message indicating the 
offending fields. Correct the errors, then save the asset. 

7. Inspect the asset by doing one of the following:

- In the asset’s toolbar, click the Inspect ( ) icon.

- In the menu bar, select Edit > Inspect.

The tab displays the Inspect view of the asset in Web Mode. When you inspect an 
asset, you cannot modify its content.

8. Preview the asset:

a. In the asset’s toolbar, click the Preview ( ) icon.

The tab displays the preview of the asset. For detailed instructions about 
previewing an asset, see Chapter 7, “Previewing Assets.”

b. When you are done previewing the asset, click the Go Back ( ) icon.

The tab re-displays the asset in Web Mode.

Editing Associations
When working with an asset in Web Mode, you can edit its associations by adding an asset 
to an empty slot, replacing an asset currently displayed in a slot with a different asset, 
repositioning the assets displayed in a multi-valued slot, and removing an asset from a 
slot. 

This section contains instructions on the following:

• Adding or Replacing an Association

• Editing the Content of an Associated Asset

• Removing Associations

• Changing the Position of Content Displayed in a Multi-Valued Slot

Adding or Replacing an Association
This section shows you how to create or replace an association between two assets by 
dragging and dropping the asset you wish to associate into the desired slot space of the 
asset you are working with in Web Mode.

To add or replace an association

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset. Do one of the following:

- Search for and open the desired asset:

1) In the Search field, enter search criteria identifying the asset and click the 
magnifying glass ( ) button.

2) In the search results list, click the name of the asset.

- If you previously bookmarked the asset, open it from the Bookmarks node in the 
My Work tree:

1) In the My Work tree, expand the Bookmarks node. (If the My Work tree is 
collapsed, expand it by clicking the My Work bar in the navigation pane.)
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2) In the list of bookmarked assets, double-click the name of the desired asset.

For more information about finding assets, see Chapter 6, “Finding and Organizing 
Assets.”

A tab opens displaying the Inspect view of the asset in either Form Mode or 
Web Mode. (In this example, we use the 25 Nevada Resorts Serving Snow “Article” 
asset.)

3. If the asset is displayed in Form Mode, switch to Web Mode. 

a. In the asset’s toolbar, click the Mode switch.

b. If the asset is not assigned to a template (web page layout), the “Select Layout” 
dialog box is displayed. Select the desired layout and then click Apply.

The tab re-displays the asset’s Inspect view in Web Mode.

4. In the asset’s toolbar, click the Edit ( ) icon.

The tab displays the Edit view of the asset in Web Mode.

5. Determine the slot into which you wish to place the asset. If the slots are already 
populated, determine which slot’s content you wish to replace.

6. Associate an asset to the asset you are working with:

a. Find the asset you want to place in the slot. Do one of the following:

- In the Search field, enter search criteria identifying the asset and click the 
magnifying glass ( ) button.

The search results list is displayed to the right of the asset you are working 
with.

- If you previously bookmarked the asset, expand the Bookmarks node in the 
My Work tree. (If the My Work tree is collapsed, expand it by clicking the 
My Work bar in the navigation pane.)

For more information about finding assets, see Chapter 6, “Finding and 
Organizing Assets.”
Oracle WebCenter Sites User’s Guide



Chapter 4 Creating, Sharing, and Editing Assets in Web Mode

 Editing Assets in Web Mode
109

 is 
 a green 
e asset 
b. In the list of assets, click the name of the asset you want to add to the slot, hold 
down the button on the mouse and drag the asset to the desired slot. 

As you drag the asset to the desired slot, the asset’s name is displayed as a floating 
object. The slot into which you can drop the asset can either be empty or occupied. 
In this example, the asset is being dragged over an empty slot. 

When you hover the asset over the slot, if the slot supports that type of asset, a 
green-dotted border is displayed around it (as shown above). If the slot does not 
support that type of asset, a red-dotted border is displayed around it. 

c. Drop the asset into the slot. 

1. Click the name of the 
asset you wish to place 
in the slot and hold 
down the button on the 
mouse to drag it.

2. Drag the asset’s name 
over the slot.

3. When the slot
surrounded by
border, drop th
into the slot.
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The asset you dropped into the slot is now associated with the asset you are 
working with. If the slot into which you drop the asset is already populated, the 
asset that was replaced is removed from the slot and as an association of the asset 
with which you are working.

7. Save your changes by doing one of the following:

- In the asset’s toolbar, click the Save ( ) icon.

- In the menu bar, select Content > Save. 

WebCenter Sites saves the asset to the database, unless:

- You have left out one or more required field(s).

- An entry or selection you have made in one or more field(s) is not permitted.

If either of the above is true, WebCenter Sites displays an error message indicating the 
offending fields. Correct the errors, then save the asset. 

8. Inspect the asset by doing one of the following:

- In the asset’s toolbar, click the Inspect ( ) icon.

- In the menu bar, select Edit > Inspect.

The tab displays the Inspect view of the asset in Web Mode. When you inspect an 
asset, you cannot modify its content.

9. Preview the asset:

a. In the asset’s toolbar, click the Preview ( ) icon.

The tab displays the preview of the asset. For detailed instructions about 
previewing an asset, see Chapter 7, “Previewing Assets.”

b. When you are done previewing the asset, click the Go Back ( ) icon to display 
the asset in Web Mode.

Editing the Content of an Associated Asset
When working with an asset in Web Mode, you can edit the content of its associated 
asset(s) either directly in the slot which displays the associated asset or in a new tab. If you 
edit the content of an associated asset in a new tab, when you save that asset, the changes 
you made are reflected in the slot that displays the asset.

To edit the content of an associated asset

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset. Do one of the following:

- Search for and open the desired asset:

1) In the Search field, enter search criteria identifying the asset and click the 
magnifying glass ( ) button.

2) In the search results list, click the name of the asset.

- If you previously bookmarked the asset, open it from the Bookmarks node in the 
My Work tree:

1) In the My Work tree, expand the Bookmarks node. (If the My Work tree is 
collapsed, expand it by clicking the My Work bar in the navigation pane.)
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2) In the list of bookmarked assets, double-click the name of the desired asset.

For more information about finding assets, see Chapter 6, “Finding and Organizing 
Assets.”

A tab opens displaying the Inspect view of the asset in either Form Mode or 
Web Mode. (In this example, we use the 25 Nevada Resorts Serving Snow “Article” 
asset.)

3. If the asset is displayed in Form Mode, switch to Web Mode. 

a. In the asset’s toolbar, click the Mode switch.

b. If the asset is not assigned to a template (web page layout), the “Select Layout” 
dialog box is displayed. Select the desired layout and then click Apply.

The tab re-displays the asset’s Inspect view in Web Mode.

4. In the asset’s toolbar, click the Edit ( ) icon.

The tab displays the Edit view of the asset in Web Mode.
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5. Click the slot containing the associated asset you wish to edit.

The slot toolbar is displayed. If the slot is configured to allow you to edit its content, 
you will see either the Edit option, the Open in new tab option, or both. 

If the slot is multi-valued, when you click it, you will see only the Edit and Manage 
options. Click the Edit option to access the individual slots within the multi-valued 
slot. Click an individual slot to display its toolbar (shown above).

6. Edit the associated asset displayed in the slot. Do one of the following:

- If you wish to edit the associated asset directly in the slot:

1) In the slot’s toolbar, click the Edit option. 

2) Point to the areas of the asset. Any area that becomes highlighted is editable.

3) Make your changes to the associated asset.

- If you wish to edit the associated asset in a new tab:

1) In the slot’s toolbar, click the Open in new tab option.

A new tab opens displaying the Inspect view of the associated asset in either 
Form Mode or Web Mode.

2) In the associated asset’s toolbar, click the Edit ( ) icon.

3) Make your changes to the associated asset. 

-    If the asset is displayed in Web Mode, see steps 5 – 8 on page 93 for 
details on the fields you may see.

-    If the asset is displayed in Form Mode, see step 4 on page 66 for details on 
the fields you may see. 

4) Save and close the asset. In the menu bar, select Content > Save & Close.

5) Switch back to the tab displaying the asset you are working with (which you 
opened in step 2 on page 110).

6) Refresh the asset whose slot displays the associated asset you edited. In the 
asset’s toolbar, click the Refresh ( ) icon.

The slot containing the associated asset you edited displays the asset with the 
changes you made.

7. Save your changes by doing one of the following:

- In the asset’s toolbar, click the Save ( ) icon.

- In the menu bar, select Content > Save.

WebCenter Sites saves the asset to the database, unless:

- You have left out one or more required field(s).

- An entry or selection you have made in one or more fields is not permitted.

If either of the above is true, WebCenter Sites displays an error message indicating the 
offending fields. Correct the errors, then save the asset. 

Open in new tab

Edit (directly in the slot)
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8. Inspect the asset by doing one of the following:

- In the asset’s toolbar, click the Inspect ( ) icon.

- In the menu bar, select Edit > Inspect.

The tab displays the Inspect view of the asset in Web Mode. When you inspect an 
asset, you cannot modify its content.

9. Preview the asset:

a. In the asset’s toolbar, click the Preview ( ) icon.

The tab displays the preview of the asset. For detailed instructions about 
previewing an asset, see Chapter 7, “Previewing Assets.”

b. When you are done previewing the asset, click the Go Back ( ) icon to display 
the asset in Web Mode.

Removing Associations
When you are working with an asset in Web Mode and you remove an asset from a slot, 
you are also removing the association between the asset you are working with and the 
asset you removed from the slot.

To remove an associated asset

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset. Do one of the following:

- Search for and open the desired asset:

1) In the Search field, enter search criteria identifying the asset and click the 
magnifying glass ( ) button.

2) In the search results list, click the name of the asset.

- If you previously bookmarked the asset, open it from the Bookmarks node in the 
My Work tree:

1) In the My Work tree, expand the Bookmarks node. (If the My Work tree is 
collapsed, expand it by clicking the My Work bar in the navigation pane.)

2) In the list of bookmarked assets, double-click the name of the desired asset.

For more information about finding assets, see Chapter 6, “Finding and Organizing 
Assets.”

A tab opens displaying the Inspect view of the asset in either Form Mode or 
Web Mode. (In this example, we use the 25 Nevada Resorts Serving Snow “Article” 
asset.)

3. If the asset is displayed in Form Mode, switch to Web Mode. 

a. In the asset’s toolbar, click the Mode switch.

b. If the asset is not assigned to a template (web page layout), the “Select Layout” 
dialog box is displayed. Select the desired layout and then click Apply.

The tab re-displays the asset’s Inspect view in Web Mode.

4. In the asset’s toolbar, click the Edit ( ) icon.
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The tab displays the Edit view of the asset in Web Mode.

5. Click the slot containing the asset you wish to remove.

The slot’s toolbar is displayed. 

6. Click the Clear Slot ( ) option to remove the asset from the slot.

The asset is removed from the slot. The asset you removed is no longer associated 
with the asset you are working with.

7. Save your changes by doing one of the following:

- In the asset’s toolbar, click the Save ( ) icon.

- In the menu bar, select Content > Save. 

WebCenter Sites saves the asset to the database, unless:

- You have left out one or more required field(s).

- An entry or selection you have made in one or more fields is not permitted.

If either of the above is true, WebCenter Sites displays an error message indicating the 
offending fields. Correct the errors, then save the asset. 
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8. Inspect the asset by doing one of the following:

- In the asset’s toolbar, click the Inspect ( ) icon.

- In the menu bar, select Edit > Inspect.

The tab displays the Inspect view of the asset in Web Mode. When you inspect an 
asset, you cannot modify its content.

9. Preview the asset:

a. In the asset’s toolbar, click the Preview ( ) icon.

The tab displays the preview of the asset. For detailed instructions about 
previewing an asset, see Chapter 7, “Previewing Assets.”

b. When you are done previewing the asset, click the Go Back ( ) icon to display 
the asset in Web Mode.

Changing the Position of Content Displayed in a Multi-
Valued Slot
If the asset you are working with in Web Mode has a multi-valued slot, you can reposition 
the order in which its associated assets are displayed on the web page by moving an asset 
from one slot to another.  

To change the order in which content is displayed in a multi-valued slot

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset. Do one of the following:

- Search for and open the desired asset:

1) In the Search field, enter search criteria identifying the asset and click the 
magnifying glass ( ) button.

2) In the search results list, click the name of the asset.

- If you previously bookmarked the asset, open it from the Bookmarks node in the 
My Work tree:

1) In the My Work tree, expand the Bookmarks node. (If the My Work tree is 
collapsed, expand it by clicking the My Work bar in the navigation pane.)

2) In the list of bookmarked assets, double-click the name of the desired asset.

For more information about finding assets, see Chapter 6, “Finding and Organizing 
Assets.”

A tab opens displaying the Inspect view of the asset in either Form Mode or 
Web Mode. (In this example, we use the 25 Nevada Resorts Serving Snow “Article” 
asset.)

3. If the asset is displayed in Form Mode, switch to Web Mode. 

a. In the asset’s toolbar, click the Mode switch.

b. If the asset is not assigned to a template (web page layout), the “Select Layout” 
dialog box is displayed. Select the desired layout and then click Apply.

The tab re-displays the asset’s Inspect view in Web Mode.

4. In the asset’s toolbar, click the Edit ( ) icon.
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The tab displays the Edit view of the asset in Web Mode.

5. Determine which slot is multi-valued. The configurations your developers made to the 
web page layout (template) assigned to the asset determines how multi-valued slots 
are displayed in an asset’s Edit view. For information about which slots are multi-
valued on your site, see your developers.
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In our example (working with the 25 Nevada Resorts Serving Snow “Article” asset), 
when you point to a multi-valued slot, two or more slots associated with the multi-
valued slot are highlighted with a blue overlay, as shown below:

6. Click in the desired multi-valued slot. A multi-valued slot’s toolbar displays the Edit 
and Manage options. For example:

Multi-valued slot

Manage

Edit
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7. In the multi-valued slot’s toolbar, click the Manage option.

The following dialog box opens:

8. In the Manage dialog box, reposition the assets displayed in the multi-valued slot. 
Click the name of the desired asset and then drag and drop it into the desired position.

9. In the Manage dialog box, click Save.
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lot 
 
sets 
 you 
The assets are displayed in the desired order in the multi-valued slot.

10. Save your changes by doing one of the following:

- In the asset’s toolbar, click the Save ( ) icon.

- In the menu bar, select Content > Save. 

WebCenter Sites saves the asset to the database, unless:

- You have left out one or more required field(s).

- An entry or selection you have made in one or more fields is not permitted.

If either of the above is true, WebCenter Sites displays an error message indicating the 
offending fields. Correct the errors, then save the asset. 

11. Inspect the asset by doing one of the following:

- In the asset’s toolbar, click the Inspect ( ) icon.

- In the menu bar, select Edit > Inspect.

The tab displays the Inspect view of the asset in Web Mode. When you inspect an 
asset, you cannot modify its content.

12. Preview the asset:

a. In the asset’s toolbar, click the Preview ( ) icon.

The tab displays the preview of the asset. For detailed instructions about 
previewing an asset, see Chapter 7, “Previewing Assets.”

b. When you are done previewing the asset, click the Go Back ( ) icon to display 
the asset in Web Mode.

Multi-valued s
displaying the
associated as
in the position
specified.
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Chapter 5

Deleting Assets
This chapter contains instructions for deleting assets from the WebCenter Sites database.  

This chapter contains the following sections:

• Overview

• Asset Deletion Rules

• How Do I Delete Assets?
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Overview 
Use the WebCenter Sites delete function to delete assets from the WebCenter Sites 
database. This function allows the deletion of multiple assets at one time, if desired.

When you use the Delete function, the asset is not entirely removed from the database. 
The contents of the asset are emptied; however, the ID remains in the database as a record 
of the asset’s existence. This simple record is called a “voided asset.” 

When a previously published asset is voided in the content management system, the 
voided asset is automatically approved for publishing to any destination the asset has ever 
been published to. The voided asset is placed in the publish queue, and published during 
the next publishing session. The voided asset then overwrites the previously published 
asset.

Voided assets are not returned in search results.

Asset Deletion Rules
The following restrictions are enforced when you delete assets:

• You can delete an asset only if you have the permissions to do so.

• If an asset is in a workflow and is assigned to someone other than you, you cannot 
delete that asset even if you have the permissions to delete assets.

• You cannot delete a placed “Page” asset.

• You cannot delete an asset if it is associated with another asset. If you attempt to do so, 
WebCenter Sites displays a list of the references preventing deletion. You can then 
remove the references and continue with the deletion.
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How Do I Delete Assets?

To delete assets

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find the asset(s) to delete. In the Search field, enter search criteria identifying the 
asset and click the magnifying glass ( ) button.

A “Search” tab opens displaying a list of assets matching your search criteria.

For more information on finding assets, see “Finding and Organizing Assets,” on 
page 125.

3. Select the asset(s) you wish to delete. Do one of the following:

- If you want to inspect an asset before you delete it:

1) In the list of search results, click the name of the asset you wish to delete. 

A tab opens displaying the asset’s Inspect view (in either Form Mode or Web 
Mode).

2) In the asset’s toolbar click the Delete ( ) icon.

- If you want to delete multiple assets: 

1) In the list of search results, select (Ctrl + click) the assets you wish to delete.

2) In the “Search” tab’s toolbar, click the Delete ( ) icon.

The “Delete Asset(s)” screen displays a table with deletion details for the asset(s) you 
wish to delete:

4. Delete the asset(s). In the “Delete Asset(s)” screen, click Select All and then click 
Delete.

One of the following happens:

- If the assets you are deleting do not reference any other assets, the “Detail” 
column of the table displays the message “Asset Deleted” in the row associated 
with each deleted asset.

- If any of the assets you selected to delete have dependencies preventing the 
deletion, the “Detail” column of the table displays the message “Asset cannot be 
deleted due to n reference(s).” In this case, click View References in the “Action” 
column of the asset.

Caution

Be careful when you delete assets. You cannot “undo” a deletion.
Oracle WebCenter Sites User’s Guide



Chapter 5.  Deleting Assets

 How Do I Delete Assets?
124
The assets blocking the deletion are displayed, below the table containing the 
assets you wish to delete, in the “Assets that reference Name of Asset” section. If 
you do not remove the references to an asset, the asset cannot be deleted. 

1) Remove the references to the asset you wish to delete:

-    To remove references individually, click Remove reference(s) in the 
“Action” column of each referenced asset’s row.

-    To remove all referenced assets at once, click Select All and then click 
Remove reference(s).

-    If you do not wish to remove any of the references at this time, you have 
the option of cancelling out of the deletion by clicking the Go Back ( ) 
icon.  

When you remove the reference(s) to the asset you wish to delete, the 
“Action” column of that asset displays the link “Delete Now.”

2) Delete the asset(s). In the “Delete Asset(s)” section, select the asset(s) you 
wish to delete and then click Delete. You can also delete assets individually 
by clicking the Delete Now link in each desired asset’s “Action” column.    

The database status of the deleted asset(s) changes to “void.” 
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Chapter 6

Finding and Organizing Assets
WebCenter Sites provides an easy and effective way to find assets you want to work on. 
Once you find them, you can both save the search criteria you used to find the assets and 
organize the assets into a personalized list for easy future access. 

This chapter describes the basic procedures for finding and organizing assets, illustrated 
with examples from the avisports sample site.

This chapter contains the following sections:

• Finding Assets

• Conducting an Advanced Search

• Organizing Assets
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Finding Assets
WebCenter Sites allows you to easily find assets matching the criteria you specify. Note 
that search results will include only assets that you have permissions to work with. 
(Permissions are set by your administrator.)

Search Behavior in the WebCenter Sites Contributor Interface
The WebCenter Sites Contributor interface is integrated with the Lucene search engine. 
Because of this integration, the search behavior in the Contributor interface is as follows:

• Before you can perform searches in the Contributor interface, the administrator must 
enable search indexing on your system (through the WebCenter Sites Admin 
interface).

• The Contributor interface allows you to search across all asset types in a given site. 
You do not have to know the asset type of the asset(s) you want to find in order to 
begin a search. You do, however, have the option to limit your search to a specific 
asset type.

• The Contributor interface searches through the names and values of all fields within 
all assets. For example, you can search for all assets that contain the word flowers 
without having to select specific attribute names to search through.

• The Contributor interface allows you to customize your searches by formulating your 
search queries, as described in “Search Guidelines.”

Search Guidelines
When performing searches in the Contributor interface, use the guidelines in Table 2 to 
formulate your search queries. Customizing your search queries allows you to perform 
more precise searches.

Note that searching in the Contributor interface is not case-sensitive. For example, 
searching for Jack will return assets that contain Jack and assets that contain jack.

Table 2: Lucene search query guidelines

To find... ...do the following Example

Assets that contain a 
phrase.

Enclose the phrase in 
quotes.

To find assets that contain the 
phrase blue flowers, enter 
“blue flowers” as your search 
query.

Assets that contain 
variations of a term. (The 
variations must match the 
character length of the 
term.)

Use the ? (question mark) 
symbol to indicate a single-
character wildcard. A 
search term cannot begin 
with a wildcard.

To find assets that contain test 
or text, enter te?t as your 
search query. To find assets that 
contain either book or back, 
enter b??k as your search 
query.
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Assets that contain 
variations of a term. (The 
variations may or may 
not match the character 
length of the term.)

Use the * symbol to 
indicate a multi-character 
wildcard. 
A search term cannot begin 
with a wildcard.

To find assets that contain test, 
tester, or testing, enter test* as 
your search query. To find 
assets that contain jeanne or 
jeanine, enter jea*e as your 
search query.

Assets that contain all of 
the specified terms.

Join the terms with the 
AND operator.

To find assets that contain both 
jack and jill, enter jack AND 
jill as your search query.

Assets that contain a 
specific term but do not 
contain another term you 
specify.

Exclude the unwanted 
terms using the NOT 
operator.

To find assets that contain jack 
but do not contain jill, enter 
jack NOT jill as your search 
query.

Assets that must contain a 
specific term and may 
contain another term you 
specify.

Precede a term with the + 
(required) operator to 
indicate it is a required 
term.

To find assets that must contain 
jack and may contain jill, enter 
+jack jill as your search query.

Assets that contain a 
specific term, excluding 
assets that also contain 
another term you specify. 

Precede a term with the - 
(prohibited) operator to 
indicate the exclusion.

To find assets that contain jack 
but exclude those that also 
contain jill, enter jack -jill as 
your search query.

Assets that contain terms 
similar in spelling to the 
term you specify.

Append the ~ (tilde) 
operator to a term to 
perform a fuzzy search on 
that term.

To find assets that contain jack, 
including occurrences that are 
misspelled, enter jack~ as your 
search query.

Table 2: Lucene search query guidelines (continued)

To find... ...do the following Example
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Searching for Assets

To search for an asset

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Specify your search criteria as follows:

a. In the Search field, enter the desired search criteria. Refer to “Search Guidelines,” 
on page 126 to find out how to formulate your search query to narrow the scope of 
your search.

b. (Optional) In the Search field, click the down-arrow to render the “Search Type” 
drop-down box. Select the asset type to which you want to limit your search. If 
you do not make a selection, WebCenter Sites will search across all asset types in 
the current site.

3. Click the magnifying glass ( ) button.

- If you are not currently working with any assets, WebCenter Sites displays the 
search results list in a “Search” tab.

Note

The asset types for which you can search are determined by your permissions and 
the asset types available from the Contributor interface.

Note

In the Contributor interface, your search results are based on information drawn 
from a database index which is updated at regular intervals. After creating or 
editing an asset, there might be a short delay before those changes are reflected 
in the search results. If you have questions, consult your WebCenter Sites 
administrator.
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- If you are working with an asset, the search results list is automatically docked to 
the right of the workspace.

4. Dock or undock the search results list. Click Dock to display the search results list to 
the right of the workspace. Click Undock to view the search results list in the 
“Search” tab.

5. Select whether you want to view your search results in List View or Thumbnail View.

- To display your search results as a list, click the List View option at the top of the 
search results list.

- To display each asset in your search results as a thumbnail image, click the 
Thumbnail View option at the top of the search results list.

Thumbnail View

List View
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6. Sort your search results:

- If your search results are displayed in the “Search” tab (undocked) in List View, 
sort your search results by clicking one of the columns:

- Name

- Type

- Locale

- Modified

- If the search results list is displayed to the right of the workspace (docked) or if 
the search results are displayed in the Thumbnail View, click the Sort option at 
the top of the search results list and select one of the following options (depending 
on how you want to sort the results):

- Name (A – Z)

- Name (Z – A)

- Asset Type

- Locale

- Modified (Newest First)

- Modified (Oldest First)

Your search results are listed in the order you specify.

Navigating Through Your Search Results
The search results list displays 100 assets per page of results. To easily navigate through 
the results of your search, you can:

• Limit the number of search results that are displayed in the list. At the bottom of the 
search results list, click All to display all search results in the list at the same time.

• Go to the next page of search results by clicking the Next Page icon at the bottom of 
the search results list.

• Go back to the previous page of search results by clicking the Previous Page icon at 
the bottom of the search results list.

Tip

Once your results are sorted, click the same column again to reverse the sort 
order.
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• Skip to the last page of search results by clicking the Last Page icon at the bottom of 
the search results list.

• Skip to the first page of search results by clicking the First Page icon at the bottom of 
the search results list.

• Go to a specific page of results by selecting the desired page number, located at the 
bottom of the search results list.

Saving Your Search Criteria (Creating SmartLists)
WebCenter Sites provides the SmartList feature which allows you to save the search 
criteria you used to conduct a given search. All SmartLists you create are accessible from 
the “SmartLists” section of your dashboard (Home tab). A SmartList can either be made 
public (shared with users assigned certain roles) or kept private (accessible only to the user 
who created it) depending on how the SmartList is saved.

To create a SmartList

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. In the Search field, enter the criteria you wish to search for. To conduct an advanced 
search, see “Conducting an Advanced Search,” on page 133

3. Click the magnifying glass ( ) button. If you are conducting an advanced search, 
click Run Advanced Search.

The search results list is displayed either in a tab named “Search” or docked to the 
right of your workspace.

4. Make sure the search results list is displayed in the “Search” tab. If the search results 
list is docked, click Undock.

5. Click (Create SmartList).

The following dialog is displayed:

a. In the “Enter Name” field, enter a name to uniquely identify the SmartList you are 
creating.

b. If you want to share this SmartList with other WebCenter Sites users:
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1) Click Share.

2) In the “Available” list box, select the roles with which you wish to share this 
SmartList and move them to the “Selected” list box.

c. Click Save.

The SmartList is displayed in the “Smart Lists” section of your dashboard (Home 
tab). If you shared the SmartList, any users with the roles you specified will also 
see the SmartList in their dashboards.

6. If you want to conduct a search using the same search criteria you specified when you 
created the SmartList: 

a. Access the dashboard by clicking the Home ( ) tab.

b. In the “SmartLists” section of the dashboard, select the SmartList containing the 
criteria for which you wish to search. 

The “Search” tab opens displaying up-to-date results matching the saved search 
criteria. 
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Conducting an Advanced Search
Advanced searches enable you to search for assets by creation date, start and end date, 
locale, unique identifier, name, description, author, and type – or any combination of these 
items. 

To perform an advanced search for an asset

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. In the Search field, select the down-arrow and then click Advanced Search.

The “Search” tab displays the “Advanced Search” screen.

3. In the “Advanced Search” screen, specify criteria in as many of the fields that follow 
as you need to narrow your search:  

a. In the “Find content that contains” section, specify how to match search 
conditions:

1) In the text box, enter words or phrases for which to search. The same options 
described in “Search Guidelines,” on page 126, may be used in this field.

2) Specify conditions that the results of the search must match:

-    To have your search results match all the search criteria you specify, select 
All of these words from the drop-down list.

-    To have your search results match any one of the search criteria you 
specify, select Any of these words from the drop-down list.

b. In the “And meets the following conditions” section, specify any other criteria 
that the results of the search must meet:

- Search for assets whose names contain criteria specified in the Name field.
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- Search for assets whose descriptions contain criteria specified in the 
Description field.

- Search for assets whose unique identifiers contain criteria specified in the Id 
field.

- If your company tracks multilingual content using Locales, you can limit your 
search to assets in a selected location by choosing an option from the Locale 
drop-down list. For more information about managing multilingual content 
and about the Locale field, see “Working with Multilingual Assets,” on 
page 201.

- Search for assets created by a specific user by selecting the name of the 
desired content provider from the Author drop-down list.

- Search for a range of time in which assets were created by selecting a time 
from the Modified field. If you select Custom Range, enter the date you 
want to search from and to in the “From” and “To” fields. 

- Search only assets of a particular type by selecting an item from the 
Asset Type drop down list. You may see one or both of the following fields 
depending on the configurations made to the Lucene search engine by your 
site administrator:

-    If the asset type you chose has multiple subtypes associated with it, narrow 
your asset type search to a specific subtype, by specifying a subtype in the 
Asset Subtype field.

-    If the site administrator configured the Asset Type Search and Attributes 
for Asset Type Index search in the WebCenter Sites Admin interface, 
you will see the “Enter search keyword for asset attributes” section. Limit 
a search to specific attributes of an asset type by selecting the attribute 
from the drop-down menu and clicking Add. 

4. Click Run Advanced Search to conduct a search using the criteria you specified. To 
reset the fields in the “Advanced Search” screen, click Reset.

Note

For information about configuring search features in the 
WebCenter Sites Admin interface, see the Oracle WebCenter Sites 
Administrator’s Guide.
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Organizing Assets
WebCenter Sites allows you to keep track of your workload with the My Work tree 
(located in the navigation pane). The My Work tree contains the Bookmarks and History 
nodes, as follows:

• Bookmarks – returns a list of assets that you have bookmarked. Bookmarked assets 
are also listed in the “Bookmarks” section of the dashboard (located in the Home tab). 
For instructions about bookmarking assets, see “Bookmarking Assets,” on page 136.

• History – returns a list of assets you have worked on during the current session in the 
current site. This list is cleared every time you log out of WebCenter Sites.

You cannot create, modify, or delete the nodes in the My Work tree. However, you can 
control which assets are added to the Bookmarks node. By adding assets to the 
Bookmarks node, you create a personalized list of assets that you can easily retrieve in 
the future. You can add and delete assets from the Bookmarks node at any time. On the 
other hand, the History node keeps track of the assets you work with in the current 
session. This allows you to refer back to these assets at any time during your session. 
When you expand a node (Bookmarks or History), the assets contained within that node 
are listed underneath. An asset can be included in both tree nodes at the same time.

Note

The My Work tree is used only for managing and organizing your work. You cannot 
use the My Work tree to group assets for delivery purposes.
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Bookmarking Assets
Bookmarking allows you to add select assets to the Bookmarks node in the My Work 
tree, which makes those assets easy to retrieve at a later time. Bookmarked assets are also 
listed in the “Bookmarks” section of your dashboard (located in the Home tab). You can 
bookmark an asset you are currently working with and bookmark multiple assets included 
in a search results list. 

To bookmark assets

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Perform a search, as described in “Finding Assets,” on page 126.

3. If the search results list is docked to the right of the workspace, click Undock to 
display the search results list in the “Search” tab. 

4. Bookmark the desired asset(s). Do one of the following:

- To inspect the asset’s content before you bookmark it:

a) In the search results list, navigate to and click the name of the desired asset.

A tab opens displaying the asset’s Inspect view in either Form Mode or Web 
Mode.

b) In the menu bar, select Content > Bookmark.

- To bookmark multiple assets directly in a search results list:

a) In the search results list, select (Ctrl+ click) the assets you want to bookmark.

b) In the “Search” tab’s toolbar, click the Bookmark ( ) icon. 

A message is displayed stating the number of bookmarks that were created. 
WebCenter Sites adds the selected asset(s) to the Bookmarks node (in the My Work 
tree) and the “Bookmarks” section of the dashboard (located in the Home tab). 

5. Verify that the assets you selected have been added to the list of bookmarked assets. 
For instructions, see “Accessing Bookmarked Assets,” on page 137.
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Accessing Bookmarked Assets
Bookmarked assets can be accessed in the following ways:

• From the “Bookmarks” section of the dashboard (in the Home tab).

• From the My Work tree under the Bookmarks node. 

To access bookmarked assets from the dashboard

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. In the Home ( ) tab, navigate to the “Bookmarks” section of the dashboard.

3. In the “Bookmarks” section of the dashboard, navigate to and click the name of the 
desired asset.

A tab opens displaying the Inspect view of the asset in either Form Mode or 
Web Mode.

To access bookmarked assets from the ‘My Work’ tree

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. In the navigation pane, click the My Work bar.

3. In the My Work tree, expand the Bookmarks node by clicking the plus-sign next to 
it.

A list of bookmarked assets is displayed underneath the Bookmarks node.

4. Navigate to and double-click the desired asset.

A tab opens displaying the Inspect view of the asset in either Form Mode or Web 
Mode.
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Unbookmarking Assets
If you no longer want an asset to be bookmarked, you can remove the asset from the 
bookmarked assets list. When you unbookmark an asset, the asset is removed from the 
Bookmarks node in the My Work tree and from the “Bookmarks” section of your 
dashboard.

To unbookmark assets from the ‘My Work’ tree

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. In the navigation pane, if the My Work tree is collapsed, expand it by clicking the 
My Work bar.

3. In the My Work tree, expand the Bookmarks node by clicking the plus-sign.

A list of bookmarked assets is displayed underneath the Bookmarks node.

4. In the list of bookmarked assets, double-click the asset you wish to unbookmark.

A tab opens displaying the asset’s Inspect view in either Form Mode or Web Mode.

5. In the menu bar, select Content > Unbookmark.

A message is displayed under the asset’s toolbar stating that the bookmark was 
successfully removed. WebCenter Sites removes the asset from the Bookmarks node 
in the My Work tree and from the “Bookmarks” section of the dashboard (in the 
Home tab).

To unbookmark assets from the dashboard

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Access the dashboard by clicking the Home ( ) tab.

3. Navigate to the “Bookmarks” section of the dashboard.
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4. In the list of bookmarked assets, select the row containing the asset you wish to 
remove from the list of bookmarked assets.

5. Click Delete Bookmark.

A pop-up window opens displaying the following message:

6. Click Yes.

WebCenter Sites removes the asset from the “Bookmarks” section of the dashboard 
and from the Bookmarks node in the My Work tree.

Accessing Assets from the ‘History’ Node
The History node, in the My Work tree, keeps track of all the assets you have worked 
with in the current session, which allows you to quickly refer back to those assets during 
the session.

To access assets from the History node 

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. In the navigation pane, click the My Work bar.

3. In the My Work tree, expand the History node by clicking the plus-sign.

Note

Assets cannot be manually removed from the History node. Instead, the list of 
assets contained within the History node is cleared every time you log out of 
WebCenter Sites.
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4. In the History node, navigate to and double-click the desired asset.

A tab opens displaying the Inspect view of the asset in either Form Mode or 
Web Mode.
Oracle WebCenter Sites User’s Guide



141
Chapter 7 

Previewing Assets
This chapter describes how to use the Preview function to preview assets as they will be 
displayed on the website once they are published. Since websites change from moment to 
moment and day to day, WebCenter Sites offers the Future Preview feature. 
Future Preview enables you to view site assets as they will be displayed on the website at 
any particular moment in the future. This chapter is illustrated with examples from the 
FirstSite II sample site.

This chapter contains the following sections:

• Overview

• How Do I Preview Assets?

• Previewing Future Sites
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Overview
The Contributor interface allows you to preview how an asset will be displayed on the 
website once it is published (as shown in Figure 16). When you preview an asset, you 
cannot modify its content. However, you can choose to preview how the asset would look 
if it were rendered by a different template or wrapper.

Figure 16: Preview of the FirstSite II sample site’s FSIIAbout asset  

While previewing an asset, you can choose to preview how the asset will look on the 
website at a future date. This feature is called Future Preview and is discussed later in this 
chapter. Future preview combines the use of start and end dates (also discussed later in this 
chapter) with the preview feature to show how an asset will be displayed on the website at 
a given time and date in the future.

Go back to the Inspect or 
Edit view of the asset in 
either Form Mode or Web 
Mode

Name of the current preview 
template. Click the icon to 
change the template with which 
you are previewing the asset

Preview the asset as it will 
appear on a specific date
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How Do I Preview Assets?
Previewing an asset renders the asset as it would be displayed on the website if it were 
published. To preview an asset, the following conditions must be satisfied:

• You must have the appropriate permissions.

• The asset must have a template assigned to it.

You can preview an asset in several ways. For example:

• Use the Search field in the Contributor interface to find the desired asset. You can 
either open the asset and then preview it or preview the asset directly from the search 
results list.

• Drill down the Site Tree or My Work tree in the navigation pane. You can either 
right-click the desired asset and preview it directly from the tree or open the desired 
asset in its Inspect or Edit view and then preview it. 

• Drill down the Content Tree and double-click the parent asset associated with the 
asset you wish to preview. In the “Browse” tab that lists the assets associated with the 
selected parent asset, navigate to and preview the desired asset.

• Preview an asset you are currently working with.

To preview an asset

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset you want to preview. Do the following:

a. In the Search field, enter search criteria identifying the asset and click the 
magnifying glass ( ) button. 

For more information about searching for assets, see “Finding Assets,” on 
page 126.

b. In the list of search results, navigate to and click the desired asset’s name.

A tab opens displaying the asset’s Inspect view in either Form Mode or Web Mode.

3. Preview the asset. In the asset’s toolbar, click the Preview ( ) icon.

Note

This chapter shows you how to preview an asset by using the Search field in the 
WebCenter Sites Contributor interface.
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The tab displays the preview of the asset.

4. Preview how the asset would look on the website if it were rendered by a different 
template. 

a. Do one of the following:

- In the asset’s toolbar, click the Preview with Page Layout icon.

- In the menu bar, select View > Preview with Page Layout.

The “Select preview template” dialog box is displayed.

b. Select the template with which you wish to preview the asset. (In this example, we 
selected the /FSIIDetail template, which renders the content of the asset 
without a surrounding layout).

c. Click Apply.

The asset is displayed in the tab as it would be displayed on the website if it were 
rendered by the template you selected. For example:
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5. Preview the asset with a different site wrapper. In the menu bar, select View > 
Preview with Wrapper > select the wrapper with which you wish to preview the 
asset.

The preview of the asset is displayed in the tab with the wrapper you selected.

6. Preview the asset in a new window. In the menu bar, select View > Preview in New 
Window.

A new browser window opens displaying the preview of the asset.

Previewing Future Sites
While you are planning upcoming changes to a website, you can assign start and end dates 
to an asset. Once start and end dates are assigned, you can preview site assets as they will 
be displayed on a site at different times in the future. The feature you use to generate 
future versions of the website is known as “Future Preview.”

Start and end dates are a key part of Future Preview, which is an enhanced function of 
Site Preview. You can preview how an asset will appear without setting start and end dates 
(the regular Site Preview), but by assigning a start and end date range to an asset, you gain 
the ability to visualize upcoming changes to the website. Once you assign a start and/or 
end date to an asset, you can see how the asset will change over time by selecting dates 
from the date picker on an asset’s toolbar when its preview is displayed.
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This section contains the following:

• About Start and End Dates

• About Future Preview

• Impact of Start and End Dates on Future Preview

• Assigning Start and End Dates

• Previewing a Site as It Will Appear at a Future Time

• Approval for Publishing

About Start and End Dates
Start and end dates are optional field values you can assign to assets. This date range 
indicates when assets will appear on a website, should they be published. Fill in these 
dates when you are working with an asset in Form Mode (located on the Metadata tab).

Start and end dates affect the function of Future Preview, as discussed in this chapter.

Start and end dates also appear in the “Advanced Search” options, giving you the ability to 
search for assets based on the date range in which they will appear on the website.

About Future Preview
Future Preview is a tool for visualizing your website as you strategize upcoming content 
changes. With Future Preview, you can preview an asset’s web page as it will appear at 
any selected moment in the future. By generating possible versions of a web page, you can 
more easily decide what to publish and when.

With Future Preview, you can select any particular date in the future and see what all the 
changes you and other content contributors are making will look like on the website at that 
time. WebCenter Sites uses the assigned start and end dates to determine whether to 
display the preview of the asset. The asset’s preview is displayed only when the selected 
date falls within the asset’s start/end date range.

Impact of Start and End Dates on Future Preview
You will need to consider the following factors when assigning start and end dates:

• The start and end date range are the times you expect the asset to be displayed on the 
website.

Once you set a start and end date range, you can use Future Preview to compare how 
the page on which the asset appears will look on dates before, during, and after the 
date range.

Note

To preview an asset as it will appear at future dates:

• Start and end dates must be assigned in the Metadata section of an asset’s 
content entry form (in Form Mode). 

• The template for the page in which the asset appears must contain the 
asset:filterassetsbydate tag. See your site administrator for further 
information. 
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When you first preview an asset, you see its web page as it would appear on the asset’s 
start date. If no start date is assigned, the current date is used for preview.

Choose a future date from the date picker in the asset’s toolbar to view how the page 
will appear at the selected time. When you select a date that falls during the asset’s 
start and end date range, the preview shows how the asset’s web page will look during 
the period the asset is visible on the website. Conversely, if you choose a date that falls 
outside that date range, you see the asset’s web page as it will appear before the item is 
published or after the item is no longer visible on the page. 

• Neither the start nor end date is a required field:

- An asset without both start and end dates is always displayed in the Site Preview, 
regardless of the date with which you choose to preview it.

- An asset with an explicitly set start and end date is displayed conditionally; that is:

- If the asset has both a start and an end date, it is displayed only when the 
specific date range is selected.

- If the asset has only a start date, the asset is displayed on all dates including 
and after the start date. (It never expires.)

- If the asset has only an end date, the asset is displayed on all dates up to and 
including the end date.

Assigning Start and End Dates
Start and end dates are optional fields you can assign to assets. This date range indicates 
when assets will be displayed on the website and how those assets will be displayed at any 
given time.  

To assign a date range to an asset

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find the asset to which you are assigning a start and/or end date. Do one of the 
following:

- In the Search field, enter search criteria identifying the asset and click the 
magnifying glass ( ) button.

- If you are modifying an asset that has previously been assigned a start and/or end 
date, you can search by the previously assigned dates using the “Advanced 
Search” function. For more information about Advanced Search, see “Conducting 
an Advanced Search,” on page 133. 

- If you previously bookmarked the asset, expand the Bookmarks node in the 
My Work tree in the navigation pane. (If the My Work tree is collapsed, expand 
it by clicking the My Work bar.)

For more information on finding assets, see Chapter 6, “Finding and Organizing 
Assets”.”

Note

The publication date of the asset does not affect when and how long the asset 
displays on the website; this is controlled by the start and end dates.
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3. Edit the asset in Form Mode.

a. In the list of assets, navigate to the desired asset, right-click it, and select Edit 
from the context menu.

The tab displays the asset’s Edit view in either Form Mode or Web Mode.

b. If the asset opens in Web Mode, switch to Form Mode by clicking the Mode 
switch in the asset’s toolbar.

4. In the asset’s form section selector, select Metadata.

5. In the asset’s Metadata section, set the asset’s start and/or end date and (optionally) 
time.

In the “Start Date” and/or “End Date” fields, select the date and time from the date 
picker by clicking the Pick a date ( ) icon next to the field.

For more information about using the date picker, see “Working with the Date Picker,” 
on page 83.

6. In the asset’s toolbar, click the Save ( ) icon to update the asset.

7. To preview the asset as it will appear at a future time, see “Previewing a Site as It Will 
Appear at a Future Time,” on page 149.

Note

Your administrator may have selected default start and end dates for this asset 
type. You can change the settings if you wish.
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Previewing a Site as It Will Appear at a Future Time
When assets have been assigned start and/or end dates, you can preview assets and the 
pages on which those assets are displayed as they will appear at future times of your 
choice.

To preview a site as it will appear at a future time

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find an asset to which you have assigned a start and/or end date. Do one of the 
following:

- In the Search field, enter search criteria identifying the asset and click the 
magnifying glass ( ) button.

- To search for assets by their start and/or end dates, use the “Advanced Search” 
function. For more information about Advanced Search, see “Conducting an 
Advanced Search,” on page 133.

- If you have previously bookmarked the asset, expand the Bookmarks node in the 
My Work tree in the navigation pane. (If the My Work tree is collapsed, expand 
it by clicking the My Work bar.)

For more information about finding assets, see Chapter 6, “Finding and Organizing 
Assets.”

3. In the list of assets, click the name of the desired asset.

A tab opens displaying the Inspect view of the asset in either Form Mode or Web 
Mode.

4. Preview the asset. In the asset’s toolbar, click the Preview ( ) icon.

The tab displays the preview of the asset as it appears (or would appear) on the 
website on the current date.

Note

To preview an asset as it will appear at future dates:

• Start and end dates must be assigned in the Metadata section of an asset’s 
content entry form. 

• The template for the page in which the asset appears must contain the 
asset:filterassetsbydate tag. See your site administrator for further 
information. 
Oracle WebCenter Sites User’s Guide



Chapter 7.  Previewing Assets

 Previewing Future Sites
150
5. Preview the asset as it will appear on a future date:

a. In the asset’s toolbar, click the date link in the “Site preview on:” section to render 
the date picker.

b. In the date picker, select the desired date and time. For instructions on using the 
date picker, see “Working with the Date Picker,” on page 83.

The preview displays the asset’s web page as it will appear on the selected date.
For example, if you preview the “FSIIAbout” asset’s web page on a date in 
October 2012, the following screen is displayed:
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If you preview the same asset on a date in December 2012, the following screen is 
displayed:

Approval for Publishing
Before an asset is published to a website, you must approve the asset and all of its 
dependents for publishing. This process ensures that all the assets published at the same 
time are up to date prior to publishing. 

The start date that you set does not necessarily have to be the date on which the item gets 
published. However, the asset will not display on the website until its start date. This is 
true for all the dependent assets that you are approving as well.

If you publish an asset after its end date, the asset will be published to its destination; 
however, the asset will not appear on the website (the asset has expired). 

For more information on Approving Assets, see “Approval for Publishing,” on page 213.

Note

For assets to be viewable on the website only during the defined start/end date range, 
developers must include the asset:filterassetsbydate tag in the template of 
the page that displays the asset. See your site administrator for further information 
about the tag.
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Chapter 8

Associating Assets
WebCenter Sites allows users to place and unplace pages and associate assets with one 
another. This chapter uses the avisports sample site to show you how to associate assets 
when you are working in the Contributor interface.

This chapter contains the following sections:

• Working with Asset Associations

• Parent-Child Relationships

• Working with Grouped Assets
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In
A

Working with Asset Associations
Some asset Create and Edit views include fields (Form Mode) or slots (Web Mode) where 
you link another asset to the one in which you are working. These types of fields are called 
“associations.” Figure 17 shows an “Article” asset (from the avisports sample site), 
displayed in Form Mode and Web Mode, which is associated with five other “Article” 
assets.

Figure 17: Association field displayed in Form Mode and Web Mode     

An association field can be used to create relationships between assets. When you 
associate one asset with another asset you define a dependency between those assets. 
When one asset is dependent on another, both assets must be published together.

For example, suppose an asset of type “Article” has an association field that accepts an 
“Image” asset. In this case, you might associate an article about baseball with a picture of 
a baseball field. By associating the “Image” asset with the “Article” asset, you are 
indicating which image appropriately illustrates the article text. The “Article” asset and its 
associated “Image” asset are now dependent on one another. If you publish the “Article” 
asset, you must also publish the “Image” asset.   

Article asset displayed in Web ModeArticle asset displayed in Form Mode

In Web Mode, the assets associated with the 
Article asset are displayed in slots.

 Form Mode, the assets associated with the 
rticle asset are listed in a field.
Oracle WebCenter Sites User’s Guide



Chapter 8.  Associating Assets

 Working with Asset Associations
155
Which assets can be associated is determined by the data model. How associations will be 
presented on the website is determined by content rendering templates. For example, a 
template can either display an associated asset or render it as a link.

Types of Associations
An association field allows you to do one of the following, depending on how it is set up:

• Single-valued association field allows you to associate a single asset with the asset 
you are working with. For example, in the avisports sample site, assets of type 
“Article” contain a single-valued association field you can use to pair an “Article” 
asset with a single “Image” asset.

• Mulit-valued association fields allow you to associate multiple assets with the asset 
you are working with. For example, in the avisports sample site, assets of type 
“Article” contain two multi-valued association fields that allow you to associate 
several different assets of type “Article” with the “Article” asset you are working 
with.

Depending on your site design, an association field may be restricted to accept either a 
specific type and/or sub-type of asset or it may be unrestricted, accepting different types of 
assets. 
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Associating Assets
This procedure uses the avisports sample site to show you how to associate one or more 
assets with another asset using either Form Mode or Web Mode. In Form Mode, an 
association field is displayed as a drag and drop field in a content entry form. In Web 
Mode, association fields are represented by slots that are displayed on the web page view 
of the asset with which you are working. This procedure covers both single and multi-
valued associations. 

To associate an asset with another asset

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Do one of the following:

- Begin creating an asset:

- For instructions on creating assets in Form Mode, see “Creating a New Asset 
in Form Mode,” on page 64.

- For instructions on creating assets in Web Mode, see “Creating a New Asset 
in Web Mode,” on page 90.

- Open an existing asset for editing:

- For instructions on editing assets in Form Mode, see “Editing Assets in Form 
Mode,” on page 75.

- For instructions on editing assets in Web Mode, see “Editing Assets in Web 
Mode,” on page 99.

A tab opens displaying the asset’s Create or Edit view in either Form Mode or Web 
Mode. (In this example, we open the 25 Nevada Resorts Serving Snow “Article” 
asset.)

3. Find the asset(s) you wish to associate:

a. In the Search field, enter the desired search criteria. 

b. If the association field accepts only assets of a specific type, limit your search to 
the required asset type by clicking the down-arrow in the Search field and 
selecting the name of the asset type.

c. Click the magnifying glass ( ) button.

The search results list is docked to the right of the asset with which you are 
working. Below shows the Edit view of the 25 Nevada Resorts Serving Snow 
“Article” asset in Form Mode and Web Mode with the search results list docked to 
the right of the asset.
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Mul
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Sing
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 slots
In the Create or Edit view of an asset in Form Mode, you will see association 
fields that accepts a single asset and/or multiple assets:

In the Create or Edit view of an asset in Web Mode, you will see empty and/or 
occupied slots that accept a single asset or multiple assets:

ti-valued 
ociation fields

le-valued 
ociation field

Multi-valued

Single-valued 
slot
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4. Associate the desired asset(s) with the asset you are working with:

a. In the list of assets (docked to the right of the asset you are working with), click 
the name of the desired asset and drag the asset to the association field (Form 
Mode) or slot (Web Mode).

b. Drop the asset into the association field (or slot) by releasing the mouse button.

c. If you are working with a multi-valued association, repeat steps a – b until you 
have associated all of the desired assets with the asset you are working with.

The selected assets are added to the association field. 

5. (Optional) If you are working with a multi-valued association and have associated two 
or more assets, arrange the associated assets as follows:

- If you are working in Form Mode, move an asset up or down in the list by 
clicking the name of the desired asset and dragging and dropping it into the 
appropriate position in the field.

- If you are working in Web Mode, move an asset to a different slot. Do the 
following:

1) Click in the multi-valued slot.

The slot’s toolbar is displayed.

2) In the slot’s toolbar, click the Manage ( ) icon.

The following dialog box is displayed:

3) Click the name of the desired asset and move it either up or down in the list.

4) Click Save.

6. When you are finished, click the Save ( ) icon in the asset’s toolbar.

7. To inspect the asset, click the Inspect ( ) icon in the asset’s toolbar.

The tab displays the asset in its Inspect view. You cannot modify the asset in its 
Inspect view.

Note

The order in which the assets appear in the list (Form Mode) or in the slots (Web 
Mode), is the order they will display on the website.
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Disassociating Assets
To disassociate an asset from another asset

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset from which you want to disassociate one or more assets:

a. In the Search field, enter search criteria identifying the asset and click the 
magnifying glass ( ) button. 

A “Search” tab opens displaying the results of your search.
For more information on finding assets, see “Finding and Organizing Assets,” on 
page 125.

b. In the list of search results, navigate to the desired asset, right-click the asset’s 
name and select Edit from the right-click menu.

A tab opens displaying the Edit view of the asset in either Form Mode or Web 
Mode.

3. Remove the desired asset from the list of associated assets:

- If you are working in Form Mode, navigate to the field representing the asset’s 
associations and click the Delete (X) button next to each asset you want to 
disassociate. 

- If you are working in Web Mode: 

- If you wish to remove an asset from a slot representing a single-valued 
association, click the slot containing the asset you wish to disassociate. In the 
slot’s toolbar, click the X button.

- If you wish to remove an asset from a slot representing a multi-valued 
association, do the following: 

1)  Click in the multi-valued slot.

The slot’s toolbar is displayed.

2)  In the slot’s toolbar, click the Manage ( ) icon.

The following dialog box is displayed:

3)  Click the X next to the asset you wish to remove.
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4)  Click Save.

WebCenter Sites removes the asset(s) from the association field.

4. When you are finished, click the Save ( ) icon in the asset’s toolbar.

5. To inspect the asset, click the Inspect ( ) icon in the asset’s toolbar.

The tab displays the Inspect view of the asset. You cannot modify the asset in its 
Inspect view.
Oracle WebCenter Sites User’s Guide



Chapter 8.  Associating Assets

 Parent-Child Relationships
161

urf Articles” 

hical 
n the tree and 
ild. Double-
e to display its 
Parent-Child Relationships
When you designate an asset as a parent of another asset, you are creating a hierarchical 
relationship between the two assets. An asset that is linked to a parent is called a “child” 
asset. 

A child asset inherits attribute values from its parent. This means that once a child asset is 
linked to a parent asset, it inherits the parent’s attributes and values and retains the 
attributes it already has. If the parent and the child share the same multi-valued attribute, 
the child inherits the parent asset’s values and retains its original values. If the parent and 
child share the same single-valued attribute, the child retains the attribute’s current value 
and does not inherit the value of the parent.

Parent-child relationships are shown in the Content Tree. Parent-child relationships are 
taken into account during approval for publishing so that no broken links result on the 
published site. More information on approval for publishing can be found in “Approval 
for Publishing,” on page 213.

The “Shark Parks” Article asset has “S
designated as a parent asset.

The Content Tree reflects this hierarc
relationship. “Surf Articles” is a node o
“Shark Parks” falls inside of it as a ch
click a parent asset in the Content Tre
children in a “Browse” tab.
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An asset can have more than one parent. When assigned multiple parents, the asset 
appears in multiple places in the Content Tree, as a child of every parent to which it is 
linked.

To designate a parent asset

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Do one of the following:

- Begin creating an asset:

- For instructions on creating assets in Form Mode, see “Creating a New Asset 
in Form Mode,” on page 64.

- For instructions on creating assets in Web Mode, see “Creating a New Asset 
in Web Mode,” on page 90.

- Open an existing asset for editing:

- For instructions on editing assets in Form Mode, see “Editing Assets in Form 
Mode,” on page 75.

- For instructions on editing assets in Web Mode, see “Editing Assets in Web 
Mode,” on page 99.

A tab opens displaying the asset’s Create or Edit view in either Form Mode or Web 
Mode.

3. In the asset’s Create or Edit view, locate the association field in which you will 
designate a parent asset.

4. Find the parent asset you wish to designate as the parent of the asset with which you 
are working.

- Select the parent asset to associate from a search results list:

a) In the Search field, enter criteria that describes the desired parent asset.

b) (Optional) Limit your search to a specific asset type (for example, only assets 
of type “Article Category”) by clicking the down-arrow in the Search field 
and selecting the name of the desired asset type.

c) Click the magnifying glass ( ) button.

- Select the parent asset to associate from the Content Tree:

a) In the navigation pane, select the Content Tree bar.

b) In the Content Tree, expand the nodes to expose the parent assets related to 
each node.

Note

If you are working in Web Mode, the association field may be displayed as a 
slot. If you do not see a slot that accepts a parent asset, stop here. The layout 
(template) assigned to the asset is not coded to display this type of field. To 
assign the asset to a parent, you will have to switch to Form Mode by clicking 
the Mode switch in the asset’s toolbar.
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5. Designate the parent asset. 

For example, if you are working in Form Mode, use the drop-down menu in the 
Category field to select the desired parent asset.

WebCenter Sites associates the asset with the selected parent assets. The name of the 
associated parent asset is displayed in the field.

6. When you are finished, click the Save ( ) icon on the asset’s toolbar.

Working with Grouped Assets
When working with assets, you might want to organize them in groups and place them in a 
specific order. If you are a marketer and the “Collection” asset type is enabled for the site 
with which you are working, you can create lists of assets related to other assets in some 
way based on context, or lists of asset that change based on some variable, such as the 
current date, or time of day. You might also want to deliver different groups of assets 
depending on the demographic data of your visitors. In such cases, you would use 
“Collection” and “Recommendation” assets.

This section contains the following:

• Working with Collections

• Building a Collection

• Working with Recommendations

Working with Collections
Suppose you want to choose, rank in order, and deliver sets of content that your visitors 
will most likely want to see when viewing your site. For example, you might want to place 
five top political news stories, organized in the order of importance, on the home page of 
your site every morning. In a case like this, you can build your “Top Five” list of articles 
using a “Collection” asset.

A “Collection” asset stores a list of basic assets of a single asset type, organized in a 
specific order. The assets you can include in a collection come from the results returned by 
one or more queries. You choose the assets you want to include in the collection by 
ranking them in the order of your choice in the list of query results. This ranked, ordered 
list of assets is the collection. 

Typically, site designers or administrators create “Collection” assets and assign the 
appropriate queries and templates to them. Your job is to choose the most suitable content 
to be included in the collection.

Note

The type of field you see depends on the configurations your developers made to 
the asset’s definition. In this example, we are designating a parent asset for an 
“Article” asset, in the avisports sample site, which displays a drop-down menu. 
In the FirstSite II sample site, the field in which you designate a parent asset is a 
Drop Zone.
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Keep in mind that once you build your collection, other users with the appropriate 
permissions can access the “Collection” assets you worked with and change your asset 
rankings within them.

Building a Collection
A “Collection” asset must already exist in the site you are working with in order for you to 
be able to build the desired collection. Your site designer or administrator is usually the 
person responsible for creating new “Collection” assets and editing existing ones.

To build a collection

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find the collection you want to build:

a. In the Search field, enter search criteria identifying the asset.

b. (Optional) In the Search field, click the down-arrow to render the “Search Type” 
drop-down box. Select the “Collection” asset type to limit your search to only 
“Collection” assets. If you do not make a selection, WebCenter Sites will search 
across all asset types in the current site.

c. Click the magnifying glass ( ) button. 

A “Search” tab opens displaying the results of your search.
For more information on finding assets, see “Finding and Organizing Assets,” on 
page 125.

3. In the list of search results, navigate to the desired “Collection” asset and click its 
name.

A tab opens displaying the Inspect view of the “Collection” asset (in either Form 
Mode or Web Mode).

4. If the “Collection” asset open in Web Mode, switch to Form Mode by clicking the 
Mode switch in the asset’s toolbar.

Note

“Collection” assets can store lists of basic assets only. For flex assets, functionality 
similar to that of “Collection” assets (and much more) is provided by 
“Recommendation” assets (described later in this section).
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5. In the asset’s Inspect view (in Form Mode), click Build Collection, located next to the 
name of the Collection asset (as shown below).

WebCenter Sites runs the query (or queries) in the collection and displays the results, 
as shown below:

Click this link to 
build the collection
Oracle WebCenter Sites User’s Guide



Chapter 8.  Associating Assets

 Working with Grouped Assets
166
6. Rank the assets by entering the appropriate number (up to three digits) in the “Rank” 
column of the table. If you want to remove an asset that is included in the top list, in 
the “Remove” column, select the checkbox next to the name of the asset you wish to 
remove. Deleting an asset’s rank number from the query list will not remove it from 
the collection.

7. Click Save Changes.

WebCenter Sites builds the collection and displays the collection in its Inspect view.

Working with Recommendations
“Recommendation” assets allow you to personalize product placements and promotional 
offerings that are displayed for each site visitor. Recommendations determine which assets 
(products, for example) should be featured or “recommended” on a page, based on 
available information about your site visitors (such as age, or last viewed product).

You can personalize the content your visitors view in the following ways:

• Create Static List recommendations. These are lists of assets that are displayed 
according to demographic criteria such as age, income, or other information in the site 
visitor’s profile. (This criteria is defined in a “segment” and associated with a given 
static list recommendation.) For example, you can create a list of top dance clubs and 
show it only to visitors who specify their age range to be between 18 and 24. For 
visitors whose age falls outside this range, you can display another static list 
recommendation, for example, a list of top ten beach resorts.

• Create Related Items recommendations. Related Items recommendations allow you to 
link to each other assets that bear some sort of relation to one another. This way, 
whenever a visitor views an asset that is linked to another asset via a Related Items 
recommendation, he/she will also see the related asset. You can thus create a “path” or 
a “link trail” for your visitors to follow by consecutively linking assets to one another 
using a Related Items recommendation.

The goal is to persuade your visitors to view additional content related to the content 
they are viewing at a given moment by showing them a teaser for the related content 
alongside the main content. Related Items recommendations are thus excellent for 
business tactics such as up-selling or cross-selling merchandise.

For example, you can link to one another a number of movies that share a common 
theme or genre, such as the Godfather trilogy. You link part I of the trilogy to part II, 
and part II to part III using a Related Items recommendation. This way, when a visitor 
looks at part I of the trilogy, Sites will also show part II. When the visitor then looks at 
part II, Sites will also show part III. Additionally, you could link parts II and III to 
part I so your visitors know they should watch part I first when they view part II or III.

Note

When you rank the assets in your collection, do so in an order that is appropriate 
to the template element that renders the page. For example, if your collection 
contains 50 assets, but the template that renders it is coded to display only five, 
only the first five highest-ranked assets in the collection will be displayed on the 
page. Consult your site developers if you are unsure about the properties of the 
templates you are using.
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• Create Dynamic List recommendations. Unlike Static List and Related Items 
recommendations, the functionality of Dynamic List recommendations is defined by 
customized code written by your developers. Because of that, Dynamic List 
recommendations are the most flexible out of the three types of “Recommendation” 
assets in terms of fulfilling specific business needs. For example, your developers can 
code a Dynamic List recommendation to behave like a Related Items 
recommendation, but instead of requiring the related assets be linked manually, the 
recommendation can track the movies a visitor has bought in the past and recommend 
movies that most closely match his or her past purchases in terms of theme or genre. 
In such case, you would simply assign the recommendation to the assets you want to 
be included in the recommendation.

The choice regarding the type of recommendations used depends largely on how you or 
your site designers want your site to behave. For information about creating 
“Recommendation” assets, see Chapter 17, “Creating and Configuring 
Recommendations.”
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Chapter 9

Creating a Site’s Navigation
This chapter provides information about creating the navigation for your website by using 
the Site Tree in the Contributor interface to place and unplace pages.

This chapter contains the following sections:

• Overview

• Placing and Unplacing Pages

Note

WebCenter Sites offers multiple ways to create a website’s navigation. Your site 
design determines the way in which your website’s navigation is created. In this 
section, we assume that your site design is configured to allow you to create your 
website’s navigation using the Site Tree in the WebCenter Sites Contributor 
interface. For information about how the navigation for your website is created, 
see your site developers.
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Overview
Your website’s navigation allows visitors to access the different sections (pages, articles, 
and so on) of your site. Your site’s navigation is determined by the placement of the 
“Page” assets in the Contributor interface’s Site Tree (located in the navigation pane). The 
Site Tree enables you to create a hierarchy for the pages on your site. This means that the 
structure of your site’s navigation starts off general and drills down to specific. 

For example, if you place a page underneath an already placed page in the Site Tree, the 
page you placed becomes a sub-level of the page under which you placed it. When the 
pages are published to the website, the page you placed as a sub-level is accessible from 
the top-level page’s navigation menu. Figure 18 uses the avisports sample site as an 
example to show the dynamic relationship between the placement of pages in the 
Contributor interface’s Site Tree and your website’s navigation.

Figure 18: Relationship between the Site Tree and your site’s navigation

ee for the avisports sample site

The pages placed underneath the 
Home page in the Site Tree are 
displayed as links in the home (top-
level) page’s navigation menu.

The top-level Home Page asset 
Site Tree is the home page for t
avisports website.
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Placing and Unplacing Pages
If you are assigned the appropriate role (configured by your administrator), you can use 
the Site Tree to place pages on the website and unplace pages that currently appear on the 
site. Placing and unplacing pages enables you to organize your site’s navigation (as shown 
in Figure 18). The changes you make through the tree will be applied to the website during 
the next publishing session. For more information on “Page” assets, see the WebCenter 
Sites Developer’s Guide or consult your developers.

This section covers the following procedures:

• Placing a Page

• Unplacing a Page

Placing a Page
This section shows you how to place a “Page” asset using the Site Tree. The tree supports 
two methods for placing pages: 

• Directly under a top-level page as the page’s highest-ordered sub-level.

• At the same level in the hierarchy as another page. The selected page is placed before 
or after the other page (depending on the location you choose).

After you place a page, you must approve and publish the page in order to have it 
displayed on the website.

To place a page on the website

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. In the navigation pane, click the Site Tree bar.

The pane displays the Site Tree.

Note

The Site Tree requires you to place pages in an ordered hierarchy. Before you 
perform the procedures in this section, consult your developers to familiarize 
yourself with the structure of your website so that you know where each page 
belongs in the site hierarchy.
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3. Expand the site hierarchy by clicking the plus-sign next to each node in the tree. 
Below shows the Site Tree for the avisports sample site. 

4. Find the page you want to place and determine its target position in the hierarchy:

a. Find the desired page:

- If you are placing an already placed page, navigate the Placed Pages 
hierarchy to find the desired page.

- If you are placing an unplaced page, navigate the Unplaced Pages hierarchy 
to find the desired page.

b. Navigate the Placed Pages hierarchy to determine the page’s target position in the 
site hierarchy. 

5. Place the page by dragging it to its target position in the hierarchy. Do one of the 
following:

- To place the page at the same level as another page, drag the selected page under 
or above the name of the other page. The selected page will be placed in the list 
before or after the other page.

For example, to place the Running Home page asset at the same level as (and 
before) the Home page asset, drag the Home Running page above the name of 
the Home page, as shown below:

The blue line indicates the location the 
page will be placed.
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- To place the page as the highest-ordered sub-level of another page, drag the 
selected page over the name of the desired page under which you wish to place it.

For example, to place the Running page as the highest-ordered child of the 
Home Running page, drag the Running page over Home Running, as shown 
below:

When you release the page, it appears in the position you have chosen. For example:

You must approve the page you placed in order for the website to be updated with 
your changes during the next publishing session.

Unplacing a Page
This section shows you how to unplace a “Page” asset — that is, mark it for removal from 
the website. After you unplace the page, it will be removed from the website during the 
next publishing session.

To unplace a page on the website

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. In the navigation pane, click the Site Tree bar. 

The pane displays the Site Tree.

3. Expand the site hierarchy by clicking the plus-sign next to each node.

4. Navigate the Placed Pages hierarchy to find the page you want to unplace.

When you drag Running over Home Running, 
Home Running becomes highlighted in grey.
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5. Unplace the page by dragging it over the Unplaced Pages node. For example, to 
unplace the Home Running page, drag it over Unplaced Pages as shown below:

When you release the page, it is displayed under the Unplaced Pages node. If the 
page you unplaced contains sub-levels, its sub-level pages are also unplaced.

You must approve the page you unplaced in order for the website to be updated with 
your changes during the next publishing session.
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Chapter 10

Linking Assets
When creating and updating assets, you have the option to link the assets to each other in 
several ways, as long as the assets are on the same site. 

This chapter includes the following sections:   

• Overview

• Linking Two Assets Directly

• Linking Two Assets via an Image Asset

• Linking Assets to URLs
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Overview
Some assets’ Create and Edit views have a CKEditor enabled field. CKEditor supports a 
wide range of formatting options, such as the option to link assets to each other using the 
link icons located on the CKEditor toolbar. The table below identifies the icons on the 
CKEditor toolbar that you will be working with for the following linking procedures: 

Table 3: CKEditor Icons Used to Link Assets

Type of Link Icon(s) Description
For Link

Procedure

Linking two assets 
directly

Add asset link

Used to create a hyperlink 
to the target asset from the 
referring asset.

“To Create a H
Link to Anoth
Asset,” on pag

Include Asset 

Used to dynamically 
include the previewable 
content of one asset in 
another.

“To Link Two
by Inclusion,”
page 182

Link two assets 
via an image asset

1.  Include Asset 

2.  Add asset link 

1. The Include Asset icon 
is used to include an 
image from the 
“Bookmarks” node 
(located in the My Work 
tree) into the referring 
asset’s CKEditor enabled 
field. Note: If you did not 
bookmark the desired 
image, you can use the 
search feature to find the 
image. 

2. Once the image is 
included, the Add asset 
link icon is used to 
hyperlink the image to 
another asset.

“Linking via a
from the “Boo
Node,” on pag

1.  Pick an Image to Include

2.  Add asset link

1. The Pick an image to 
include icon is used to 
include an image from the 
“Image Picker,” into the 
referring asset’s CKEditor 
enabled field.

2. Once the image is 
included, the Add asset 
link icon is used to 
hyperlink the image to the 
target asset.

“Linking via a
from the Imag
Picker,” on pa

12

12
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Linking Two Assets Directly
This section contains prerequisite steps and instructions for linking two assets, as follows: 

• Creating a hypertext link to another asset

You may have two assets—article assets, for example—with related content that you 
wish to join by a hypertext link. Working in the main article, you would use the Add 
asset link icon on the CKEditor toolbar to insert a hypertext link to the related article. 
When site visitors access the main article’s content, they can click the inserted 
hypertext link to render the related article’s content.

• Linking two assets by inclusion

A commonly performed CM operation is to insert previewable content from one asset 
into another asset, but without manually copying the content. Instead, the content is 
inserted “by reference,” so that it can be dynamically updated at the insertion point 
when the target asset (the source of content) is modified.

In this scenario, you would use the Include Asset icon in the CKEditor toolbar to 
insert the asset, whose previewable content is then rendered dynamically at the 
insertion point. 

When using Include Asset, you are actually inserting a link to the target asset, but 
rendering the link in the form of the target asset’s previewable content. The link 
persists after the target asset is included. As a result, the content is not editable at the 
insertion point, but it is refreshed when the target asset (the source of content) is 
modified. To view refreshed content, you must refresh the referring asset by clicking 
the Refresh ( ) icon in the referring asset’s toolbar.

The extent to which these capabilities are available to you depends on how your site 
designers have implemented them as part of the custom asset design. For example, the 
“Article” asset type that ships with the avisports sample site is configured with a CKEditor 
in its “Body” field. Therefore the “Body” field supports the types of links described above. 

Linking assets to 
URLs

Link

Used to insert a hypertext 
link to a URL into the 
referring asset’s CKEditor 
enabled field. 

Additional options, such 
as Email, are also 
available in the Link 
icon, but they are not 
covered in this guide. For 
more information about 
the additional options, 
refer to the CKEditor’s 
documentation at:
http://
 docs.cksource.com

“Linking Asse
URLs,” on pa

Table 3: CKEditor Icons Used to Link Assets

Type of Link Icon(s) Description
For Link

Procedure
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Prerequisites 
Before linking assets, you must verify that they can be linked. Use this section as a 
checklist. (It is assumed that you know how to edit and preview assets, and create them, if 
necessary. Basic instructions are given in various steps.) 

Participating Assets
Two assets are involved in this procedure, and both assets are on the same site:

• The referring asset (in which you will create the link to the target asset)

• The target asset (which will be rendered when the link is clicked)

Referring Asset
• The referring asset displays the CKEditor in the field where you will place the link. If 

you need instructions for verifying that CKEditor is displayed, complete the following 
steps:

1. Open the referring asset in its Edit view. If you need to find the referring asset, do 
the following:

a) In the Search field, enter the desired search criteria (if any) and then click the 
magnifying glass ( ) button. 

b) In the search results list, navigate to and right-click the name of the desired 
asset. In the right-click menu, select Edit.

2. Navigate to the field in which you want to place the link. Click in the field to 
make sure it displays the CKEditor. 

• If you intend to publish the referring asset, the asset must be previewable, including 
the field where you will place the link. (Ensure that the referring asset can be rendered 
by one of the templates listed in the asset’s “Template” field. For instructions on 
previewing assets, see Chapter 7, “Previewing Assets.) 

Target Asset
• The target asset is previewable (ensure that the target asset can be rendered by one of 

the templates that is listed in the asset’s “Template” field.

Note

If you are creating a new referring asset, you can start this procedure in the 
asset’s Create view. However, it is best to save the asset and then open its Edit 
view (to ensure against possible loss of any existing content, as you move from 
step to step).

Note

By default, CKEditor is not displayed automatically when the asset’s Edit 
view opens. To display the CKEditor, click in the field. If the CKEditor does 
not appear, then the field is not CKEditor enabled and the assets cannot be 
linked. Contact your system administrator to have the field enabled.
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• (Optional) The target asset is readily available for linking (ensure that the target asset 
is placed in the “Bookmarks” node, located in the My Work tree in the navigation 
pane).

1. Find the target asset and place it in the “Bookmarks” node:

a) In the Search field, enter the desired search criteria (if any) and click the 
magnifying glass ( ) button.

b) In the search results list, navigate to and right-click the desired asset. In the 
right-click menu, select Bookmark.

2. Make sure the target asset is displayed in the Bookmarks node:

a) In the navigation pane, click the My Work bar.

2) In the My Work tree, navigate to and expand the Bookmarks node.

Make sure the target asset is displayed in the list of assets underneath the 
“Bookmarks” node.

Next Step
At this point you are ready to link the assets. Continue to any one of the following 
sections, depending on how you wish to link the assets:

• To Create a Hypertext Link to Another Asset

• To Link Two Assets by Inclusion

To Create a Hypertext Link to Another Asset
1. Ensure that all prerequisites starting on page 178 are met. 

2. Open the referring asset in its Edit view.

3. Insert the link to the target asset:

a. In the navigation pane, click the My Work bar.

b. In the My Work tree, navigate to and expand the Bookmarks node.

A list of bookmarked assets is displayed underneath the Bookmarks node. 

c. In the desired field of the referring asset, select the text that you want to be 
hyperlinked. Alternatively, you can type new text anywhere in the field and select 
it.

Note

Placing target assets in the “Bookmarks” node is most efficient when linking 
large numbers of target assets to a source asset. When you are linking only one 
target asset to a source asset, you can conduct a search for the target asset while 
working in the source asset’s Edit view. (If you are trying to link a large number 
of assets to a source asset, you will have to conduct a separate search for each 
target asset.) When you conduct a search for a target asset, the search results are 
displayed (docked) to the right of the source asset’s Edit view. For information 
about searching for assets, see “Finding Assets,” on page 126.
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To work more comfortably, you can maximize the CKEditor to fill your workspace. 
Click the Maximize icon. 

d. On the CKEditor’s toolbar, click the Add asset link icon. 

The “Insert Embedded Link” dialog box opens:  

1) Navigate to the expanded Bookmarks node in the My Work tree. Select the 
desired asset and drag it to the drag and drop field in the “Insert Embedded 
Link” dialog box. Then drop the asset into the field.

The dialog box displays the layouts (templates) available to be assigned to the 
target the asset. 

2) Select a layout (template) to assign to the target asset. The layout (template) 
you select will render the target asset when the hyperlink is clicked.

3) In the “Wrappers” field, select the wrapper with which you want to render the 
target asset.

4) (Optional) In the “Link Anchor” field, provide a secondary link. If the 
primary link to the target asset is broken in some way, the secondary link is 
used instead. 

5) In the “Link Text” field, verify the text you selected to be the hyperlink (step c 
on page 179). If necessary, edit the text.

Maximize the editor size

Add asset link
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6) If the “Template Arguments” section displays the “Name” and “Value” 
menus, you can use them to set properties for the target asset. Select the 
parameters that you need (one at a time), enter a value, and click Add.

7) Click Apply.

8) Click OK to save the link.

The dialog box closes, and the linked text appears in the field, underlined and 
surrounded by a blue border, as shown below:

4. Right-click the linked text to open its context menu. From the context menu you can:

- Cut Linked Asset

- Copy Linked Asset

- Edit Properties

- Remove Linked Asset

Note

The “Extra Parameters” section is enabled only if developers have 
configured parameters for the template that is assigned to the target 
asset. Otherwise, the “Template Arguments” section displays the 
message “No arguments defined for template Name.”

Asset link 
(underlined and 
surrounded by blue 
border)
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5. Save the referring asset:

a. If you expanded the CKEditor, click the Maximize icon to collapse the CKEditor 
and view the entire asset.

b. In the referring asset’s toolbar, click the Save ( ) icon.

6. Test the link by previewing the referring asset:

a. In the referring asset’s toolbar, click the Preview ( ) icon. 

b. Click the hypertext link to display the target asset.

To Link Two Assets by Inclusion
1. Ensure that all prerequisites starting on page 178 are met.

2. Open the referring asset in its Edit view.

3. Include the target asset:

a. In the navigation pane, click the My Work bar.

b. In the My Work tree, navigate to and expand the Bookmarks node.

A list of bookmarked assets is displayed underneath the Bookmarks node. 

c. In the desired field of the referring asset, place your cursor at the point where you 
want to include the previewable content of the target asset.

To work more comfortably, you can maximize the CKEditor to fill your workspace. 
Click the Maximize icon. 

d. On the CKEditor’s toolbar, click the Include Asset icon. 

Note

The Remove Linked Asset option removes the link function, but not the 
text of the link. To restore the link function, press Ctrl+Z until the underline 
and blue border re-appear.

Maximize the editor size

Include Asset
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The “Insert Included Asset” dialog box opens:  

1) Navigate to the expanded Bookmarks node in the My Work tree. Select the 
desired asset and drag it to the drag and drop field in the “Insert Included 
Asset” dialog box. Then drop the asset into the field.

The dialog box displays the layouts (templates) available to be assigned to the 
target asset.

2) Select a layout (template) to assign to the target asset. The layout (template) 
you select will render the target asset at its insertion point in the referring 
asset.

3) If the “Template Arguments” section displays the “Name” and “Value” 
menus, you can use them to set properties for the included asset. Select the 
parameters that you need (one at a time), enter a value, and click Add.

4) Click OK.

The dialog box closes, and the target asset’s previewable content is rendered 
within the referring asset by the layout (template) you selected. 

Note

The “Template Arguments” section is enabled only if developers have 
configured parameters for the template that is assigned to the included 
asset. Otherwise, the “Template Arguments” section displays the 
message “No arguments defined for template Name.”

Note

If you click on the included asset, you will find that all of its content is 
selected. You cannot select its individual pieces of content. The content 
is editable only in the target asset (the source of content).

When the target asset is edited, the included content in the referring 
asset is automatically updated, but not in real time. To view an update, 
you must refresh the referring asset.
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4. You can now work with the included asset as follows: 

a. Right-click the included asset to open its context menu. From the context menu 
you can:

- Cut Included Asset

- Copy Included Asset

- Edit Properties

- Remove Included Asset 

b. If you want to resize the included asset or view its properties, double-click the 
included asset. When you double-click the asset, a properties window opens. You 
can adjust the size and alignment of the asset from the properties window. 

5. Save the referring asset:

a. If you expanded the CKEditor, click the Maximize icon to collapse the CKEditor 
and view the entire asset.

b. In the referring asset’s toolbar, click the Save ( ) icon.

6. Verify that the included asset is properly rendered by clicking the Preview ( ) icon, 
in the referring asset’s toolbar. 
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Linking Two Assets via an Image Asset
Company logos (and other images) are often used as links to various types of content: 
news about the company, products and services offered by the company, and so on. 
WebCenter Sites enables you to include an image asset in a given asset, and then hyperlink 
the image to another (target) asset. Clicking the image renders the target asset’s 
previewable content. 

This section contains prerequisite steps and instructions for linking two assets via an 
image asset. Before continuing with the rest of this section, determine whether you will be 
including the image from the Bookmarks node (located in the navigation pane, in the My 
Work tree), or from the “Image Picker”:

• Linking via an image from the “Bookmarks” node using CKEditor

In the CKEditor enabled field of the asset you are working with, you may want to 
include an image asset that you have bookmarked. From the CKEditor toolbar use the 
Include asset icon to include the image in the field. Use the Add asset link icon to 
hyperlink the included image to another asset.   

• Linking via an image from the Image Picker using CKEditor

You might work with an asset that is not enabled with an “Image Picker.” If you prefer 
to choose your image assets from the “Image Picker,” CKEditor is capable of 
invoking an “Image Picker.” From the CKEditor toolbar, use the Pick an image to 
include icon to access the “Image Picker,” and select an image to include in the field. 
Use the Add asset link icon to hyperlink the included image to the target asset.

Prerequisites
Before linking assets, you must verify that they can be linked. Use this section as a 
checklist. (It is assumed that you know how to edit and preview assets, and create them, if 
necessary. Basic instructions are given in various steps.)

Participating Assets

Three assets are involved in this procedure, and all three assets are on the same site:

• The referring asset (in which you will include and hyperlink the image asset)

• The image asset (which you will include in the referring asset)

• The target asset (to which you will link the image asset)

Note

If an image will be used to link two assets, the image must be part of an image asset.

Note

The Pick an image to include icon is enabled by the developers of your site. If 
the icon has not been enabled, then it will appear in grey on the CKEditor 
toolbar. If this is the case, you can contact your administrator or, see “Linking 
via an Image from the “Bookmarks” Node” for an alternate method of linking 
two assets via an image asset. 
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Referring Asset
• The referring asset displays the CKEditor in the field where you will place the link. If 

you need instructions for verifying that CKEditor is displayed, complete the following 
steps:

1. Open the referring asset in its Edit view. If you need to find the referring asset, do 
the following:

a) In the Search field, enter the desired search criteria (if any) and then click the 
magnifying glass ( ) button. 

b) In the search results list, navigate to and right-click the desired asset. In the 
context menu, select Edit.

2. Navigate to the field in which you would like to place the image asset. Click in the 
field to make sure it displays the CKEditor. 

• If you intend to publish the referring asset, the asset must be previewable, including 
the field where you will include the image. (Ensure that the referring asset can be 
rendered by one of the templates listed in the asset’s “Template” field). For 
instructions on previewing assets, see Chapter 7, “Previewing Assets.

Image Asset
• The image asset is previewable. Ensure that only the image is rendered by one of the 

templates that is listed in the asset’s “Template” field. 

• Determine whether you will be including an image from the “Image Picker” or from 
the Bookmarks node (located in the My Work tree): 

- If you are including an image from the “Bookmarks” node. The image asset is 
readily available for inclusion. Place the image asset into the Bookmarks node, 
located in the My Work tree of the navigation pane, for easy retrieval during the 
linking process. 

Note

If you are creating a new referring asset, you can start this procedure in the 
asset’s Create view. However, it is best to save the asset and then open its Edit 
view (to ensure against possible loss of any existing content, as you move from 
step to step).

Note

By default, CKEditor is not displayed automatically when the asset’s Edit 
view opens. Click in the field to display the CKEditor. If the CKEditor does 
not appear, then linking is not supported in the field. Contact your system 
administrator to have the field enabled with CKEditor.

Note

Rendering additional content (such as text) can interfere with and corrupt the 
linking process.
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1) Find the image asset and place it in the Bookmarks node:

a) In the Search field, enter the desired search criteria (if any) and then click 
the magnifying glass ( ) button.

b) In the search results list, navigate to and right-click the desired asset. In 
the context menu, select Bookmark.

2) Make sure the image asset is displayed in the Bookmarks node:

a) In the navigation pane, click the My Work bar.

b) In the My Work tree, navigate to and expand the Bookmarks node.

The image asset should be displayed in the list of assets underneath the 
Bookmarks node.

- If you are including an image from the Image Picker. The image you wish to 
include is available from the “Image Picker.” (Developers enable the “Image 
Picker” for the Pick an image to include icon. If more than one “Image Picker” 
exists, developers will also determine which “Image Picker” is rendered when the 
Pick an image to include icon is selected.)

Target Asset
The target asset is also previewable and readily available for linking. 

• The target asset can be rendered by one of the templates listed in the asset’s 
“Template” field.

• (Optional) The target asset is placed in the Bookmarks node (in the My Work tree) 
for easy retrieval during the linking process. (For instructions about placing assets in 
the “Bookmarks” node, see step 1 on page 187.)

Next Step
At this point you are ready to link the assets. Continue to any one of the following 
sections, depending on where you will retrieve the image from:

• Linking via an Image from the “Bookmarks” Node

• Linking via an Image from the Image Picker

Note

Placing target assets in the Bookmarks node is most efficient when linking large 
numbers of target assets to a source asset. When you are linking only one target 
asset to a source asset, you can conduct a search for the target asset while 
working in the source asset’s Edit view. (If you are trying to link a large number 
of assets to a source asset, you may have to conduct a separate search for each 
target asset.) When you conduct a search for a target asset, the search results are 
displayed (docked) to the right of the source asset’s Edit view. For information 
about searching for assets, see “Finding Assets,” on page 126.
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Linking via an Image from the “Bookmarks” Node
1. Assuming that all prerequisites starting on page 185 are met, continue as follows: 

Include the image asset in the referring asset:

2. Open the referring asset in its Edit view.

3. Include the image asset:

a. In the navigation pane, click the My Work bar.

b. In the My Work tree, navigate to and expand the Bookmarks node.

A list of bookmarked assets is displayed underneath the Bookmarks node. 

c. In the desired field of the referring asset, place your cursor at the point where you 
want the image asset to be rendered.

To work more comfortably, you can maximize the CKEditor to fill your workspace. 
Click the Maximize icon. 

d. On the CKEditor toolbar, click the Include asset icon.

The “Insert Included Asset” dialog box opens: 

1) Navigate to the expanded Bookmarks node in the My Work tree. Select the 
desired asset and drag it to the drag and drop field in the “Insert Included 
Asset” dialog box. Then drop the asset into the field.

Maximize the editor size

Include Asset
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The dialog box displays the layouts (templates) available to be assigned to the 
target asset.

2) Select a layout (template) to assign to the included asset. The layout 
(template) you select will render the included asset at its insertion point in the 
referring asset.

3) If the “Template Arguments” section displays the “Name” and “Value” 
menus, you can use them to set properties for the included asset. Select the 
parameters that you need (one at a time), enter a value, and click Add.   

4) Click OK to save the included asset.

The dialog box closes, and the image is rendered in the field with the layout 
(template) you selected: 

4. If you change your mind about the image or wish to make other adjustments, right-
click the linked image to open its context menu. From the context menu you can:

- Cut Included Asset

- Copy Included Asset

- Edit Properties

- Remove Included Asset

Note

The “Template Arguments” section is enabled only if developers have 
configured parameters for the template that is assigned to the included 
asset. Otherwise, the “Template Arguments” section displays the 
message “No arguments defined for template Name.”

Referring 
asset

Included 
image
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5. If you want to resize the included image or view its properties, double-click the 
included image. When you double-click the image, a properties window opens. You 
can adjust the size and alignment of the asset from the properties window. 

Link the image asset to the target asset:

6. Now that the image is rendered in the referring asset’s field, create a hyperlink from 
the image to the target asset:

a. In the navigation pane, click the My Work bar.

b. In the My Work tree, navigate to and expand the Bookmarks node.

A list of bookmarked assets is displayed underneath the Bookmarks node. 

c. In the referring asset’s field, select the image you have just inserted.

d. On the CKEditor toolbar, click the Add asset link icon.

The “Insert Embedded Link” dialog box opens: 

1) Navigate to the expanded Bookmarks node in the My Work tree. Select the 
desired asset and drag it to the drag and drop field in the “Insert Embedded 
Link” dialog box. Then drop the asset into the field.

The dialog box displays the layouts (templates) available to be assigned to the 
target asset.

2) Select the layout (template) to assign to the target asset. The layout (template) 
you select will render the target asset when the hyperlink is clicked.

3) In the “Wrappers” drop-down field, select the wrapper with which you want 
to render the target asset.

4) (Optional) In the “Link Anchor” field, provide a secondary link. If the 
primary link to the target asset is broken in some way, the secondary link is 
used instead.

5) If you do not want to link the included image to the target asset, you can 
choose to replace the included image with text. In the “Link Text” field, enter 

Add asset link
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the text you wish to hyperlink. The image is replaced with the text you enter 
into this field.

6) If the “Template Arguments” section displays the “Name” and “Value” 
menus, you can use them to set properties for the target asset. Select the 
parameters that you need (one at a time), enter a value, and click Add.   

7) Click Apply.

8) Click OK to save the link.

The dialog box closes, and the image you included in the field now appears as 
a hyperlink, surrounded by a blue border.

7. At this point, you can work with the linked image by right-clicking it to open its 
context menu. From the context menu you can:

- Cut Linked Asset

- Copy Linked Asset

- Edit Properties

- Remove Linked Asset

a. Enter text before or after the linked image.

8. Save the referring asset:

a. If you expanded the CKEditor, click the Maximize icon to collapse the CKEditor 
and view the entire asset.

b. Click the Save ( ) icon.

Test the linked image:

9. If the referring asset is previewable, click the Preview ( ) icon, in the asset’s 
toolbar, to preview and test the linked image. Click the image to render the target 
asset.

Linking via an Image from the Image Picker
1. Assuming that all prerequisites starting on page 185 are met, continue as follows:

Note

The “Template Arguments” section is enabled only if developers have 
configured parameters for the template that is associated with the target 
asset. Otherwise, the “Template Arguments” section displays the 
message (No arguments defined for template Name.”

Note

The Remove Linked Asset option removes the link function, but not the 
included image. To restore the link function, press Ctrl+Z until the blue 
border re-appears.
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Include the image asset in the referring asset:

2. Open the referring asset in its Edit view.

3. Include the image:

a. In the desired field of the referring asset, place your cursor at the point where you 
wish to include the image.

To work more comfortably, you can maximize the CKEditor to fill your workspace. 
Click the Maximize icon.

b. In the CKEditor toolbar, click the Pick an Image to Include icon.

The Image Picker and the “Insert Included Asset” window open, as follows:

Maximize the editor size

Pick an Image to Include
Oracle WebCenter Sites User’s Guide



Chapter 10.  Linking Assets

 Linking Two Assets via an Image Asset
193

e Picker 
yed in a 
h results list 

ed to the right 
 referring 

t’s Edit view.
- The “Image Picker” opens to the right of the referring asset’s Edit view. 

- The “Insert Included Asset” pop-up window opens:

1) Navigate to the “Image Picker” (docked to the right of the referring asset’s 
Edit view). Select the desired image asset and drag it to the drag and drop 
field in the “Insert Included Asset” pop-up window. Then drop the image 
asset into the field.

The window displays the layouts (templates) available to be assigned to the 
image asset.

2) Select a layout (template) to assign to the image asset. The layout (template) 
you select will render the image asset at its insertion point in the referring 
asset.

3) If the “Template Arguments” section displays the “Name” and “Value” 
menus, you can use them to set the properties of the included image asset. 

Imag
displa
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Select the parameters that you need (one at a time), enter a value, and click 
Add.

4) Click OK to save the included image asset.

The pop-up window closes, and the image is rendered within the referring 
asset by the template that you selected. 

4. You can now work with the included image as follows: 

Right-click the included image to open its context menu. From the context menu you 
can:

- Cut Included Asset

- Copy Included Asset

- Edit Properties

- Remove Included Asset 

5. If you want to resize the included image or view its properties, double-click the 
included image. When you double-click the image, a properties window opens. You 
can adjust the size and alignment of the asset from the properties window. 

Link the image asset to the target asset:

6. Now that the image is rendered in the field, create a hyperlink from the image to the 
target asset:

a. In the navigation pane, click the My Work bar.

b. In the My Work tree, navigate to and expand the Bookmarks node.

A list of bookmarked assets is displayed underneath the Bookmarks node.

c. In the referring asset’s field, select the image you just included.

d. In the CKEditor toolbar, click the Add asset link icon.

Note

The “Template Arguments” section is enabled only if developers have 
configured the parameters for the template that is associated with the 
image asset. Otherwise, the “Template Arguments” section displays the 
message “No arguments defined for template Name.”

Add asset link
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The “Insert Embedded Link” pop-up window opens: 

1) Navigate to the expanded Bookmarks node in the My Work tree. Select the 
desired asset and drag it to the drag and drop field in the “Insert Embedded 
Link” window. Then drop the asset into the field.

The window displays the layouts (templates) available to be assigned to the 
target asset.

2) Select a layout (template) to assign to the target asset. The layout (template) 
you select will render the target asset when the hyperlinked image is clicked.

3) In the “Wrappers” drop-down menu, select the wrapper with which you want 
to render the target asset.

4) (Optional) In the Link Anchor field, provide a secondary link. If the primary 
link to the target asset is broken in some way, the secondary link is used 
instead.

5) If the “Template Arguments” section displays the “Name” and “Value” 
menus, you can use them to set the properties of the target asset. Select the 
parameters that you need (one at a time), enter a value, and click Add.

6) Click OK to save the link.

7. At this point, you can work with the linked image as follows:

a. Right-click the linked image to open its context menu. From the context menu you 
can:

- Cut Linked Asset

- Copy Linked Asset

- Edit Properties

Remove Linked Asset

Note

The “Template Arguments” section is enabled only if developers have 
configured the parameters for the template that is assigned to the target 
asset. Otherwise, the “Template Arguments” section displays the 
message “No arguments defined for template Name.”
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b. Enter text before or after the linked image.

8. Save the referring asset:

a. If you expanded the CKEditor, click the Maximize icon to collapse the CKEditor 
and view the entire asset.

b. In the referring asset’s toolbar, click the Save ( ) icon.

Test the linked image:

9. If the referring asset is previewable, click the Preview ( ) icon, in the asset’s 
toolbar, to preview and test the linked image. Click the image to render the target 
asset. 

Note

The Remove Linked Asset option removes the link function, but not the 
included image. To restore the link function, press Ctrl+Z until the blue 
border re-appears.
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Linking Assets to URLs
Using CKEditor, you can link WebCenter Sites assets to URLs by creating a hypertext link 
to the desired website’s URL. A link to a URL is not stored in its own field in the 
WebCenter Sites database. The link can be created directly within any CKEditor-enabled 
field of a WebCenter Sites asset, but it cannot be managed as an asset. As a result, the user 
who creates a link to a URL must manually validate the URL.

The extent to which this capability is available to you depends on whether CKEditor is 
configured for your custom asset types. For example, the “Article” asset type that ships 
with the avisports sample site is configured with a CKEditor in its “Body” field. Therefore 
the “Body” field supports the creation of a link to a URL as described above. The rest of 
this section describes how to link assets to URLs. 

To create a link to a URL

1. Find the referring asset (in which you will specify a URL) and open its Edit view. If 
you need to find the referring asset, do the following:

a. In the Search field, enter the desired search criteria (if any) and then click the 
magnifying glass ( ) button. 

b. In the search results list, navigate to and right-click the desired asset. In the 
context menu, select Edit.

2. Navigate to the field in which you would like to place the link. Click in the field to 
make sure it displays the CKEditor. 

3. In the desired field, select the text that you want to be the hyperlink. Alternatively, you 
can type new text anywhere in the field and select it.

Note

If you are creating a new referring asset, you can start this procedure in the 
asset’s Create view. However, it is best to save the asset and then open its Edit 
view (to ensure against possible loss of any existing content, as you move from 
step to step).

Note

By default, CKEditor is not displayed automatically when the asset’s Edit view 
opens. Click in the field to display the CKEditor. If the CKEditor does not 
appear, then linking is not supported in the field. Contact your system 
administrator to have the field enabled with CKEditor.
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To work more comfortably, you can maximize the CKEditor to fill your workspace. 
Click the Maximize icon. 

4. On the CKEditor toolbar, click the Link icon. 

The following pop-up window opens:

a. In the “Link Type” field, select URL. 

b. In the “URL” field, type the URL of the website you wish to link to.

c. Click OK to convert the selected text to a link.

Maximize the editor size

Link
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The pop-up window closes, and the hyperlinked text appears underlined in the 
field, as shown below:    

5. If you wish to make adjustments to the link, right-click the link to open its context 
menu. From the context menu you can:

- Cut

- Copy

- Edit Link

- Unlink

6. Save the referring asset:

a. If you expanded the CKEditor, click the Maximize icon to collapse the CKEditor 
and view the entire asset.

b. In the referring asset’s toolbar, click the Save ( ) icon.

7. View and test the link. 

a. In the referring asset’s toolbar, click the Preview ( ) icon

b. In the preview of the referring asset, click the link to open the corresponding web 
page in a browser window.

Note

The Unlink option removes the link function, but not the text of the link. To 
restore the link function, press Ctrl+Z until the underscore re-appears.

Hyperlinked text
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Chapter 11

Working with Multilingual Assets
This chapter shows you how to work with localized assets and multilingual asset sets.

This chapter contains the following sections:

• Overview

• Setting or Changing an Asset’s Locale Designation

• Creating a Translation of an Asset

• Examining the Available Translations of an Asset

• Changing the Master Asset of a Multilingual Set
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Overview
Very often, organizations maintain one or more localized websites that serve different 
geographic regions. Such sites will host content in one or more languages local to the 
region served by the site. In such cases, a piece of content can be translated to exist in 
multiple languages, or locales.

If two or more locales are set up on your site, you can translate assets into the languages 
that are enabled by the locales. When you create the first translation of an asset, the asset 
and its translation become a multilingual set, and the source asset is automatically 
designated as the master asset of the set. Once an asset is designated as the master of a 
set, it remains so until you designate another member of the set as the master.

You can create subsequent translations either from the master asset, or from an existing 
translation. The master asset and its translations are linked to one another to indicate they 
are members of the multilingual set. Each member contains the same piece of content but 
in a different language. You cannot delete the master asset if at least one translation exists 
in the set. You will have to delete all of the translations linked to the master asset before 
you can delete it.

Each asset can have only one translation in each available language. For example, once a 
Canadian French translation of an asset exists, you cannot create another Canadian French 
translation within the same multilingual set.

To create a translation of an asset, you must do the following:

1. Select the target language of the translation. WebCenter Sites does the following:

a. Creates a copy of the source asset

b. Sets the target language of the copy according to your selection.

c. Links the copy to the master asset and marks the copy as a translation of the 
master. If this is the first translation of the asset, a multilingual set is created and 
the source asset is designated as the master.

2. Translate the source content and store the translated content in the translation asset.

3. (Optional) Translate the assets associated with the source asset and associate the 
translated versions with the translation of the source asset. See Table 4, on page 203 
for information on how asset relationships are handled when you create translations of 
assets. 

Note

Before performing the procedures in this chapter, note the following:

• Your WebCenter Sites interface will contain locale-related functionality only if 
the administrator has set up your site to support multiple languages.

• If you plan to work with content in a language that uses non-English characters, 
your machine must be configured for input and display of such characters.

If you have any questions, contact your WebCenter Sites administrator.
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For more information, see “Working with Asset Associations,” on page 154.

Table 4: Asset relationship behavior for multilingual assets

Relationship Type  Behavior

Asset Associations When you create a translation of an asset that contains 
associations, all assets associated with the source asset are 
automatically associated with the translation. You then have 
the choice to translate the associated assets and associate the 
translated versions with the translated parent asset.

Static Lists 
Recommendations

When you create a Static Lists recommendation in a new 
locale, the new “Recommendation” asset retains the member 
assets of the source asset. You then have the choice to translate 
the member assets and place the translated versions in the new 
“Recommendation” asset, replacing the member assets carried 
over from the old collection.

Asset-Type Attributes When an asset containing associations through asset-type 
attributes is translated, all assets associated with the source 
asset are automatically associated with the translation. You 
then have the choice to translate the associated assets and 
associate the translated versions with the translated parent 
asset.

Embedded Links Embedded links are not affected. When an asset containing 
embedded links is translated, you must manually update the 
links to point to the corresponding translations of the linked 
content (if they exist).

Note

If you want to share a localized asset to another site, the locale assigned to the asset 
must be enabled on the target site. If you have questions about locales, contact your 
WebCenter Sites administrator.
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Setting or Changing an Asset’s Locale 
Designation

Before you can create a translation of an asset, the asset must have a locale designation 
assigned to it. (Typically, you assign the locale designation when you create an asset.)

If you want to create a translation of an asset that has no locale designation, follow the 
steps below, then continue on to step 5 of the next section, “Creating a Translation of an 
Asset,” on page 205.

You can also change the locale designation of an asset that already has one assigned to it, 
if necessary. For example, if the administrator decides to further divide the asset’s locale 
(such as dividing French into Canadian French and Belgian French) you can update your 
assets to use the new locale designations.

To set or change an asset’s locale designation

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset whose locale designation you want to set or change. Do one of 
the following:

- Search for and open the desired asset:

1) In the Search field, enter search criteria identifying the asset and click the 
magnifying glass ( ) button. 

2) In the list of search results, click the name of the desired asset.

- If you previously bookmarked the asset, open it from the Bookmarks node:

1) In the My Work tree, expand the Bookmarks node. (If the My Work tree is 
collapsed, expand it by clicking the My Work bar.)

2) In the list of bookmarked assets, double-click the name of the desired asset.

For more information on finding assets, see “Finding Assets,” on page 126.

A tab opens displaying the Inspect view of the asset (in either Form Mode or 
Web Mode).

3. Set or change the asset’s locale designation:

a. If the asset is displayed in Web Mode, switch to Form Mode by clicking the Mode 
switch in the asset’s toolbar.

b. In the asset’s toolbar, click the Edit ( ) icon.

c. Switch to the Metadata section of the form by clicking Metadata in the form 
section selector.

d. In the “Locale” drop-down menu, select the desired locale.

4. In the asset’s toolbar, click the Save ( ) icon.

The asset is now assigned to the selected locale.

Note

You can only assign locales that have been enabled on your site by the WebCenter 
Sites administrator.
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5. Inspect the asset. Do one of the following:

- In the asset’s toolbar, click the Inspect ( ) icon.

- In the menu bar, select Edit > Inspect.

The tab displays the Inspect view of the asset in Form Mode. When you inspect an 
asset, you cannot modify its content.

6. (Optional) If your next step is to create a translation of the asset, proceed to step 5 of 
the next section, “Creating a Translation of an Asset,” on page 205.

Creating a Translation of an Asset

To create a translation of an asset

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset whose locale designation you want to set or change. Do one of 
the following:

- Search for and open the desired asset:

1) In the Search field, enter search criteria identifying the asset and click the 
magnifying glass ( ) button.

2) In the list of search results, click the name of the desired asset.

- If you previously bookmarked the asset, open it from the Bookmarks node:

1) In the My Work tree, expand the Bookmarks node. (If the My Work tree is 
collapsed, expand it by clicking the My Work bar.)

2) In the list of bookmarked assets, double-click the name of the desired asset.

For more information on finding assets, see “Finding Assets,” on page 126.

A tab opens displaying the Inspect view of the asset (in either Form Mode or 
Web Mode).

3. If the asset is displayed in Web Mode, switch to Form Mode by clicking the Mode 
switch in the asset’s toolbar.

4. Switch to the Metadata section of the form by clicking Metadata in the form section 
selector. 

Note

• Before you can create a translation of an asset, the asset must have a locale 
designation already assigned to it. (The asset’s locale is listed in the Metadata 
section of the asset form and is typically assigned by the user who creates the 
asset.) If the asset does not have a locale designation, follow the steps in “Setting 
or Changing an Asset’s Locale Designation,” on page 204, then skip to step 5 of 
this procedure.

• If you are creating the first translation of an asset, you are automatically creating 
a multilingual set consisting of the source asset and the translation. The source 
asset will be automatically designated as the master asset of the multilingual set.
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5. Set the target language of the translation. In the “Translations” field, select the 
Translate link in the desired locale’s “Action” column.

A new tab opens displaying the translated asset’s Create view. The translated asset’s 
name is displayed in the tab as “Translation of (new locale) Asset Name_randomly 
generated number.”

Note

If the “Translations” field is not displayed, stop here. You do not have the 
permissions to translate the asset, or your site has less than two locales set up. If 
you have questions about locales or your permissions, contact your WebCenter 
Sites administrator.
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If the administrator configured the asset type such that all new assets of that type are 
placed into workflow upon creation, you will see the “Choose Assignees” dialog box.

Select at least one user for each required role and click Set Assignees. Any of these 
users can complete the next step in the workflow process. For more information, see 
Chapter 14, “Workflow.”

6. In the translation’s Create view, do the following:

a. In the Name field, replace the asset’s system generated name with a name that 
uniquely identifies the new asset as a translation of the source asset.

Note the following conventions when naming the asset:

- The name must be between 1 and 64 alphanumeric characters.

- The following characters are not allowed: single quote ('), double quote ("), 
semicolon (;), colon (:), question mark (?), percent sign (%), less-than sign 
(<), and greater-than sign (>).

- The name can contain spaces, but cannot start with a space.

b. Translate the asset as follows:

Save your work as you go. Click the Save ( ) icon to save your progress as 
you work on the asset. When you click the Save icon, WebCenter Sites commits 
the changes to the database and keeps the asset open in its Edit view so that you 
can keep working.
If any of the fields or form sections are unfamiliar to you, consult your developers 
or WebCenter Sites administrator.

1) For each field, replace the copied content with an appropriate translation. See 
step b on page 67 for details on filling in the fields in the form.

2) Select the next section in the form section selector and fill in the fields as 
necessary. Continue until you have populated all required sections (marked 
with an asterisk).

7. Save the asset by doing one of the following:

- In the asset’s toolbar, click the Save ( ) icon.

- In the menu bar, select Content > Save.
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WebCenter Sites saves the asset to the database, unless:

- You have left out one or more required fields in one or more sections

- An entry or selection you have made in one or more sections is not permitted

If either of these conditions is true, WebCenter Sites displays an error message 
indicating the offending fields. Correct the errors, then save the asset.

8. Inspect the asset. Do one of the following:

- In the asset’s toolbar, click the Inspect ( ) icon.

- In the menu bar, select Edit > Inspect.

The tab displays the Inspect view of the asset in Form Mode. When you inspect an 
asset, you cannot modify its content.

9. (Optional) If the asset is not preassigned to a workflow and you want to use the 
workflow feature, you can assign the asset to a workflow process as described in the 
section “Assigning an Asset to a Workflow,” on page 244.

10. (Optional) If you want to see how the asset would look if it were published, you can 
preview it. Do the following:

a. In the asset’s toolbar, click the Preview ( ) icon.

b. If the asset does not have a template assigned to it, the “Select Layout” pop-up 
window opens. Select the desired layout and click Apply.

The tab displays the preview of the asset. For detailed instructions about 
previewing assets, see Chapter 7, “Previewing Assets.”

c. When you are finished previewing the asset, click the Go Back ( ) icon in the 
asset’s toolbar.

11. Review the assets associated with the translation asset to determine which associated 
assets need to be translated into the target language.

a. In the Content section of the form, navigate to the field (or fields) displaying the 
associated assets.

b. Review the assets associated with the translated asset and determine which ones 
need to be translated.

When you create a translation of an asset, the assets associated with the source 
asset are automatically associated with the translation asset. 
Depending on the nature of the associated assets, you may want to translate them 
and associate the translated versions with the translation asset you created in the 
previous steps. For example, an image depicting a product might not require a 
localized version, but a data sheet for the product will need to be translated.
See Table 4, on page 203 for information on how WebCenter Sites handles asset 
relationships with respect to multilingual assets.

c. (Optional) If in step b you determined that one or more assets associated with the 
translation asset have to be translated, translate each asset requiring translation by 
repeating this procedure, then follow the steps in “Associating Assets,” on 
page 156 to associate the translated versions with the translation asset you created 
in the previous steps.
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Examining the Available Translations of an Asset
To check whether a translation of an asset exists in a specific language, open the asset and 
examine the “Translations” field in the Metadata section of the form. If the desired 
translation exists for a given language, you can open it by clicking its name in the 
“Translations” field.

To check whether a specific translation of an asset exists

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset whose translations you want to examine. Do one of the 
following:

- Search for and open the desired asset:

1) In the Search field, enter search criteria identifying the asset and click the 
magnifying glass ( ) button.

2) In the list of search results, click the name of the desired asset.

- If you previously bookmarked the asset, open it from the Bookmarks node in the 
My Work tree:

1) In the My Work tree, expand the Bookmarks node. (If the My Work tree is 
collapsed, expand it by clicking the My Work bar.)

2) In the list of bookmarked assets, double-click the name of the desired asset.

For more information on finding assets, see “Finding Assets,” on page 126.

A tab opens displaying the Inspect view of the asset (in either Form Mode or 
Web Mode).

3. If the asset is displayed in Web Mode, switch to Form Mode by clicking the Mode 
switch in the asset’s toolbar.

4. Switch to the Metadata section of the form by clicking Metadata in the form section 
selector. 
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5. Examine the contents of the “Translations” field. If a translation in a given language 
exists, you will see the name of the translation asset displayed next to that language. 

6. (Optional) If you want to open a specific translation of the asset for viewing, in the 
“Translations” field, click the name of the desired translation asset.

Note

If the “Translations” field does not show the name of a translation asset next to 
the desired language, the asset has not yet been translated into that language. 
You can translate the asset by following the steps in “Creating a Translation of 
an Asset,” on page 205.

Master asset 

Translation a
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Changing the Master Asset of a Multilingual Set
When you create the first translation of an asset, the source asset becomes the master asset 
of a multilingual asset set consisting of the asset itself and its translation. As more 
translations of the source asset are created, the multilingual set grows.

If you need to designate another member of the set as the master (for example, when the 
multilingual set is copied to a site in another language), you can do so from the Inspect 
view of any member of the set.

The following procedure shows you how to set a new master asset from the Inspect view 
of the set’s current master asset.

To change the master asset of a multilingual set

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset whose translations you want to examine. Do one of the 
following:

- Search for and open the desired asset:

1) In the Search field, enter search criteria identifying the asset and click the 
magnifying glass ( ) button.

2) In the list of search results, click the name of the desired asset.

- If you previously bookmarked the asset, open it from the Bookmarks node in the 
My Work tree:

1) In the My Work tree, expand the Bookmarks node. (If the My Work tree is 
collapsed, expand it by clicking the My Work bar.)

2) In the list of bookmarked assets, double-click the name of the desired asset.

For more information on finding assets, see “Finding Assets,” on page 126.

A tab opens displaying the Inspect view of the asset (in either Form Mode or 
Web Mode).

3. If the asset is displayed in Web Mode, switch to Form Mode by clicking the Mode 
switch in the asset’s toolbar.

4. Switch to the Metadata section of the form by clicking Metadata in the form section 
selector. 

5. In the “Translations” field, select the Make Master link in the desired translation 
asset’s “Action” column.

The tab displays the Inspect view of the new master asset in Form Mode.

Note

Note the following:

• The master asset of a multilingual set is indicated in the “Translations” field in 
the Metadata section of the asset when it is displayed in Form Mode.

• If a multilingual set is being revision-tracked, you must manually check out all 
members of the set before you can change the set’s master asset. For 
instructions, see “Checking Out Assets,” on page 226.
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Chapter 12

Approval for Publishing
The goal of using WebCenter Sites is to publish content to a website where site visitors 
can read and interact with that content. Before an asset can be published, it has to be 
approved for publishing.

This chapter describes the procedures used to approve assets for publishing. It includes the 
following sections:

• Overview

• Approval Tasks
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Overview
Before an asset can be published, it must be approved for publishing. Requiring approval 
is a safeguard against publishing an asset whose dependent assets are not ready to be 
published. This prevents broken links on the delivery system. You approve assets for one 
or more destinations that the administrator sets up on your site. Having multiple 
destinations allows for the use of multiple publishing methods. (For more information on 
destinations and available publishing methods, see the Oracle WebCenter Sites 
Administrator’s Guide.)

Asset approval can be either manual or automatic. You can manually approve assets by 
clicking the Approve ( ) icon in an asset’s toolbar. You can also manually approve 
assets directly from the Content Tree or a search results list. Form Mode enables you to 
approve the primary asset (asset with which you are working). Web Mode enables you to 
approve the primary asset and all assets displayed in the primary asset’s web page view. If 
any of the assets you are approving have dependent assets that need approval, WebCenter 
Sites displays a list of dependent assets which you can then approve in bulk. 

Asset approval can also be automated. For example, your administrator can configure a 
workflow process in such a way that its final step automatically approves assets in the 
workflow for publishing to one or more destinations.

Dependencies
Dependencies are conditions that determine whether an asset can be published. An asset 
dependency exists when there is an association of some kind between assets. For example, 
a “Product” asset has an association with a “Datasheet” asset. The “Datasheet” asset has 
an association with three “Image” assets. Two of these images have associations with 
“Article” assets. This tree hierarchy forms a set of parent/child dependencies among all 
these assets.

The approval status of an asset indicates whether the asset can be safely published; that 
is, whether any dependency conflicts exist. An asset’s approval status is determined by its 
dependency relationships, which include the approval status of all assets associated with a 
particular asset, as well as the dependency relationships of those associated assets.

For more information on how WebCenter Sites calculates asset dependencies during 
approval and publishing, see the publishing chapter of the Oracle WebCenter Sites 
Administrator’s Guide.
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Approval States
Because of the dependencies between assets, as well as the nature of the dependencies, 
approving an asset involves the concept of approval states. For example, “Held” is an 
approval state an asset enters when the asset is approved for publishing, but its dependent 
assets are not. In such case, the asset is then held from publishing until its dependents are 
approved. 

The following table lists all the possible approval states of an asset and what each state 
means: 

If an asset enters an approval state that prevents publication, WebCenter Sites displays a 
list of dependent assets that require approval. Once all assets are approved, they can be 
published.

To learn more about the approval and publishing mechanisms employed by WebCenter 
Sites, see the Oracle WebCenter Sites Administrator’s Guide.

Approval Tasks
This section provides information on the following approval tasks you can perform on an 
asset:

• Approving an Asset for Publishing

• Checking an Asset’s Approval Status

• Removing Assets from the Publishing Queue

Approving an Asset for Publishing
The following procedure describes how to manually approve an asset for publishing. 
Before approving an asset for publishing, you should preview it first.

To manually approve an asset for publishing 

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find the asset(s) you want to approve for publishing:

- If the asset is currently assigned to you:

1) Access your dashboard by clicking the Home ( ) tab.

State Meaning

Approved (Informational) The asset will be published during the next 
publishing session to this destination, unless the asset, or one of its 
dependent assets (in Exact dependencies), is edited. 

Held (Action required) The asset will be held until the dependents are 
approved.

Needs Approval (Action required) The asset requires approval. Click Approve to 
initiate the approval process.
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2) Navigate to the “Assignments” section of your dashboard.

The “Assignment” section of the dashboard displays a list of all the assets that 
have been assigned to you.

3) In the list of assets, click the name of the asset you wish to approve. 

WebCenter Sites opens a tab displaying the asset’s Inspect view.

- If the asset is not currently assigned to you:

1) In the Search field, enter search criteria identifying the asset and click the 
magnifying glass ( ) button.

For more information on finding assets, see “Finding Assets,” on page 126.

2) In the search results list, do one of the following:

-    If you wish to Inspect the asset before you approve it, navigate to the 
desired asset and click its name.

WebCenter Sites opens a tab displaying the asset’s Inspect view (in either 
Form Mode or Web Mode). 

-    If you wish to approve the asset from the search results list, select 
(Ctrl+click) the asset(s) you wish to approve.

3. Select the desired publishing destination for the asset. Do one of the following:

- In the asset or search tab’s toolbar, click the Approve ( ) icon. In the menu that 
appears below the icon, select the desired publishing destination.

- In the menu bar, select Content > Approve > select the desired publishing 
destination.

One of the following happens:

- If you are approving an asset that is displayed in Form Mode or if you are 
approving assets from a search results list, the tab displays a table containing the 
details of the asset(s) you chose to approve for the selected destination.

Note

• You can approve an asset for only one destination at a time; repeat this 
procedure to approve the asset for additional destinations.

• Consult your administrator to find out where (to which destinations) and 
how (using which publishing method) your content is published from your 
system.

Prim
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- If you are approving an asset that is displayed in Web Mode, the tab displays a 
table containing the primary asset’s details for the selected destination along with 
details of all the assets displayed in the primary asset’s web page view.

Continue with the steps below to approve the asset(s). If you do not wish to approve 
any of the assets at this time, click Go Back.

4. Approve the asset(s) and any dependencies. Do one of the following:

- If you wish to approve the asset(s) and all dependencies at one time, do the 
following:

1) In the table, make sure the rows containing the assets you wish to approve are 
selected (highlighted). If you wish to approve all assets displayed in the table, 
click Select All. If you wish to approve only certain assets in the table, 
highlight (Ctrl+click) the rows containing the assets you wish to approve.

2) Click Approve With Dependencies.

-    If the approval is successful, the asset and all of its dependencies are now 
approved for publishing to the selected destination. In the “Status” 
column of the table, the status of the asset(s) changes to “Approved.” 

-    If an asset has dependencies that cannot be approved (for example, one or 
more dependent assets are checked out to another user), the status of the 
asset (located in the “Status” column of the table) changes to “Held” and 
the “Detail” column displays the number of assets blocking its approval. 

- If you wish to view the dependencies before approving them, do one of the 
following:

- If you want to approve multiple assets:

1)  In the table, make sure the rows containing the assets you wish to approve 
are selected (highlighted). If you wish to approve all assets displayed in 
the table, click Select All. If you wish to approve only certain assets in the 
table, highlight (Ctrl+click) the rows containing the assets you wish to 
approve. 

2)  Click Approve.

- If you want to approve the assets in the table one at a time, in the “Action” 
column of the table, click Approve next to the asset you wish to approve. 
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One of the following happens:

- If the asset has no dependencies, the status of the asset (located in the “Status” 
column of the table) changes from “Needs Approval” to “Approved.”

- If the asset has dependencies that are preventing publication, the status of the 
asset (located in the “Status” column of the table) changes to “Held” and the 
“Detail” column displays the number of dependent assets. To approve the 
dependent assets, do the following:

1)  In the “Detail” column, click the n blocking assets link to display a list of 
dependent assets.

2)  Continue with the steps below to approve the asset (or click Go Back).

3)  At the top of the list of dependent assets, click Select All to select all assets 
in the list. Then click Approve. 

WebCenter Sites approves the dependent assets and calculates their 
dependencies. If any of the dependent assets have their own 
dependencies, WebCenter Sites displays a list of the dependent assets’ 
dependencies; again, click Select All, and then click Approve. Continue 
this process until all dependencies for all assets are approved.

When all dependencies are approved, the status of the “Held” assets changes to 
“Approved.” The assets and their dependencies are now approved for publishing to 
the selected destination.
Oracle WebCenter Sites User’s Guide



Chapter 12.  Approval for Publishing

 Approval Tasks
219
5. (Optional) If the administrator configured a publishing event for the destination to 
which you approved the asset(s), you will see the “Publish event schedule for 
destination” link, as shown below:

Point to this link to view a summary of the publishing event schedule for the selected 
destination. For more information about publishing sessions, see the Oracle 
WebCenter Site Administrator’s Guide.

Checking an Asset’s Approval Status
To check an asset’s approval status

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset whose approval status you wish to view:

- If the asset is currently assigned to you:

1) Access your dashboard by clicking the Home ( ) tab.

2) Navigate to the “Assignments” section of your dashboard.

The “Assignment” section of the dashboard displays a list of all the assets that 
have been assigned to you.

3) In the list of assets, click the name of the asset you wish to approve. 

WebCenter Sites opens a tab displaying the asset’s Inspect view.

- If the asset is not currently assigned to you:

1) In the Search field, enter search criteria identifying the asset and click the 
magnifying glass ( ) button.

For more information on finding assets, see “Finding Assets,” on page 126.

2) In the search results list, navigate to the desired asset and click its name.

WebCenter Sites opens a tab displaying the asset’s Inspect view.
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3. In the menu bar, select View > Status.

The tab displays the asset’s status summary screen, which displays information about 
the asset’s approval status.

4. Navigate to the name of the desired publishing destination and check the asset’s 
approval state. For information about an asset’s approval state, see “Approval States,” 
on page 215.

Removing Assets from the Publishing Queue
If you decide not to publish an approved asset, you can unapprove the asset. When you 
unapprove, WebCenter Sites removes the asset from the publishing queue (for the given 
destination) and changes its status to “Needs Approval.” If the unapproved asset is a child 
(referenced asset) of one or more assets in the publishing queue, WebCenter Sites removes 
the parent (referring) assets from the publishing queue for the destination and changes 
their approval states to “Held.” 

To remove an asset from the publishing queue

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset you want to remove from the publishing queue:

- If the asset is currently assigned to you:

1) Access your dashboard by clicking the Home ( ) tab.

2) Navigate to the “Assignments” section of your dashboard.

The “Assignment” section of the dashboard displays a list of all the assets that 
have been assigned to you.

3) In the list of assets, click the name of the asset you wish to approve. 

WebCenter Sites opens a tab displaying the asset’s Inspect view.

The asset’s publishing status
publishing destination availab
site with which you are workin
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- If the asset is not currently assigned to you:

1) In the Search field, enter search criteria identifying the asset and click the 
magnifying glass ( ) button.

For more information on finding assets, see “Finding Assets,” on page 126.

2) In the search results list, navigate to the desired asset and click its name.

WebCenter Sites opens a tab displaying the asset’s Inspect view.

3. Unapprove the asset:

a. Do one of the following:

- In the asset’s toolbar, click the Approve ( ) icon. In the menu that appears 
below the icon, select the desired publishing destination.

- In the menu bar, select Content > Approve > select the desired publishing 
destination.

The tab displays a table containing the asset’s details for the selected destination.

b. In the “Action” column of the table, click Unapprove.

WebCenter Sites removes the asset from the publishing queue. The asset’s 
approval state in the “Status” column of the table changes to “Needs Approval.” If 
the asset is a child (referenced asset) of one or more assets in the publishing 
queue, WebCenter Sites removes the parent (referring) assets from the queue and 
changes their approval states to “Held.” 
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Chapter 13

Revision Tracking
Revision tracking is an optional feature and must be enabled by the WebCenter Sites 
administrator for the asset types on your sites. Revision tracking allows you to track and 
control the changes made to your assets. 

With revision tracking, you can:

• Enforce that only one person at a time can edit or delete an asset.

• Track and view past versions of an asset and the user(s) who worked with the asset.

• Restore (roll back) an asset to a previous version.

This chapter describes revision tracking and the procedures used to track assets, illustrated 
with examples from the avisports sample site. In the avisports sample site, revision 
tracking is not enabled by default.

This chapter contains the following sections:

• Overview

• Checking Out Assets

• Examining Your Checkouts

• Undoing a Checkout

• Checking In Assets

• Examining Revision History

• Reverting to a Previous Version (Rollback)

Note

Contact your administrator if you have any questions or concerns about revision 
tracking as it applies to you.
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Overview
Revision tracking allows you to check out, or lock, assets. When you check out an asset, 
you lock the asset, which prevents other users from editing or deleting it. When you are 
finished working with the asset, you can decide to check the asset back in with the changes 
you made or discard the changes you made to the asset by undoing the checkout. In either 
case, the asset is then again available for modification by other users. An asset that is 
checked out to you, however, can still be viewed and searched for by other users, as well 
as retrieved by queries or collections.

When revision tracking is enabled, you control whether other users can edit or delete an 
asset by checking it out and back in. You can either check assets out manually, or you can 
let WebCenter Sites handle the check out process automatically. If you allow WebCenter 
Sites to automatically check assets out to you, you will still have to manually check assets 
back in when you are done working with them.

Checkout and Checkin
When revision tracking is enabled, the following commands control access to assets:

• Check out. Only one user can check out an asset at any given time. If other users try 
to check the asset out or modify it, WebCenter Sites informs them that the asset is 
locked by someone else.

If an asset is assigned to you in a workflow, and you have checked out the asset, then 
you cannot finish your assignment until you check the asset back in.

An asset that is checked out (locked by a user) cannot be approved for publishing until 
it is checked in (unlocked).

• Undo Checkout. If you check out an asset and then decide that you do not want to 
save the changes you have made to it, cancel or “undo” the checkout. In this case, the 
asset is simply unlocked, changes are reverted back to the most current version of the 
asset, and no new version is saved.

• Check in. You check in assets that you have checked out. After the asset is checked 
in, others can work with it, and if the asset is assigned to you in a workflow, you can 
finish your assignment.

When you check in an asset that you have checked out, a record is made of the 
checkin, and a copy of the last saved version of the asset is preserved as a new version 
(the number of versions kept is set by the administrator).

Another option is to check in the asset so that you have an archived version but to 
keep it checked out. This option enables you to create a version but keeps the asset 
checked out to you.

If you edit an asset that is not already checked out to you, WebCenter Sites checks it out to 
you automatically. When you save the edited asset, WebCenter Sites does not check the 
asset back in for you. Therefore, you will still have to manually check the new version of 
the asset back in after you save the changes you have made to it. Similarly, if you do not 
want to save the changes you made to an asset that is checked out to you, you will have to 
manually undo the checkout.

If you delete an asset that is not already checked out to you, WebCenter Sites checks it out 
to you for deletion. This ensures that no other users can work with the asset as you are 
deleting it from WebCenter Sites. Once the asset is deleted, it is no longer checked out to 
you because it no longer exists in the system.
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Releasing Locked Assets
If you edit an asset when revision tracking is enabled, the asset is automatically checked 
out to you. Because of this, you may accidentally check out an asset while you work in the 
WebCenter Sites interface. When an asset is checked out to you, the asset is locked and 
prevents other users from working with it. To make sure that you are not preventing other 
people from working with assets that you have inadvertently checked out, review the 
assets checked out to you by viewing the “Checkouts” section of your dashboard (located 
in the Home tab) and check in (or, if you do not want to commit your changes to the 
database, undo the checkout of) any assets that you do not need to lock.

Functions That Automatically Checkout an Asset To You
The following table describes asset management functions that check assets out 
automatically:

Rollback and Revision History
When you check in an asset that you have checked out, WebCenter Sites stores a new 
version of the asset and adds it to a list of previous versions. You can later restore the asset 
to one of those previous versions and you can examine the asset’s revision history. 

• Rollback means restoring the asset to a previous version. When you have an asset 
checked out, you can roll it back to any previous version (provided the version was not 
overwritten). Rollback restores the contents of the asset, but does not reset its status 
(created, edited, and so on) as of the previous version, nor does it affect workflow 
status. If the asset is part of a workflow, anyone who has the appropriate permissions 
can restore it to a previous version.

• Revision History. You or any user can list and examine the revision history of an 
asset. The revision history also shows who, if anyone, currently has the asset checked 
out. You can also see comments entered by the user who checked the asset in at the 

Function Effect on Revision Control

Create As soon as you create a new asset, the asset is checked out to you. 

Edit Checks out the asset and prohibits other users from editing or 
deleting it.

Copy Creates a new copy of the asset. The source asset cannot be checked 
out during the copy operation. As soon as you create a copy of an 
asset, the copy is automatically checked out to you. 

Note

The volume of revisions to be saved for a given asset may be limited (depending 
on your administrator’s configurations). Therefore, earlier versions of the asset 
could be overwritten. In this case, the overwritten version will not be shown in the 
asset’s revision history. An asset cannot be rolled back to a version that has been 
overwritten.
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time, if the user chose to enter a comment, by looking at the “Comments” section of 
the revision history table.

Checking Out Assets
This section shows you how to manually check out an asset.

To check out an asset

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset you want to check out. Do one of the following:

- Search for and open the desired asset:

1) In the Search field, enter search criteria identifying the asset and click the 
magnifying glass ( ) button.

2) In the list of search results, click the name of the desired asset.

- If you previously bookmarked the asset, open it from the Bookmarks node in the 
My Work tree:

1) In the My Work tree, expand the Bookmarks node. (If the My Work tree is 
collapsed, expand it by clicking the My Work bar in the navigation pane.)

2) In the list of bookmarked assets, double-click the name of the desired asset.

For more information on finding assets, see Chapter 6, “Finding and Organizing 
Assets.”

A tab opens displaying the Inspect view of the asset (in either Form Mode or 
Web Mode).

3. Check out the asset:

Note

If the asset is checked out to another user, when you try to edit the asset or check 
the asset out, you will receive an error message like the one below:
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- If you are working in Form Mode, in the asset’s toolbar, click the Check Out 
( ) icon.

WebCenter Sites checks the asset out to you.

- If you are working in Web Mode, do the following:

1) In the asset’s toolbar, click the Checkin/Checkout ( ) icon.  

The tab displays the “Asset to be checked in” screen. This screen contains a 
table with revision tracking details about the primary asset (asset you opened 
in Web Mode) and all of its associated assets (assets displayed in the primary 
asset’s web page view), as shown below:

The revision tracking action (if any) you can perform on an asset is indicated 
in the “Action” column of the desired asset’s row. If the asset is not revision 
tracked, then the “Action” column for that asset’s row is empty and the 
“Detail” column for that asset’s row displays the message “Not Tracked.”

2) In the revision tracking detail table, select (Ctrl+click) the asset(s) you wish 
to check out and then click the Checkout button. You can also check assets 
out one at a time by clicking the Checkout link in the “Action” column of the 
desired asset’s row.

WebCenter Sites checks the asset(s) out to you. 

Note

If you do not see the Check Out icon in the asset’s toolbar, either revision 
tracking for that asset type is not enabled on your site or the asset is already 
checked out to you.
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Examining Your Checkouts
A list of assets that are currently checked out to you is accessible from your dashboard (in 
the Home tab).

To view a list of assets currently checked out to you

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Access your dashboard by clicking the Home ( ) tab.

3. Navigate to the “Checkouts” section of the dashboard.

The “Checkouts” section of the dashboard lists all of the assets that are currently 
checked out to you.

4. (Optional) If you want to open an asset, click its name in the list.

A tab opens displaying the asset’s Inspect view (in either Form Mode or Web Mode).

Undoing a Checkout 
This section shows you how to undo the checkout of an asset. Undoing a check out makes 
the asset available to other users who have permissions to work with it.

To undo the checkout of an asset

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find the asset for which you want to undo the checkout and open it: 

a. Access the dashboard by clicking the Home ( ) tab.
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b. Navigate to the “Checkouts” section of the dashboard.

The “Checkouts” section of the dashboard displays a list of assets currently 
checked out to you.

c. In the list of assets, navigate to the desired asset and click its name.

A tab opens displaying the asset’s Inspect view (in either Form Mode or Web 
Mode).

3. Undo the check out. Depending on whether the asset opened in Form Mode or Web 
Mode, do one of the following:

- If the asset opened in Form Mode:

1) In the asset’s toolbar, click the Undo Checkout ( ) icon.

The following dialog box is displayed:

2) In the dialog box, click Yes.

WebCenter Sites undoes the checkout of the asset.

- If the asset opened in Web Mode:

3) In the asset’s toolbar, click the Checkin/Checkout ( ) icon.

The tab displays the “Asset to be checked in” screen. This screen contains a 
table with revision tracking details about the primary asset (asset you opened 
in Web Mode) and all of its associated assets (assets displayed in the primary 
asset’s web page view), as shown below:

The revision tracking action (if any) you can perform on an asset is indicated 
in the “Action” column of the asset’s row. If the asset is not revision tracked, 
then the “Action” column for that asset’s row is empty and the “Detail” 
column for that asset’s row displays the message “Not Tracked.”
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4) In the revision tracking detail table, select (Ctrl+click) the asset(s) whose 
checkouts you wish to undo and then click the Undo Checkout button. 

WebCenter Sites undoes the check outs of the selected assets.

Checking In Assets
This section shows you how to check an asset in. Checking an asset in creates a new 
version of the asset and makes it available to other users who have permissions to work 
with the asset.

To check in an asset

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find the asset you wish to check in and open it: 

a. Access the dashboard by clicking the Home ( ) tab.

b. Navigate to the “Checkouts” section of the dashboard.

The “Checkouts” section of the dashboard displays a list of assets currently 
checked out to you.

c. In the list of assets, navigate to the desired asset and click its name.

A tab opens displaying the asset’s Inspect view in either Form Mode or Web 
Mode.

3. Check in the asset. Depending on whether the asset opened in Form Mode or Web 
Mode, do one of the following:

- If the asset opened in Form Mode:

1) In the asset’s toolbar, click the Checkin ( ) icon.

The tab displays a table containing the asset’s revision tracking details:

2) Make sure the row containing the asset is highlighted, then click the Checkin 
button.

3) (Optional) In the Comment field, enter comments or instructions that pertain 
to the version you are checking in. The comments you enter here are 
displayed in the asset’s revision history. If you are checking in multiple assets, 
the comment you enter will apply to all assets that you are checking in.

4) (Optional) If you want to create a new version of the asset and then continue 
working on the new version, select the Keep Checked Out box.
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5) Click Checkin.

WebCenter Sites checks the asset in to the database.

- If the asset opened in Web Mode:

1) In the asset’s toolbar, click the Checkin/Checkout ( ) icon.

The tab displays the “Asset to be checked in” screen. This screen contains a 
table with revision tracking details about the primary asset (asset you opened 
in Web Mode) and all of its associated assets (assets displayed in the primary 
asset’s web page view), as shown below:

The revision tracking action (if any) you can perform on an asset is indicated 
in the “Action” column of the desired asset’s row. If the asset is not revision 
tracked, then the “Action” column for that asset’s row is empty and the 
“Detail” column for that asset’s row displays the message “Not Tracked.”

2) In the revision tracking detail table, select (Ctrl+click) the asset(s) you wish 
to check in and then click the Checkin button. You can also check assets in 
one at a time by clicking the Checkin link in the “Action” column of the 
desired asset’s row.

3) (Optional) In the Comment field, enter comments or instructions that pertain 
to the version you are checking in. The comments you enter here are 
displayed in the asset’s revision history. If you are checking in multiple assets, 
the comment you enter will apply to all assets that you are checking in.

4) (Optional) If you want to create a new version of the asset and then continue 
working on the new version, select the Keep Checked Out box.

5) Click Checkin.

WebCenter Sites checks the selected asset(s) back in to the database.
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Examining Revision History

To examine an asset’s revision history

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset whose revision history you want to view:

a. Do one of the following:

- If the asset is not currently checked out to you, in the Search field, enter 
search criteria identifying the asset and click the magnifying glass ( ) 
button.

For more information about finding assets, see Chapter 6, “Finding and 
Organizing Assets.”

- If the asset is currently checked out to you, access the dashboard by clicking 
the Home ( ) tab. Then, navigate to the “Checkouts” section of the 
dashboard.

b. In the list of assets, navigate to the desired asset and click its name.

A tab opens displaying the asset in its Inspect view (in either Form Mode or Web 
Mode).

3. If the asset opens in Web Mode, switch to Form Mode. In the asset’s toolbar, click the 
Mode switch. 

4. View the asset’s revision history. Do one of the following:

- In the asset’s toolbar, click the Show versions ( ) icon.

- In the menu bar, select Edit > Version > Show versions.

The tab displays the asset’s revision history:

5. Click the magnifying glass icon next to the version you want to view. 

The tab displays the Inspect view of the version of the asset you selected (in Form 
Mode).

Note

You can examine an asset’s revision history only if the asset is displayed in Form 
Mode. If the asset opens in Web Mode, you will have to switch to Form Mode
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Reverting to a Previous Version (Rollback)
This section shows you how to roll an asset back to a previous version.

To roll back an asset

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find the asset you want to roll back to a previous version and open it:

a. Do one of the following:

- If the asset is not currently checked out to you, in the Search field, enter 
search criteria identifying the asset and click the magnifying glass ( ) 
button.

For more information about finding assets, see Chapter 6, “Finding and 
Organizing Assets.”

- If the asset is currently checked out to you, access the dashboard by clicking 
the Home ( ) tab. Then, navigate to the “Checkouts” section of the 
dashboard.

b. In the list of assets, navigate to the desired asset and click its name.

A tab opens displaying the asset in its Inspect view (in either Form Mode or Web 
Mode).

3. If the asset opens in Web Mode, switch to Form Mode. In the asset’s toolbar, click the 
Mode switch. 

4. Roll back to a previous version of the asset. Do one of the following:

- In the asset’s toolbar, click the Rollback ( ) icon.

- In the menu bar, select Edit > Version > Rollback. 

Note

You can roll an asset back to a previous version only when the asset is displayed in 
Form Mode. If the asset opens in Web Mode, you will have to switch to Form 
Mode

Note

You will not be able to roll the asset back to a previous version if either of the 
following is true:

• Revision tracking is not enabled for the asset type. 

• The asset is already checked out by you or another user, you cannot roll it 
back to a previous version. To roll the asset back, it must be checked in.

If you have questions about revision tracking or your permissions, contact your 
WebCenter Sites administrator.
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The tab displays the following: 

5. In the Rollback column of the table, select the radio button next to the version of the 
asset to which you want to roll back.

6. Click Rollback.

WebCenter Sites rolls the asset back to the version you selected. When you roll back 
an asset, WebCenter Sites creates another version of it.
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Chapter 14

Workflow
Most websites are produced by a team of people in which different individuals assemble 
content, edit and review it, and decide what goes where and when to update the pages. 
Work flows from one person to the next in a predictable way, and that process is called 
workflow.

This chapter presents a brief overview of workflow concepts followed by procedures on 
how to perform specific tasks related to workflow. It includes the following sections:

• Overview

• Sample Workflow

• Viewing Your Assignments

• Using Workflow Functions
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Overview
The following sections describe basic workflow concepts and terminology.

Workflow and Assets
Assets can (but do not have to) be assigned to a workflow. A workflow routes an asset 
through a series of editorial tasks (states) by assigning the tasks to the appropriate users at 
the appropriate times. Either specific assets or all assets of a certain type can be assigned 
to a workflow.

Depending on how your site is configured, assets might be assigned to a workflow either 
automatically (for example, when you create a new asset) or manually. The workflow 
system lets WebCenter Sites direct and track the assignment of assets to users and 
specifies what users can do with those assets through permissions.

The flow of the editorial tasks performed on the asset, as well as who is authorized to 
perform those tasks at each point in the workflow is defined by a workflow process. The 
workflow administrator can define as many workflow processes per asset type as needed.

States and Steps
A workflow process defines a series of states. A state is a point in the workflow process 
that represents the status of the asset at that point, for example, “Ready to Edit” or “Ready 
for Approval.”

States are linked together in a specific order by steps. A step is the movement of the asset 
between states. Because creating workflow steps links workflow states in a specific order, 
creating steps in a workflow process is what organizes the process. In each step, the asset 
goes from a start (“from”) state to an end (“to”) state. When creating the workflow 
process, the administrator defines the states and links them via the appropriate steps.

Note

In addition to the functionality described in this chapter, WebCenter Sites provides 
the following workflow functionality through the WebCenter Sites Admin interface:

• Workflow groups – allow you to manage a defined set of assets in a coordinated 
manner that allows those assets to reach the end of the workflow process 
together, prior to publishing.

• Workflow reports – allow you to track the progression of assets and user 
assignments in workflow.

For information on workflow groups and reports, see the Oracle WebCenter Sites 
Administrator’s Guide.

Note

During workflow, the asset is not electronically transferred from one person to the 
next. What is transferred is permissions to the asset. The asset itself remains in its 
original location in the database throughout the workflow process and throughout its 
existence in WebCenter Sites.
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Steps and states have names; for example, in the FirstSite II sample site, “Send for 
Approval” is a step originating from the “Ready to Edit” state and resulting in the “Ready 
for Approval” state. An asset can move from one state to another via more than one step. 
For example, an asset that is ready for approval can be rejected because of factual errors or 
stylistic problems, each type of rejection having its own step.

Assets are assigned to users by roles. As an asset progresses through the workflow, each 
step assigns it to users holding roles authorized to work on the asset in the next state. For 
each step, there is at least one role authorized to complete work on an asset and allow it to 
continue moving through the workflow. In certain cases, a user holding the appropriate 
role can choose between steps; for example, a user holding the Approver role can either 
approve or reject an asset assigned to him/her for approval.

When you log in to WebCenter Sites, the “Assignments” section of the dashboard (Home 
tab) provides a summary of your present workload, from which you can access the assets 
assigned to you. When your work on the asset is complete, you use the 
Finish Assignment function to invoke the next step in the workflow; the workflow 
process then moves the asset to the next state and assigns the asset to the appropriate users. 
Note that a step can be conditional; that is, certain users or all users can be prevented from 
taking a step until some condition is met.

Users, Roles, and Participants
A user in WebCenter Sites is a person who is assigned a WebCenter Sites user name 
which he/she uses to identify him/herself and to log in to WebCenter Sites. What a user 
can or cannot do is determined by the role (or roles) assigned to that user by the 
administrator.

A role describes and determines the function(s) of a user in a CM site by granting him/her 
permissions to perform specific functions; in the context of workflow, these permissions 
are called function privileges.

The workflow process grants roles (not individual users) the appropriate function 
privileges. The function privileges are enforced only when an asset has been assigned to a 
workflow. Function privileges depend not only on the user’s role, but also on the state of 
the asset and whether or not the asset has been assigned to the user. 

Each role required by a particular workflow state in a workflow process is a participating 
role. Participating roles are chosen for each state in a workflow process by the 
administrator. Each user whose assigned role(s) match those required by that workflow 
state is therefore a participant for that state in the workflow process and is authorized to 
take the workflow step leading from that state to the next state.

Note

Because function privileges are granted to a user through his/her role(s), they 
function independently of the access permissions assigned by the administrator at 
the user level.

For example, a user might not normally have the permission to edit “Content” assets, 
but he/she can have the function privilege to do so if he/she has the Editor role, is 
participating in a workflow process for “Content” assets, and the asset he/she wants 
to edit is in the appropriate workflow state.
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Unless the administrator decides otherwise, assets placed in workflow are assigned to all 
available participants for a given role. However, depending on how your administrator 
configured a given workflow step, you may be able to limit which users can work with a 
particular asset by choosing the desired assignees from among the participants available in 
each participating role.

An assignee is a workflow participant chosen to work on a specific assignment. Assignees 
are set when an asset is assigned to a workflow, but you may have the ability to choose 
different assignees when the asset is already in a workflow process. How assignees are 
chosen for a workflow process is determined by the configurations your administrator 
made to the steps in the workflow process. Workflow steps can be configured to allow 
users assigned specific roles to choose assignees. However, workflow steps can also be 
configured to automatically assign an asset to all users with a specified role or to assign an 
asset to only the user who created it.   

When assignees are set for a given asset in the workflow, only the chosen assignees will 
see the asset in their assignment lists, and only they can complete the assignment before 
the workflow process changes the state of the asset.

Workflow Assignments
An assignment is an asset that a chosen participant (an assignee) is (or is supposed to be) 
working on. An asset appears on the participant’s assignment list as soon as the asset 
enters a state for which the participant has a role to fulfill.

A typical workflow design generates an e-mail notification when you are given a 
workflow assignment. You can see an updated list of your assignments at any time in the 
“Assignments” section of your dashboard (located on the Home tab).

Assignment Duration
Each workflow state has an associated estimated time of completion (deadline) for an 
assignment. If the administrator has granted you the appropriate permission, you can 
override the default estimate for the next assignment. 

As the assignment deadline nears, associated assignment actions in the form of e-mail 
notifications can be triggered as timed events relative to the estimated time to completion. 
For example:

• You receive a reminder the day before your assignment is due.

• You and the workflow initiator receive a warning the day the assignment is due.

• The initiator receives notification the day after the due date that the assignment has 
not been completed.

Voting Your Assignments
If you participate in workflow, you have a vote. Voting means taking a workflow step that 
moves the asset from its current state to the next, after you have completed the task 
required by the current workflow state (such as editing an article) and committed the 
changes to the WebCenter Sites database (saved the asset), if applicable. You cast your 
vote by either using the Finish Assignment function (available in the “Assignments” 
section of the dashboard) or by viewing the status of an asset and finishing your 
assignment using the Workflow commands drop-down menu (accessible by selecting 
View > Status in the menu bar when working with the asset). If more than one participant 
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with a given role has the assignment, either one, or all of them must vote before the asset 
moves to the next state, depending on how the workflow was set up by the administrator.

Depending on your role in the workflow process, when you vote to finish the assignment 
you may be given a choice of steps to take; for example, if you are an approver and your 
current assignment is to either approve an asset for publishing or reject it, when you finish 
your assignment you can invoke either a step that approves the asset for publishing, or a 
step that rejects it due to factual error, depending on your choice. When you vote, the asset 
moves to the next workflow state unless the step you chose is in disagreement with the 
step chosen by other assignees with the same role as you.

If, for some reason, you are unable to complete your assignment, you can abstain from 
voting, as long as yours is not the last (or only) vote for that particular role and/or step. 
When you abstain, you still have the assignment, but the asset can continue through 
workflow. If you change your mind, you can reverse your abstention by voting again, as 
long as the asset has not already moved to the next state.

Delegating Your Assignments
Another way of handling an assignment is to delegate it to another participant holding the 
same role as you, assuming the asset you are delegating is not already assigned to that 
person for the current workflow state. 

Your function privileges (set by the administrator) determine whether you can delegate 
your assignments. Also, the administrator can delegate assignments on your and other 
assignees’ behalf, if necessary.

Delegating an assignment can trigger associated delegate actions in the form of e-mail 
notifications. For example:

• The recipient of the new assignment is notified.

• The workflow administrator is notified of the assignment delegation.

Deadlocks
An asset moves from one state to the next when assignees cast their votes (that is, take a 
step) for a given workflow state. When defining the workflow process, the administrator 
decides whether each step is all-voting, that is, whether all assignees must vote (take the 
step) for the asset to move to the next state. By default, steps are not all-voting, which 
means that the first assignee to vote in a given workflow state determines the flow of the 
asset, and the assignments for the remaining assignees for that workflow state are 
cancelled. If the administrator set the step to be all-voting, the asset is held in its current 
workflow state until all assignees have voted, at which time the asset moves to the next 
state.

If there is a choice of steps and each step is all-voting, the potential for a deadlock exists. 
A deadlock occurs when all of the assignees must vote, and the voting is not unanimous on 
which step to take. A workflow process typically includes a deadlock action to generate 
e-mail notifications to all assignees, showing the vote tally and advising all assignees to 
vote again in favor of the majority. Deadlocks cause additional work for all the users 
involved, and should be avoided whenever possible. They should also be resolved as 
quickly as possible so that the flow of work is not hindered.
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Sample Workflow
The FirstSite II sample site includes six sample workflow processes which guide assets of 
different types from creation to approval for publishing. The sample workflows are 
simple, transitioning through three states via five possible steps, but they serve to illustrate 
how a workflow process works. This section is based on the FSII: Approval for Content 
sample workflow process included in the FirstSite II sample site. 

The FSII: Approval for Content sample workflow process has the following roles 
participating: author, editor, approver, and administrator. Each role has only a single 
participant (your organization will most likely have more complex processes, with several 
users participating in each role). A participant from any of the roles can create a new 
“Content” asset, which automatically assigns it to the FSII: Approval for Content 
workflow. By creating the asset, workflow is initiated. The asset then moves from author 
to editor to approver. The approver can either approve or reject the asset. If the approver 
rejects the asset, it goes back to the editor. The administrator can perform the functions of 
author, editor, and approver at any point in the workflow, as well as return an already 
approved asset back to the editor for additional changes.

Sample Workflow States and Steps
The FirstSite II sample site includes a sample workflow process called FSII: Approval for 
Content. The flow of the process is shown in the following diagram: 

The steps and states from this workflow process are described in the following table:

Table 5: States and Steps

Asset in 
State... Step Description

Asset Moves to 
State...

none Create A user with the ContentAuthor role 
creates a “Content” asset, which 
automatically assigns it to the FSII: 
Approval for Content workflow.

Ready to Edit

Ready to 
Edit

Send for 
Approval

A user with the ContentEditor role 
receives e-mail notification of the 
assignment. The editor revises the 
asset to complete the assignment.

Ready for 
Approval
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Sample Workflow Scenario
This section describes the typical flow of a “Content” asset through the FSII: Approval for 
Content workflow process.

1. The author creates the asset and writes the content

The process starts when Conrad the author creates the “Content” asset. Since the 
“Content” asset type in the FirstSite II sample site is configured to automatically place 
each new “Content” asset in workflow, Conrad’s asset is automatically placed into the 
FSII: Approval for Content workflow process. Conrad writes the content and saves the 
“Content” asset.

When Conrad saves the asset, the workflow process automatically changes the state of the 
asset to “Ready to Edit,” assigns it to Connie the editor, and sends Connie an e-mail notice 
about the new assignment.

2. The editor edits the asset and sends it for approval

Connie the editor logs in, checks her assignment list, and opens the “Content” asset for 
editing. She reads the content and fixes some punctuation. When done, Connie saves her 
changes and then votes to send the asset on for approval.

Ready for 
Approval

Reject A user with the Approver role 
receives an e-mail notification of the 
assignment.

The approver completes the 
assignment by rejecting the asset 
because of factual errors. The 
rejection triggers a notice to the 
editor, who must make some 
corrections and resubmit the asset for 
approval.

Ready to Edit

Approve 
and Lock

The approver completes the 
assignments by approving the asset.

The asset is flagged in the 
WebCenter Sites database as “ready 
to publish” for selected destinations.

Approved and 
Locked

Approved 
and Locked

Return for 
Edit

The workflow administrator (holding 
the Workflow Admin role) reviews 
the asset and determines that the 
content needs to be updated with 
additional information.

The workflow administrator then 
uses votes to return the asset to the 
editor for revision.

Ready to Edit

Table 5: States and Steps (continued)

Asset in 
State... Step Description

Asset Moves to 
State...
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The workflow process changes the state of the asset to “Ready for Approval,” assigns it to 
Napoleon the approver, and sends Napoleon an e-mail notice about his new assignment. 

3. The approver approves the asset

Napoleon the approver is already logged in, so when he receives his e-mail, he accesses 
the “Assignments” section of the dashboard to view his assignment list. Napoleon opens 
the newly assigned “Content” asset and examines it. It looks fine, so he can vote to either 
approve or reject the asset for this workflow process. The workflow process presents both 
options to him.

Since Napolean voted to approve the asset, the workflow process changes the state of the 
asset to “Approved and Locked,” and flags it in the database as “ready to publish.” The 
asset will be published to the website during the next publishing session.

4. The workflow administrator returns the asset to the editor

When new information becomes available, it has to be added to the asset. When that 
happens, the workflow administrator can vote in the workflow process to return the asset 
to Connie for review and updating.

The workflow process automatically changes the state of the asset to “Ready to Edit,” 
assigns it to Connie the editor, and sends Connie an e-mail notice about the new 
assignment.

When Connie finishes her assignment, the updated asset will need to be re-approved 
before it can be re-published to the website.

Note

If two or more users with the same role have the same assignment in a given 
workflow state, the first vote cast determines the next state for the asset.

For example, if the FSII: Approval for Content workflow process included two 
approver users who both had a vote when approving the asset for publishing, a 
rejection by either of them would cancel the assignment of the other person and 
return the asset to the editor.

Your administrator might set up a workflow in which a disagreement like this causes 
a deadlock (see “Deadlocks,” on page 239) that has to be resolved before the asset is 
returned to the previous state or moved to the next one.
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Viewing Your Assignments
To manage your workload, you can view a list of your current assignments and their status 
by accessing the “Assignments” section of your dashboard (located on the Home tab).

To view a list of your workflow assignments

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Access your dashboard by clicking the Home ( ) tab. Then navigate to the 
“Assignments” section of your dashboard.

The “Assignments” section of your dashboard displays a list of your workflow 
assignments.

The list provides information about the asset’s name, the action to take in the 
workflow process, the name of the user who assigned the asset to you, and the amount 
of days left until the assignment is due for completion. 

3. Click an asset’s name to open it in its Inspect view (in either Form Mode or Web 
Mode). You can also right-click an asset in the list to open the asset’s Edit view or to 
preview the asset.

Note

As you work in the interface, new assignments might be given to you, and you may 
complete some of your current assignments, causing your assignment list to change. 
Check your assignment list periodically to make sure you stay up to date with your 
assignments.
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Using Workflow Functions
The following sections describe the workflow functions you use in the Contributor 
interface. These functions are available from the menu bar (View > Status) when you are 
working with an asset. Depending on your function privileges, some of the described 
functions may not be available to you.

This section provides information about the following topics: 

• Assigning an Asset to a Workflow

• Setting a Process Deadline

• Setting an Assignment Deadline

• Finishing Your Assignments

• Delegating Your Assignments

• Abstaining from Voting

• Resolving Deadlocks

• Removing an Asset from Workflow

• Viewing an Asset's Participant (Assignee) List

• Setting Workflow Participants

• Examining the Workflow Progress of an Asset

Assigning an Asset to a Workflow
An asset can be assigned to a workflow either automatically or manually.

Automatic workflow assignment is set up by the administrator for selected asset types. 
When you create a new asset of such type, the asset is automatically placed in the 
workflow process assigned to that asset type. Consult your administrator to find out which 
asset types are set up for automatic workflow assignment.

Manual workflow assignment is available to users with appropriate permissions, assuming 
a workflow process is assigned to the selected asset type.

To manually assign an asset to a workflow

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset you want to place in workflow. Do one of the following:

- Search for and open the desired asset:

1) In the Search field, enter search criteria identifying the asset and click the 
magnifying glass ( ) button.

Note

Before an asset can be assigned to a workflow, the administrator must first assign 
one or more workflow processes to the asset type of the asset in question; otherwise, 
the option to assign the asset to a workflow is not available. Consult your 
administrator to find out which workflow processes are available to which asset 
types on your system.
Oracle WebCenter Sites User’s Guide



Chapter 14.  Workflow

 Using Workflow Functions
245
A “Search” tab opens displaying the results of your search. 

2) In the list of search results, click the name of the desired asset.

- If you previously bookmarked the asset, open it from the Bookmarks node in the 
My Work tree:

1) In the My Work tree, expand the Bookmarks node. (If the My Work tree is 
collapsed, expand it by clicking the My Work bar.)

A list of bookmarked assets is displayed underneath the Bookmarks node.

2) In the list of bookmarked assets, double-click the name of the desired asset.

For more information on searching, see Chapter 6, “Finding and Organizing Assets.”

A tab opens displaying the asset’s Inspect view (in either Form Mode or Web Mode).

3. In the menu bar, select View > Status.

4. In the “Workflow commands” drop-down menu, choose Select Workflow. 

The tab displays the “Select Workflow” form:

5. In the “Workflow Process” drop-down menu, select a workflow process.

6. If the workflow process is configured in such a way that you must select assignees for 
each role involved in the workflow process, you will see the Set Participants... 
button. Do the following:

a. Click Set Participants... 

The tab displays the “Set Participants” form. 

b. Select at least one user for each role and then click Set Participants. 

Each participant you select becomes an assignee in the respective role(s) for this 
asset.

7. (Optional) In the “Action to Take” field, enter brief instructions for the person 
receiving the assignment.

8. Click Select Workflow.
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9. If the administrator enabled the selection of assignees for the first step in the workflow 
process, the tab displays the “Choose Assignees” form:

In such cases, select at least one user for each role, then click Set Assignees.

The tab re-displays the asset’s status summary screen. 

At this point, the asset is in workflow; participants with roles required by the next state 
typically receive e-mail notifications of their assignments.
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Setting a Process Deadline
A process deadline is the overall time allotted for an asset to pass through a workflow 
process. By default, no process deadline is set. This deadline is independent of the 
assignment deadline described later in this section; that is, the total of the individual 
assignment deadlines does not necessarily add up to a process deadline. 

Before you can set a process deadline, the workflow administrator must first have done the 
following:

• Allowed a process deadline to be set for this workflow process.

• Assigned you a workflow administrator role for the workflow process, or otherwise 
provided you with the right function privileges.

The option to set a process deadline is available only if both of the above conditions are 
met. Contact your administrator to find out if you have the appropriate privileges and 
whether setting a process deadline is enabled for the workflow process in question.

To set a process deadline

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset for which you want to set a process deadline:

a. Access your dashboard by clicking the Home ( ) tab.

b. Navigate to the “Assignments” section of the dashboard.

c. In the list of assets, click the name of the asset for which you want to set a process 
deadline.

A tab opens displaying the asset in its Inspect view (in either Form Mode or Web 
Mode).

3. In the menu bar, select View > Status.

The tab displays the asset’s status summary screen.

4. In the “Workflow commands” drop-down menu, select Set Process Deadline. 

Note

Deadlines are informational only — the system does not impose any sort of penalty 
or issue error messages when a deadline is exceeded.

Note

If you do not see the Set Process Deadline function in the drop-down menu, 
stop here. The function was not enabled by the administrator or you do not have 
the right permissions to access it.
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The tab displays the “Set Process Deadline” form: 

5. In the “Set Process Deadline” field, select the Due radio button and then use the date 
picker to select a date. 

When setting a process deadline, you should consider where the asset is in the 
workflow process, and the cumulative time of the remaining steps. The default is to 
have no process deadline.

6. Click Save.

The tab re-displays the asset’s status summary screen.

Setting an Assignment Deadline
An assignment deadline is the time allotted to the assignee to complete an assignment as 
an asset advances through workflow. This deadline is independent of the process deadline 
described earlier in this section; that is, the total of the individual assignment deadlines 
does not necessarily add up to a process deadline. 

Before you can set an assignment deadline, the workflow administrator must first have 
done the following:

• Allowed an assignment deadline to be set for this workflow state.

• Assigned you a workflow administrator role for the workflow process, or otherwise 
provided you with the right function privileges.

The option to set the assignment deadline is available only if both of these conditions are 
met. Contact your administrator to find out if you have the appropriate privileges and 
whether an assignment deadline is allowed for the workflow state in question.

Note

Deadlines are informational only — the system does not impose any sort of penalty 
or issue error messages when a deadline is exceeded.
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To set an assignment deadline

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset for which you want to set an assignment deadline:

a. Access your dashboard by clicking the Home ( ) tab.

b. Navigate to the “Assignments” section of the dashboard.

c. In the list of assets, click the name of the asset for which you want to set an 
assignment deadline.

A tab opens displaying the asset in its Inspect view (in either Form Mode or Web 
Mode).

3. In the menu bar, select View > Status.

4. In the “Workflow commands” drop-down menu, select Set Assignment Deadline.

The tab displays the “Set Assignment Deadline” form:

Note

This procedure describes how to set an assignment deadline from an asset’s Inspect 
view. You can also set an assignment deadline when you complete an assignment for 
an asset. In such case, the “Finish My Assignment” form will include an 
Assignment Deadline field.

Note

If you do not see the Set Assignment Deadline function in the drop-down 
menu, stop here. The function was not enabled by the administrator or you do 
not have the right permissions to access it.
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5. In the “Set Assignment Deadline” field, enter a date using the date picker. The default 
assignment deadline is set by the administrator in the workflow state definition. For 
example, in the FSII: Approval for Content sample workflow, each state has a 
duration of one year from the current date and time.

6. Click Save.

The tab re-displays the asset’s status summary screen.

Finishing Your Assignments
After you complete your work for an assignment, you need to notify the system that you 
are finished so the asset can continue to move through the workflow.

To finish your assignment for an asset

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Access the desired asset’s “Finish My Assignment” form. Do one of the following:

- If you are currently working with the asset:

a. In the menu bar, select View > View Status.

The tab displays the asset’s status summary screen.
b. In the “Workflow commands” drop-down menu, select Finish My 

Assignment.

- If the asset is not already open:

a. Access your dashboard by clicking the Home ( ) tab.

b. Navigate to the “Assignments” section of your dashboard.

c. In the list of assets assigned to you, select the desired asset’s row and then 
click Finish Assignment.
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The “Finish My Assignment” form is displayed.

3. Complete the form as follows:

- If you hold multiple participant roles in the workflow process, in the “Assigned 
User Roles” field, select the role for which you are finishing this assignment.

- (Optional) In the “Action Taken” field, enter a short description of the work you 
completed on the asset.

- (Optional) In the “Action to Take” field, enter a short suggestion for the next 
person who will work with the asset.

- If setting the assignment deadline is enabled for the next step in the workflow 
process, you will see the “Assignment Deadline” field.

If you want to override the time allotted for the next assignment, in the 
“Assignment Deadline” field, select the Due radio button and then use the date 
picker to enter a date. If you do not specify a date, the assignment is due within the 
time determined by the next workflow state.

Note

You can cancel this procedure at any time by clicking either Cancel (next to the 
Finish My Assignment button) or Go Back (in the asset’s toolbar).

Note

This feature appears only if enabled by the workflow administrator.

To set the assignment deadline, you must hold an administrative role in the 
workflow process or otherwise have the right privileges. For more 
information, see “Setting an Assignment Deadline,” on page 248.
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4. Click Finish My Assignment.

5. If the administrator has set up the workflow process in a way that requires you to 
choose assignees for the next step when you finish your assignment, WebCenter Sites 
displays the “Choose Assignees” form:

Select at least one user for each displayed role, then click Set Assignees.

The tab displays the asset’s status summary screen, showing the changes in the 
“Workflow State” and “Workflow history” fields. For more information about these 
fields, see “Examining the Workflow Progress of an Asset,” on page 260.

What happens after you complete your assignment depends on the way the administrator 
set up the next workflow step. There are five possible options:
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• Assign From a List of Participants — when you (or another user with the 
appropriate privileges) assign an asset to a workflow, you have the option to decide 
which participants in each role get the assignment when the asset enters a workflow 
state requiring those roles. This is the default mechanism for moving an asset through 
a workflow.

• Choose Assignees When Step is Taken — this option, described in step 5, is similar 
to the “Assign From a List of Participants” option described earlier, but instead of 
predetermining at the beginning of the workflow who will get the assignment during 
which workflow state(s), you choose assignees for the next workflow state in real-
time each time you take a step.

• Retain “From” State Assignees — you keep the assignment as the asset moves to the 
next state; this allows you to continue working on the asset in that state. You probably 
know why it is appropriate for you to keep the assignment, but if you do not, ask your 
WebCenter Sites or workflow administrator. 

• Assign To Everyone — the asset is assigned to all users holding roles participating in 
the current workflow process.

• No Assignments — as the asset moves to the next state, it remains in the workflow so 
that function privileges defined for the workflow process are enforced. However, the 
asset is assigned to no one and participant roles alone (through their assigned function 
privileges) determine who can work on the asset, and how.

Delegating Your Assignments
As you review your assignment list, you might find that you will be unable to complete 
certain assignments. For example, you might notice that an assignment’s due date falls 
during your scheduled vacation time. In such situations, you can delegate your assignment 
to another user who has the same role as you, assuming that the user does not already have 
an identical assignment for the asset; that is, if both you and another user have the Editor 
role, you cannot delegate the asset to the other user if he/she already has the asset assigned 
through the Editor role. (The asset can still be assigned to the user through a different role 
or another workflow process.) 

To delegate an assignment

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset you wish to delegate to another user:

a. Access your dashboard by clicking the Home ( ) tab.

b. Navigate to the “Assignments” section of the dashboard.

c. In the list of assets, click the name of the desired asset.

A tab opens displaying the asset in its Inspect view (in either Form Mode or Web 
Mode).

3. In the menu bar, select View > Status.
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4. In the “Workflow commands” drop-down menu, select Delegate Assignment.

The tab displays the “Delegate Assignment” form.

5. If you hold a workflow administrator role and multiple users with the same role are 
assigned to this step in the workflow process, the “Assigned to” field displays a drop-
down menu. In the “Assigned to” drop down list, if you are delegating the assignment 
on behalf of another user, select the user who wishes to delegate the assignment. 
Otherwise, select your own user name.

6. In the “Delegate to” field, select the user to whom you want to delegate the 
assignment. 

7. (Optional) In the “Action Taken” field, enter a comment about your action.

8. Click Delegate.

The tab displays the asset’s status summary screen. If the “Workflow History” table is 
not displayed in the field, click the Click here to see Workflow History link. The 
delegation is denoted in the “Task Status” column for the assignment you delegated. 

This action also triggers a notification e-mail to the new assignee, assuming your site 
is configured to do so.

Note

If you do not see the Delegate Assignment function in the drop-down menu, 
stop here. You do not have the right permissions to access the function or there 
are no other users in your role to whom you can delegate your assignment.
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Abstaining from Voting
Sometimes, you are unable to deal with a particular assignment: your workload is too 
heavy, or perhaps you have been miscast in your role. In such situations, you can abstain 
from voting (that is, waive your participation), as long as yours is not the last (or only) 
vote for that particular role and/or step. When you abstain, you still have the assignment, 
but the asset can continue through workflow.

To abstain from voting on an assignment

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset for which you want to abstain from voting:

a. Access your dashboard by clicking the Home ( ) tab.

b. Navigate to the “Assignments” section of the dashboard.

c. In the list of assets, click the name of the asset for which you wish to abstain from 
voting.

A tab opens displaying the asset in its Inspect view (in either Form Mode or Web 
Mode).

3. In the menu bar, select View > Status.

The tab displays the asset’s status summary screen.

4. In the “Workflow commands” drop-down menu, select Abstain From Voting.

The tab displays the “Abstain from voting” form: 
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5. If you hold multiple participant roles in the workflow process, select the role for 
which you are abstaining from voting on this assignment in the “Assigned User Role” 
field.

6. (Optional) In the “Action Taken” field, enter a brief explanation for your abstention 
and click Abstain from Voting.

The tab displays the asset’s status summary screen. The abstention is denoted in the 
“Workflow state” field. Keep in mind that abstaining does not cancel your assignment.

Resolving Deadlocks
A deadlock can occur when there is a choice of steps to move the asset to the next state, 
and each step requires all assignees to vote. If the vote is not unanimous in favor of a 
single step, there is a deadlock.

Frequently, resolving deadlocks involves offline communication and negotiation among 
assignees to achieve consensus; as such, deadlocks cause additional work for everyone 
involved and should be avoided whenever possible. If a deadlock occurs, it should be 
resolved as quickly as possible so that the flow of work suffers minimal delay. 

To resolve a deadlock, certain participants must change their votes to achieve unanimity. If 
you receive an e-mail notification that your vote is the one causing the deadlock, you must 
vote again to break the deadlock.

To resolve a deadlock, do one of the following:

• Vote again on the assignment and select to finish it, as described in “Finishing Your 
Assignments,” on page 250.
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• In some cases, you can also resolve the deadlock by changing your vote to an 
abstention, which clears the way for the asset to move to the next workflow state (see 
“Abstaining from Voting,” on page 255).

Removing an Asset from Workflow
You can remove an asset from workflow assuming you have the permissions to do so. 
When you remove an asset from workflow, all assignments for the asset are cancelled.

To remove an asset from workflow

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset you wish to remove from workflow:

a. Access your dashboard by clicking the Home ( ) tab.

b. Navigate to the “Assignments” section of the dashboard.

c. In the list of assets, click the name of the desired asset.

A tab opens displaying the asset in its Inspect view (in either Form Mode or Web 
Mode).

3. In the menu bar, select View > Status.

The tab displays the asset’s status summary screen.

4. In the “Workflow commands” drop-down menu, select Remove from Workflow.

The tab displays the “Remove from Workflow” form:

5. If you are sure you want to remove the asset from workflow, click Remove From 
Workflow. (Otherwise, click Cancel.)

The tab re-displays the asset’s summary screen. The “Workflow process” field denotes 
the removal. All assignments for the asset are automatically cancelled.
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Viewing an Asset's Participant (Assignee) List
To examine an asset’s participant (assignee) list 

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset whose participant list you wish to view:

a. Access your dashboard by clicking the Home ( ) tab.

b. Navigate to the “Assignments” section of the dashboard.

c. In the list of assets, click the name of the desired asset.

A tab opens displaying the asset in its Inspect view (in either Form Mode or Web 
Mode).

3. In the menu bar, select View > Status.

4. In the “Workflow commands” drop-down menu, select Show Participants.   

The tab displays the “Show Participants” summary screen:

For each step in the workflow process, the “Show Participants” summary displays the 
following:

- Step – steps involved in the current workflow process for the asset.

- Users Authorized – users authorized to take the next step in the workflow 
process when they hold the assignment for the asset.

- Users Notified – users who will get the next assignment for the asset.

5. When you are finished viewing the list, click the Go Back ( ) icon in the asset’s 
toolbar to return to the asset’s Inspect view.

Note

If you do not see the Show Participants function in the drop-down menu, stop 
here. The administrator has not enabled the function or you do not have the right 
permissions to access it.
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Setting Workflow Participants
Once you have placed an asset in a workflow and chosen the assignees for each role in the 
workflow process, you might find that you forgot to include a certain user as an assignee 
for a particular role. Or perhaps you realized that you gave the assignment to a certain user 
by mistake. In such cases, you can modify the list of participants for an asset while the 
asset is in workflow.

To set workflow participants

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset for which you want to set participants:

a. Access your dashboard by clicking the Home ( ) tab.

b. Navigate to the “Assignments” section of the dashboard.

c. In the list of assets, click the name of the desired asset.

A tab opens displaying the asset in its Inspect view (in either Form Mode or Web 
Mode).

3. In the menu bar, select View > Status.

The tab displays the asset’s status summary screen.

4. In the “Workflow commands” drop-down menu, select Set Participants.

The tab displays the “Set Participants” form: 

Note

If you do not see the Set Participants function in the drop-down menu, stop 
here. The administrator has not enabled the function or you do not have the right 
permissions to access it.
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Each participant you select in this form becomes an assignee in the respective role(s) 
for this asset.

5. Choose the desired assignees for this assignment by selecting the names of the users in 
each of the role lists.

6. When you have selected the desired assignees, click Set Participants.

The tab displays the asset’s status summary screen. The newly selected assignees are 
denoted in the “Workflow state” field.

Examining the Workflow Progress of an Asset
To examine the workflow progress of an asset

1. Log in to WebCenter Sites, select the site you want to work with and the icon for the 
WebCenter Sites Contributor interface.

2. Find and open the asset whose workflow progress you want to view:

a. Access your dashboard by clicking the Home ( ) tab.

b. Navigate to the “Assignments” section of the dashboard.

c. In the list of assets, click the name of the desired asset.

A tab opens displaying the asset in its Inspect view (in either Form Mode or Web 
Mode).

3. In the menu bar, select View > Status.

The tab displays the asset’s status summary screen.

Note

The participants list updates as the asset passes through each step in the 
workflow process. However, added users get the assignment only if the 
workflow state assigned to their role has not yet been reached.
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4. Navigate to the fields containing the asset’s workflow summary:

- The Workflow process field indicates the workflow process which the asset is 
currently passing through.

- The Workflow state field displays a table that indicates where the asset currently 
is in the workflow process and to whom the asset is currently assigned.

- The Workflow history field displays a table that shows the assignments 
completed on the asset so far, and the result of each assignment. Each row in the 
list represents a single assignment. Items are ordered with the most recently 
completed assignment at the top of the list.  

If you do not see the “Workflow history” table, click the Click here to see 
Workflow History link to display the table.
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Table 6 (below) defines all of the columns in the “Status” and “Workflow history” 
lists.

Table 6: Workflow summary list columns

Column  Definition

Assigned To The user name(s) of the assignee(s) for each assignment. Note that 
the user’s role appears in parentheses following the user name.

Assigned By The user name of the assignee who finished working with the asset 
and assigned it to the next participant. In the “Workflow history” 
list, the very first entry in this column (at the bottom of the list) 
shows the user name of the person who assigned the asset to the 
workflow process.

Assigned Date The date and time the asset was assigned to the user.

Action to Take Instructions from the user who assigned the asset, assuming that 
person entered instructions in the “Finish Assignment” form when 
they finished their assignment (see page 250). If the text is longer 
than the width of the column, click the text to view its entirety.

Step Chosen The step indicated by the user who completed the assignment, when 
there is a choice of next step in the “Finish Assignment” form. 

Action Taken Information about the work this user did with the asset (if 
information was entered on the form). If the text is longer than the 
width of the column, click the text to view its entirety.

Resolved By The person whose action moved the asset to the next state.

Resolution Date The date and time the action was taken to move the asset to the next 
state.

Task Status The status of the assignment. Possible values are as follows:

• Abstain - the assignee has abstained from voting.

• Active - the asset is currently assigned to someone.

• Cancelled - the first vote moved the asset to the next state, so the 
assignment has been cancelled for the other assignees, or the 
asset has been removed from workflow.

• Completed - the assignee has completed the step.

• Delegated - the assignment has been delegated to another user in 
the same role.

• Queued - the asset has multiple assignees for the current state, 
the next step is all-voting, and not everyone has voted yet. (Also 
appears if the asset is deadlocked.)
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Par t  3

Using Oracle WebCenter Sites: Engage
Assets
This part describes tasks and responsibilities performed by marketers who want to target 
site visitors for marketing campaigns using Engage assets.

This part contains the following chapters:

• Chapter 15, “Oracle WebCenter Sites: Engage Overview”

• Chapter 16, “Grouping Visitors into Segments”

• Chapter 17, “Creating and Configuring Recommendations”

• Chapter 18, “Creating Promotions”
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Chapter 15

Oracle WebCenter Sites: Engage Overview
With WebCenter Sites, you can use the flex asset model to create an online catalog 
offering products and content for sale. If you want to divide your market into segments 
that define specific groups of customers and then target those segments with personalized 
promotional or marketing messages, the solution is Engage.

Engage is installed with WebCenter Sites. Engage adds merchandising features to 
WebCenter Sites and extends the XML and JSP object methods available for 
programming your e-commerce site. It enables you to design websites that gather 
information about your site visitors and customers, evaluate that information, and then use 
that information to personalize the product placements and promotional offerings that are 
displayed for each visitor.

This chapter contains the following sections:

• About Merchandising Assets

• Using Segments to Categorize Visitors

• Making Recommendations to Segmented Visitors

• Basing Promotions on Buying Patterns
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About Merchandising Assets
With Engage, you use merchandising assets to do the following:

• Collect visitor data using the “Visitor Attribute,” “History Attribute,” and “History 
Definition” assets 

• Use that visitor data to define visitor segments (using “Segment” assets) 

• Recommend products and content to visitors based on the segments they belong to 
(using “Recommendation” assets)

• Run promotions that apply to all or specific segments (“Promotion” assets) 

Developers and administrators create and manage the visitor data and underlying business 
logic, while marketers create and manage the “Segment,” “Recommendation,” and 
“Promotion” assets. As with any of the other Sites applications, you create and work with 
assets on the management site. Then, when assets are approved, you publish them to your 
delivery site.

Marketers and developers are expected to collaborate extensively to implement effective 
merchandising efforts.

Using Segments to Categorize Visitors
Segments are assets that categorize groups of visitors based on the visitor data that you are 
gathering about them. You build segments by determining which kinds of visitor data to 
use as filtering criteria and then setting the values that qualify or disqualify a visitor for the 
segment.

You use the “Segment Filtering” forms in Engage to categorize groups of visitors based on 
the visitor attributes, history attributes, and history definitions created by the developers.

Segments are the key to personalization with Engage. When visitors browse your site, the 
information they submit is used to qualify them for segment membership. When the site 
displays a page with a recommendation or promotion, Engage determines which segments 
a visitor belongs to and displays the product recommendations or promotional messages 
that are designated for those segments.

For detailed information on segments, see Chapter 16, “Grouping Visitors into Segments.”

Making Recommendations to Segmented Visitors
You create “Recommendation” assets and then configure them by rating assets based on 
their importance to the segments that you have created. 

Recommendations are assets that determine which products or content should be featured 
or “recommended” on a site page. These assets are rules that are based on the segments the 
visitors qualify for, and, in some cases, relationships between the product or content 
assets.

Recommendations have templates. A recommendation returns a list of assets to its 
template when the template is rendered on a site page. The items in a list of recommended 
assets are rated according to their importance to the current visitor based on the segments 
that the visitor belongs to.
Oracle WebCenter Sites User’s Guide



Chapter 15.  Oracle WebCenter Sites: Engage Overview

Basing Promotions on Buying Patterns
267
For detailed information on recommendations, see Chapter 17, “Creating and Configuring 
Recommendations.”

Basing Promotions on Buying Patterns
Promotions are assets that define an offer of value (a discount) to the visitors based on the 
products that the visitor is buying and the segments that the visitor qualifies for. This value 
can be offered in several ways: 

• A discount off the purchase price of the promoted products 

• A discount off the entire value of the shopping cart 

• A discount off shipping charges 

• A combination discount: a shipping discount with a price or cart discount 

Promotions use the same templates as recommendations. You decide which 
recommendation the promotion overrides, and Engage uses that recommendation’s 
template to render the promotion on the site page.

For detailed information on segments, see Chapter 18, “Creating Promotions.”
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Chapter 16

Grouping Visitors into Segments
Segments are assets that categorize visitors into groups on the basis of visitor data that you 
gather. You build segments by determining which kinds of visitor data to use as filtering 
criteria and then setting values that qualify or disqualify a visitor for the segment.

This chapter describes segments and presents procedures for creating them. It includes the 
following sections:

• About Segments

• About the Segment Forms

• Creating Segments

• Sample Segment Assets

• Publishing Segments

• After You Publish
Oracle WebCenter Sites User’s Guide



Chapter 16.  Grouping Visitors into Segments

About Segments
270
About Segments
Segments are used to create recommendations and promotions. The segments determine 
which content in the recommendations and promotions visitors qualify for and display that 
content to the visitors.

Segments are the key to personalization and merchandising with Engage. You, as a 
marketer, create the visitor segments that the site pages depend on because you know 
which merchandising messages should be associated with specific visitor segments.

When you create a segment, you specify filtering criteria that a visitor must match in order 
to be included as a member of that segment. This is comparable to when database or site 
administrators create a database query, and they specify parameters that a database record 
must match in order to be included in the results of the query.

Segments and Visitor Data Assets
You build segments by using the visitor data assets as filtering criteria. There are three 
kinds of visitor data assets: visitor attributes, history attributes, and history definitions.

• Visitor attributes hold types of information that specify one characteristic only. For 
example, there can be attributes named years of experience, job description, or 
number of children.

When visitors change the data, the new data overwrites the old. For example, if a 
visitor changes her job description from analyst to marketing specialist, there is no 
record of the fact that the visitor used to be an analyst.

• History attributes are individual information types that you group together to create 
a single type of historical record.

• This historical record is a history definition. For example, a history definition called 
purchases could be made up of the history attributes SKU #, itemname, quantity, and 
price.

Engage treats the data recorded as a history definition as a whole unit of information. 
It assigns a timestamp to and stores each instance of the data, which means that you 
can create segments based on counts or sums of history definitions.

Developers create the visitor data assets based on the kinds of information that the 
marketing and design teams want to collect and analyze. You and the other marketers can 
use those assets to create segments that categorize your visitors, and the developers 
program your site pages to collect and store visitor information.

Developing Segments: Process Overview
There are five general steps for creating segments:

1. Planning. A cross-functional design team including developers and marketers 
determines the data you want to gather about your site visitors.

2. Creating visitor data assets. The developers create and define the necessary visitor 
attributes, history attributes, and history definitions using the forms in Engage.

3. Creating segments. You (the marketers) use the “Segment” forms in Engage to 
categorize visitors on the basis of visitor attributes, history attributes, and history 
definitions.
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4. Collecting visitor data. The developers program the appropriate site pages to collect 
and store visitor data. For example, they might create an online registration form for 
visitors to fill out with information that qualifies them for segments. When visitors 
browse your site, the information they submit is stored in the Sites database. 

5. Segmenting visitors. Now when visitors browse your site, the information they 
submit is used to qualify them for segment membership. The promotional messages 
and recommended products are personalized based on the segments that visitors 
qualify for.

About the Segment Forms
You will use two forms when creating segments, the “Segment Filtering Criteria” form 
and the “Segment Definition” form. This section describes these forms.

“Segment Filtering Criteria” Form
The “Segment Filtering Criteria” form displays the visitor data assets that you can use to 
create segments. In this form you select the criteria that will define your segment.

Categories
The visitor data assets in the “Segment Filtering Criteria” form are organized within 
categories that are listed across the top of the form. For example:

When you click a category, the form displays the visitor attributes or the history 
definitions in that category.

Because visitor data assets are so varied, developers assign them to categories to organize 
them. (Developers create categories when they define visitor data assets.) The Profile 
category, for example, details visitor attributes such as age and income, that are related to 
personal information about the visitors.

Note

The actual categories of visitor data assets will likely differ for your installation, 
depending on the installation options and what your developers have defined. See 
your developers if you need information about categories or visitor data assets.
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The “Shopping Cart” Form
“Shopping Cart” is listed with the categories on the segment filter forms but the shopping 
cart is a special, default feature rather than a category of attributes.

You can use the “Shopping Cart” form to create segments based on the following kinds of 
conditions:

• The total value of all the products in the shopping cart

• Whether a specific product is in the shopping cart

• Whether a certain number of products are in the shopping cart

• Whether a certain number of specific products is in the shopping cart

If you want to implement a promotion based on the current state of a visitor’s shopping 
cart, use this form to build a segment and then use the segment in the promotion.

The “Shopping Cart” form is always available for defining your segments. Therefore, 
even before your site developers create visitor attributes or history definitions, you can 
create segments defined by shopping cart information.
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The “Segment Definition” Form
While you’re creating a segment, Engage displays each condition (criterion) that you add 
to the segment in a form similar to the following: 

As you add criteria to a row (across the table), you create a more inclusive segment. In the 
preceding form, the visitor can be one who spent over $50 or made a purchase since June 
15, 2011 or both to be included in the segment. In other words, you add more factors that 
can qualify a visitor for a segment by working across the table, adding criteria to the same 
row.
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As you add criteria to a column (down the table), you create a more restrictive segment. In 
the following example, a visitor belongs to the segment only if both the criteria are true:

The visitor must have previously spent over $100 in a purchase and be between the ages of 
35 and 39 to belong to the segment. In other words, you add restrictions to a segment by 
working down the form, adding them to the column.

In summary, segments broaden as you add criteria across the table and narrow as you add 
criteria down the table.
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Creating Segments
Before you create segments, be sure the following tasks have been completed:

• The marketing, design, and development teams met to determine the kinds of data that 
you want to collect about your visitors.

• The developers created the visitor attributes, history attributes, and history definitions 
that the cross-functional team decided are necessary.

• You (the marketers) obtained a list or overview of the visitor data assets that were 
created and you understand what they mean and how they are categorized.

Step 1: Name and Define the Segment
1. Log in to WebCenter Sites, select the site you want to work with (FirstSite II in this 

example) and the icon for the WebCenter Sites Contributor interface.

2. In the menu bar, select Content > New > New Segment.

a. If the administrator configured the asset type such that all new assets of that type 
are placed into workflow upon creation, a tab opens displaying the “Choose 
Assignees” 

Select at least one user for each required role and click Set Assignees. Any of 
these users can complete the next step in the workflow process. For more 
information, see Chapter 14, “Workflow.”

b. If the Create view of the “Segment” asset is displayed in Web Mode, switch to 
Form Mode by clicking the Mode switch in the asset’s toolbar.

Note

If New Segment does not appear in the “New” form, stop here. You do not have 
the permissions to create segments. Consult your administrator for more 
information on your permissions.
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The tab displays the “Segment” asset’s Create view in Form Mode:

3. In the Name field, enter a unique, descriptive name for the segment. You can enter up 
to 64 alphanumeric characters, including spaces. The first character must be a letter.

4. In the Description field, enter a brief description of the segment. You can enter up to 
128 alphanumeric characters.

5. (Optional) Assign a start and/or end date to the segment asset. For more information 
about start and end dates, see “Assigning Start and End Dates,” on page 147.

6. Click Continue.

The tab displays the “Segment Filtering Criteria” form. The categories of visitor 
attributes and history definitions you can use to build your segment are listed across 
the top of the form.
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Note that filtering on text strings is case-sensitive unless it is explicitly set not to be so.

7. Do one of the following:

- If you want to create a segment based on buyer contact information, go to 
“Step 2: Create Segment Filtering Criteria with Visitor Attributes,” on page 277.

- If you want to create a segment based on the user profile, go to “Step 2: Create 
Segment Filtering Criteria with Visitor Attributes,” on page 277.

- If you want to create a segment based on buyer history, go to  Step 3: Create 
Segment Filtering Criteria with History Definitions.

- If you want to create a segment based on a history definition, go to  Step 3: Create 
Segment Filtering Criteria with History Definitions.

- If you want to create a segment based on the shopping cart, go to  Step 4: Define 
the Segment with Shopping Cart Criteria.

Step 2: Create Segment Filtering Criteria with Visitor Attributes
1. In the “Segment Filtering Criteria” form, click the Profile category.

Engage displays a list of the attributes in the category.

2. Click the name of the attribute that you want to use to define the segment.

The form displays constraint fields that are meaningful for that attribute.

3. Use the form to set the attribute values that include a visitor in the segment or exclude 
a visitor from the segment.

For example, if the attribute is “Age” and you want to include people between the ages 
of 20 and 24, set the values as follows:

To exclude people who are in that age range, set the values as follows:

4. Click Add This Criterion.
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The criterion is added to the segment.

5. Do one of the following:

- If you are finished creating this segment, in the asset’s toolbar, click the 
Save ( ) icon.

- To add another criterion to the segment, continue this procedure.

6. Do one of the following:

- To add another criterion that qualifies a visitor for this segment, select a category 
name from the drop-down list to the right (in the same row) of the criterion that 
you just added, and click Include Others.

- To add more restrictions to the segment, select a category name from the drop-
down list under (in the next row) the criterion that you just added, and click 
Restrict Further.

7. Do one of the following:

- If you selected a visitor attribute category, go back to step 2 of this procedure.

- If you selected a history definition category, go to  Step 3: Create Segment 
Filtering Criteria with History Definitions.

- If you selected Shopping Cart, go to  Step 4: Define the Segment with Shopping 
Cart Criteria.
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Step 3: Create Segment Filtering Criteria with History Definitions
1. In the “Segment Filtering Criteria” form, click a category for a history definition 

(Buyer history in this example).

The “Segment Filtering Criteria” form for history definitions is displayed. It shows the 
first history definition in the category. For example:

It has three general areas that you use to restrict or filter items:

- The options area at the top of the form

- The time restriction area on the lower left of the form
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- The history attribute restriction area on the lower right of the form. This section 
lists the history attributes that define the history definition.

2. Use one or more of the following options to create simple or complex criteria by using 
all three areas in the “Segment Filtering Criteria” form to restrict or filter one item.

Option 1: Filtering Based on a Total
You can define the segment based on a total, such as the total amount spent, a total price, 
or a total number of items.

For example, a site developer could create a history definition named Buyer history, 
which would be a historical record of purchases made by site visitors. One of the history 
attributes in this definition could be number of items. Using this history definition, a 
marketer could create a segment based on the total number of items purchased by site 
visitors.

To define a segment based on a total, complete the following steps:

1. At the top of the form, select the Total option, and set the values that include a visitor 
in the segment or exclude a visitor from the segment. 

For instance, the example history definition could be set to include visitors who have 
purchased 10 items or more:

2. Under Restrict to a specific time period, specify the time period to use for the total.

For example, to include visitors who bought the specified number of items during the 
last six months, the time option values for the Buyer history history definition could 
be set as follows:

Note

To use a different history definition from the one displayed in the form, 
select one from the Additional Criteria list at the bottom of the form.
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To include visitors who bought the specified number of items on a specific day—
perhaps a holiday—the values could be set as follows:

3. (Optional) To further restrict this criterion by adding a history attribute to it, go to 
Option 5: Adding a History Attribute to Further Define the Segment.

4. Click Add This Criterion. The criterion is added to the segment.

5. Do one of the following:

- If you are finished creating this segment, in the asset’s toolbar, click the 
Save ( ) icon.
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- To add another criterion to the segment, continue this procedure.

6. Do one of the following:

- To add another criterion that qualifies a visitor for this segment, select a category 
name from the drop-down list to the right (in the same row) of the criterion that 
you just added, and click Include Others.

- To add more restrictions to the segment, select a category name from the 
drop-down list under (in the next row) the criterion that you just added, and click 
Restrict Further.

7. Do one of the following:

- If you selected a visitor attribute category, go to Step 2: Create Segment Filtering 
Criteria with Visitor Attributes

- If you selected a history definition category, go to Step 3: Create Segment 
Filtering Criteria with History Definitions

- If you selected Shopping Cart, go to Step 4: Define the Segment with Shopping 
Cart Criteria

Option 2: Filtering Based on a Count
You can define the segment based on the total number of times this history definition was 
recorded for a visitor.

For instance, using the Buyer history history definition described in Option 1: Filtering 
Based on a Total, a marketer could define a segment based on the number of times 
Buyer history was recorded for a visitor. The effect of this criterion is that Engage would 
consider how many times a visitor purchased anything instead of considering what they 
bought or how much they spent.

To define a segment based on a count, complete the following steps:

1. Select the Count option at the top of the form and then set the values that include a 
visitor in the segment or exclude a visitor from the segment.

For example, the Buyer history history definition could be set to include visitors who 
have purchased something (anything) at least five times:

2. Under Restrict to a specific time period, specify the time period to use for the count.

For example, to include visitors who bought during the last six months, the time 
option values for the Buyer history history definition could be set as follows:
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To include visitors who bought something on a specific day or period of days—
perhaps a particular promotional period—the values could be set as follows:

3. (Optional) If you want to further restrict this criterion by adding a history attribute to 
it, go to Option 5: Adding a History Attribute to Further Define the Segment

4. Click Add This Criterion.

The criterion is added to the segment.

5. Do one of the following:

- If you are finished creating this segment, click the Save ( ) icon.

- To add another criterion to the segment, continue this procedure.

6. Do one of the following:

- To add another criterion that qualifies a visitor for this segment, select a category 
name from the drop-down list to the right (in the same row) of the criterion that 
you just added, and click Include Others.
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- To add more restrictions to the segment, select a category name from the 
drop-down list under (in the next row) the criterion that you just added, and click 
Restrict Further.

7. Do one of the following:

- If you selected a visitor attribute category, go to Step 2: Create Segment Filtering 
Criteria with Visitor Attributes.

- If you selected a history definition category, go to Step 3: Create Segment 
Filtering Criteria with History Definitions

- If you selected Shopping Cart, go to Step 4: Define the Segment with Shopping 
Cart Criteria.

Option 3: Filtering Based on the First Time a History 
Definition Was Recorded
You can define the segment based on the first time the history record was recorded for 
visitors.

For instance, using the Buyer history history definition described in Option 1: Filtering 
Based on a Total a marketer could define a segment based on the first time the visitor 
purchased something—in other words, the first time a Buyer history record was recorded 
for the visitor.

To define the segment based on the first time the definition was recorded, complete the 
following steps:

1. Select the Earliest date recorded option at the top of the form and then set the values 
that include a visitor in the segment or exclude a visitor from the segment.

For example, the Buyer history history definition could be set to include visitors who 
purchased something on or before January 1, 2012:

2. Under Restrict to a specific time period, specify the time period to use for this 
condition.

For example, if a marketer wanted to include visitors who purchased something on or 
before a specific date (in this example, January 1, 2007) but did not want to include 
them if the date of that purchase was more than two years ago, the Buyer history time 
values could be set as follows:

3. (Optional) If you want to further restrict this criterion by adding a history attribute to 
it, go to Option 5: Adding a History Attribute to Further Define the Segment.

4. Click Add This Criterion.
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The criterion is added to the segment.

5. Do one of the following:

- If you are finished creating this segment, click the Save ( ) icon.

- To add another criterion to the segment, continue this procedure.

6. Do one of the following:

- To add another criterion that qualifies a visitor for this segment, select a category 
name from the drop-down list to the right (in the same row) of the criterion that 
you just added, and click Include Others.

- To add more restrictions to the segment, select a category name from the drop-
down list under (in the next row) the criterion that you just added, and click 
Restrict Further.

7. Do one of the following:

- If you selected a visitor attribute category, go to Step 2: Create Segment Filtering 
Criteria with Visitor Attributes.

- If you selected a history definition category, go to Step 3: Create Segment 
Filtering Criteria with History Definitions.

- If you selected Shopping Cart, go to Step 4: Define the Segment with Shopping 
Cart Criteria.

Option 4: Filtering Based on the Last Time a History 
Definition Was Recorded
You can define the segment based on the last time (the most recent time) the history 
definition was recorded for a visitor.

For instance, using the Buyer history history definition described in Option 1: Filtering 
Based on a Total a marketer could define a segment based on the most recent time the 
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visitor purchased something—in other words, the last time a Buyer history record was 
recorded for the visitor.

To define the segment based on the last time the history definition was recorded, complete 
the following steps:

1. Select the Latest date recorded option at the top of the form and then set the values 
that include a visitor in the segment or exclude a visitor from the segment. 

For example, to include visitors who have purchased something since January 1, 2012, 
the Buyer history values could be set as follows:

2. Under Restrict to a specific time period, specify the time period to use for this 
condition (Overall in our example).

3. (Optional) If you want to further restrict this criterion by adding a history attribute to 
it, go to Option 5: Adding a History Attribute to Further Define the Segment. 

4. Click Add This Criterion.

The criterion is added to the segment. For example:

5. Do one of the following:

- If you are finished creating this segment, click the Save ( ) icon.

- To add another criterion to the segment, continue this procedure.

6. Do one of the following:

- To add another criterion that qualifies a visitor for this segment, select a category 
name from the drop-down list to the right (in the same row) of the criterion that 
you just added, and click Include Others.
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- To add more restrictions to the segment, select a category name from the 
drop-down list under (in the next row) the criterion that you just added, and click 
Restrict Further.

7. Do one of the following:

- If you selected a visitor attribute category, go to Step 2: Create Segment Filtering 
Criteria with Visitor Attributes.

- If you selected a history definition category, go to Step 3: Create Segment 
Filtering Criteria with History Definitions.

- If you selected Shopping Cart, go to Step 4: Define the Segment with Shopping 
Cart Criteria.

Option 5: Adding a History Attribute to Further Define the 
Segment
You can add a history attribute to create a more complex segment—one that further 
restricts the count, total, first, or last record by taking a specific attribute into 
consideration.

To add a history attribute to further define the segment, complete the following steps:

1. Select and configure one of the four options at the top of the form (Count, Total, 
Earliest date recorded, or Latest date recorded). If you need help with this step, go 
to one of the following procedures:

- Option 1: Filtering Based on a Total

- Option 2: Filtering Based on a Count

- Option 3: Filtering Based on the First Time a History Definition Was Recorded

- Option 4: Filtering Based on the Last Time a History Definition Was Recorded

2. Under History Attributes (on the right side of the Buyer history form), select the 
Values for selected attributes option.

3. Under the attribute list for this history definition, click the history attribute that you 
want to use as a filter. Typically this list will include items such as Product list, 
Store ID, Number of items, and Amount of sales.

The form displays constraint fields that are meaningful for that attribute. Clicking 
more than one attribute, or an attribute more than once, will display constraint fields 
for each time an attribute is clicked.

4. Use the constraint fields to set the attribute values that further constrain the criterion. 
For example:

5. Under Restrict to a specific time period, specify the time period to use for this 
condition.

6. Click Add This Criterion.

The criterion is added to the segment.
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7. Do one of the following:

- If you are finished creating this segment, click the Save ( ) icon.

- To add another criterion to the segment, continue this procedure.

8. Do one of the following:

- To add another criterion that qualifies a visitor for this segment, select a category 
name from the drop-down list to the right (in the same row) of the criterion that 
you just added, and click Include Others.

- To add more restrictions to the segment, select a category name from the 
drop-down list under (in the next row) the criterion that you just added, and click 
Restrict Further.

9. Do one of the following:

- If you selected a visitor attribute category, go to Step 2: Create Segment Filtering 
Criteria with Visitor Attributes.

- If you selected a history definition category, go to Step 3: Create Segment 
Filtering Criteria with History Definitions.

- If you selected Shopping Cart, go to Step 4: Define the Segment with Shopping 
Cart Criteria.

Option 6: Adding Products to Further Define the Segment
You can add products to create a more complex segment—one that further restricts the 
count, total, first, or last record by taking specific products into consideration—if the 
history definition that you use to define this segment has a product list history attribute.

To add a product to the segment definition, complete the following steps:

1. Select and configure one of the four options at the top of the form (Count, Total, 
Earliest, or Latest). If you need help with this step, go to one of the following 
procedures:

- Option 1: Filtering Based on a Total

- Option 2: Filtering Based on a Count

- Option 3: Filtering Based on the First Time a History Definition Was Recorded

- Option 4: Filtering Based on the Last Time a History Definition Was Recorded

2. Under History Attributes (on the right side of the Buyer history form), select the 
Values for selected attributes option.

3. Under the attribute list, select Product list.

The form displays a Browse button. Click Browse to open a new window to select 
assets. This new window allows you to find assets in four screens: “Search,” 
“Bookmarks,” “History,” and “My Assignments.”

4. In the window, select the assets to include in the product list.
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This image shows assets of type “Product” as found on the “Search” screen.

5. Select the checkbox for each product that you want to select. 

6. Click Select.

The window closes and the products you selected are displayed in the “Buyer history” 
screen. For example:

7. Under Restrict to a specific time period, specify the time period to use for this 
criterion.
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8. Click Add This Criterion.

The criterion is added the segment.

9. Do one of the following:

- If you are finished creating this segment, click the Save ( ) icon.

- To add another criterion to the segment, continue this procedure.

10. Do one of the following:

- To add another criterion that qualifies a visitor for this segment, select a category 
name from the drop-down list to the right (in the same row) of the criterion that 
you just added, and click Include Others.

- To add more restrictions to the segment, select a category name from the 
drop-down list under (in the next row) the criterion that you just added, and click 
Restrict Further.

11. Do one of the following:

- If you selected a visitor attribute category, go to Step 2: Create Segment Filtering 
Criteria with Visitor Attributes.

- If you selected a history definition category, go to Step 3: Create Segment 
Filtering Criteria with History Definitions.

- If you selected Shopping Cart, go to Step 4: Define the Segment with Shopping 
Cart Criteria.

Step 4: Define the Segment with Shopping Cart Criteria
1. In the “Segment Filtering Criteria” form, click the Shopping Cart category.

Engage displays the “Shopping Cart” section of the “Segment Filtering Criteria” form:
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2. Do one of the following:

- To define this segment based on the total value of the items in a visitor’s shopping 
cart, select the first option and then set the values. For example, to include visitors 
who have at least $50 worth of products in their carts, set the values as follows:

- To define this segment based on the total number of items in the visitor’s shopping 
cart, select the second option and then set the values. For example, to include 
visitors who have three or more items in their carts, set the values as follows:

3. To restrict the item count or cart value to specific products in the catalog:

a. Select Restrict to specific items from the tree or search.

b. In the tree, select the Product tab.

c. Drag and drop the product that you want to select into the Drop Zone.

d. In the “Segment Filtering” form, click Add Selected Items.

4. Click Add This Criterion.

The shopping cart criterion is added to the segment.

5. Do one of the following:

- If you are finished creating this segment, click the Save ( ) icon.

- To add another criterion to the segment, continue this procedure.
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6. Do one of the following:

- To add another criterion that qualifies a visitor for this segment, select a category 
name from the drop-down list to the right (in the same row) of the criterion that 
you just added, and click Include Others.

- To add more restrictions to the segment, select a category name from the 
drop-down list under (in the next row) the criterion that you just added, and click 
Restrict Further.

7. Do one of the following:

- If you selected Shopping Cart, return to step 2 in this procedure.

- If you selected a visitor attribute category, go to Step 2: Create Segment Filtering 
Criteria with Visitor Attributes.

- If you selected a history definition category, go to Step 3: Create Segment 
Filtering Criteria with History Definitions.

Sample Segment Assets
If you have installed the sample sites, the FirstSite II sample site comes with one sample 
segment asset: AffluentYoungSingles. This segment is designed to work in concert with 
the sample “Recommendation” and “Promotion” assets. Use these sample segments as 
templates for creating segment assets for your site.

Publishing Segments
When your segments are ready, you must approve them so they can be published to your 
delivery system. Engage can then use the segments to assess visitors and recommend the 
appropriate items to them.

Be sure to examine or inspect your segments to verify that you configured them correctly 
before approving them for publishing. 

For more information about approving and publishing assets, see Chapter 12, “Approval 
for Publishing.”

After You Publish
After you have created, verified, and published the segments, you must assign ratings to 
the products and content that are significant to members of each segment. For details, see 
Chapter 17, “Creating and Configuring Recommendations.”

You can also create promotions after you have created segments. For more information, 
see Chapter 18, “Creating Promotions.”
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Chapter 17

Creating and Configuring Recommendations
Recommendations are assets that determine which assets are featured or “recommended” 
on a site page. Recommendations calculate which assets to recommend based on the 
segments the visitors qualify for, and, in some cases, context-based relationships between 
assets (for example, movies related to each other by genre).

After you create the “Recommendation” assets, (typically, marketing people create 
“Recommendation” assets), you configure them by rating their child assets based on their 
importance to the segments that visitors qualify for. Assets are recommended (or are not 
recommended) based on those ratings. Additionally, the Related Items recommendation 
defines relationships between assets that allow for cross- or up-selling items according to 
how those items are related to one another. You determine which assets have those 
relationships.

This chapter contains the following sections:

• Recommendation Assets

• Asset Selection Factors

• Creating Recommendation Assets

• Editing Recommendation Assets

• Configuring Assets to Be Recommended

• Configuring Asset Relationships Using Related Items Recommendations

• Verifying Recommendation Assets

• Publishing Rated Flex Assets
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Recommendation Assets
A “Recommendation” asset collects, assesses, and sorts assets, and then recommends the 
most appropriate of these assets to the current visitor. How does it determine which assets 
are the most appropriate? By consulting the list of segments that the visitor belongs to and 
any confidence set in the recommendation for each asset. (For information about 
confidence, see “Confidence,” on page 298.)

You create segments and then rate the flex assets for their importance to each segment. 
When a “Recommendation” asset is invoked from a site page, Engage determines which 
segments the current visitor qualifies for, and then selects the assets that are identified by 
the recommendation to have the highest rating for those segments. These are the assets 
that are recommended to the visitor.

Engage provides the following types of recommendations:

• Static Lists – operates in two modes, List and Recommendation:

- In List mode, a Static Lists recommendation holds and returns a single static, 
preselected list of assets regardless of segments (or whether segments apply at 
all). Confidence values are automatically assigned to assets on the list based on 
their position on the list; the first asset receives a confidence value of 100%, the 
next one 99%, and so on, in descending order.

- In Recommendation mode, a Static Lists recommendation holds and returns static, 
preselected lists of recommended assets when the visitor qualifies for segments 
defined in the recommendation, and also when no segments apply.

When a template invokes the recommendation, the recommendation returns the 
assets on the static lists. For each asset that you add to a segment’s static list, you 
can assign a confidence value for In Segment and Out of Segment ratings. (A 
variant of this type of recommendation was formerly known as “manual.”)

You create a static lists recommendation by selecting assets from your bookmarks and 
adding them to each segment’s list (recommendation mode) or the common list (list 
mode). Because this is a static lists recommendation, the assets in the list(s) remain the 
same until you change them (or delete them from the database).

• Dynamic Lists – references a special asset called a “CSElement” asset, which your 
developers have coded as a type of program known as an element. When a template 
invokes the Dynamic Lists recommendation, it executes the element, which returns a 
list based on the conditions defined in the element. For example, you could create a 
recommendation named “New Products” whose referenced element selects only those 
“Product” assets that have been added to the database in the past five days.

You create a Dynamic Lists recommendation by selecting a “CSElement” asset 
(which contains the logic for generating the list) in the tree. You can then test the 
selected element by displaying the current list results.

As its name implies, this type of recommendation is dynamic: each time it is invoked 
by a template, the recommendation executes the element, which regenerates the list, 
based on the current state of the database.

• Related Items – holds the name of a relationship between flex assets that are related 
to one another based on context (for example, similarly themed movies). When a 
template invokes a Related Items recommendation, assets are returned 
(recommended) only if they are manually configured to have the relationship named 
by the recommendation with the asset that is currently displayed on the page.
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Typical relationships between assets are cross-sell and up-sell relationships. For 
example, a Related Items recommendation named “Cross-Sell” displays a list of 
science fiction movies on rendered pages that display suspense movies because the 
marketers determined that people who buy science fiction movies also buy suspense 
movies.

You create a Related Items recommendation by naming it and specifying that it is a 
Related Items recommendation. You must then determine which flex assets should 
have the relationship represented by this recommendation with other flex assets. You 
assign these relationships in the parent asset’s “New” or “Edit” form, and you assign a 
confidence value to each asset on the list for each segment.

When the recommendation is rendered by its template, Engage does the following:

- Identifies which assets have the relationship named by the recommendation with 
the currently displayed asset.

- Examines the ratings for those assets to determine whether those assets are 
relevant for the current visitor.

The functionality of each of the available types of “Recommendation” assets is 
summarized in the following table:    

arameter
Static Lists (List 

Mode)
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Asset Selection Factors
When Engage determines which assets are the most appropriate to recommend to the 
current visitor through a given recommendation, it multiplies each asset’s individual 
rating in the segment by the confidence value assigned to the asset in the 
recommendation to obtain the asset’s weighted rating. The following sections describe 
these concepts in detail.

Ratings
An asset’s individual rating establishes how important the asset is to the visitor belonging 
to a particular segment. You manually assign the rating to the asset in the asset’s Create or 
Edit view.   

You can assign three kinds of ratings to an asset:

There is also a system default rating for flex assets or flex parents that have not been 
assigned any of these specific ratings. The system default is set to 50 unless you and your 
development team decide to change it (through an XML or JSP object method on your site 
pages). The system default represents the average or middle point in the rating scale for 
your site, which is why it is recommended that you keep the system default rating set to 
50.

Range of Ratings
The valid range for individual ratings is 0 through 100. The individual values of 0 and 100 
are special and affect an asset’s rating as follows:

• An asset rating of 0 for a segment tells Engage to never recommend the asset to a 
member of the segment. For example, you might want to make sure that your site never 
recommends PCs or PC software to members of a segment named “Macintosh Users.”

• An asset rating of 100 for a segment tells Engage to always recommend the asset to a 
member of the segment.

Note

Only flex assets can be rated for segments. Basic assets do not support ratings and 
are ignored by the recommendation if placed in it. Consult your administrator to 
make sure you are only placing flex assets in the recommendations you create.

Rating Description

In Segment Used when the current visitor is a member of a specific 
segment.

Out of Segment Used when the current visitor is not a member of a 
specific segment.

When no segment ratings 
apply

Used when no segments are defined for the current site, 
or the asset is placed in a recommendation that does not 
recognize segments (Static Lists recommendation in 
List mode).
Oracle WebCenter Sites User’s Guide



Chapter 17.  Creating and Configuring Recommendations

Asset Selection Factors
297
Inheritance of Ratings
Flex assets and flex parents inherit “In Segment,” “Out of Segment,” and “When No 
Segment Ratings Apply” (“fallback”) ratings from their parents. The asset’s or parent’s 
final rating is the average of its individual rating (which is the system default rating if it 
has no individual rating) plus its inherited rating. The asset’s inherited rating is the final 
rating of its parent, as illustrated by the following formula:

where, 

individual rating = system default if custom rating is not specified

inherited rating = parent’s final rating

For example:

If the flex asset inherits a rating for a segment that it does not have an individual rating for, 
Engage averages the inherited rating with the system default rating (which is typically 50) 
to determine the final rating. For example:

Because the values of 0 and 100 have special functions, the following rules apply to them 
when inheritance is concerned:

• If either the individual or the inherited rating is 0, the final rating is 0.

Asset or Parent
Individual 

Rating
Inherited 

Rating Final Rating

Asset Parent A

(top-level group)

70 no rating 
inherited

70

Asset Parent B 

(child of Asset Parent A)

60 70 (60 + 70) / 2 = 65

Asset 1

(child of Asset Parent B)

95 65 (95 + 65) / 2 = 80

Asset or Parent
Individual 

Rating
Inherited 
Rating Final Rating

Asset Parent A

(top-level group)

80 nothing 
inherited

80

Asset Parent B

(child of Asset Parent A)

none, so the 
system default 
of 50 is used

80 (50 + 80) / 2 = 65

Asset 1

(child of Asset Parent B)

70 65 (70 + 65) / 2 = 67.5

Final rating individual rating inherited rating+
2

-----------------------------------------------------------------------------------=
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• If either the individual or the inherited rating is 100, the final rating is 100 unless the 
other value is 0.

If the current visitor belongs to more than one segment and the asset has ratings for those 
segments, the following rules apply:

• The highest of the ratings is the final rating.

• If one of those ratings is 0, the final rating is 0.

Confidence
Confidence in Engage indicates how likely your visitors are to want to view a particular 
piece of content; thus, Engage uses confidence values assigned to each asset in a 
recommendation to decide how often a piece of content is to be recommended to the 
visitor. When a recommendation assesses an asset against a given segment, the asset’s 
rating (either individual or final, depending on the scenario) is multiplied by the 
confidence value for that segment in the recommendation to produce the asset’s weighted 
rating. The weighted rating is then used by the recommendation to determine how relevant 
the asset is to the current visitor. Confidence is therefore a scaling factor for the asset’s 
rating. Keep in mind that neither an asset’s individual rating nor its confidence value alone 
can be used to recommend the asset to the visitor; the weighting process applies to all 
assets assigned to a given recommendation.

Note that when an asset is assessed by multiple recommendations, its respective weighted 
ratings are calculated independently of one another; that is, the confidence values assigned 
to the asset in one recommendation do not affect the asset’s rating “visible” to the other 
recommendation. For example, if an asset has an individual rating of 80, a 60% 
confidence for Segment A in Recommendation 1, and a 90% confidence for Segment A in 
Recommendation 2, both recommendations use the asset’s individual rating of 80 when 
calculating its respective weighted rating.

The way confidence is assigned depends on the type of recommendation:

- For Static Lists recommendations in List mode, Engage automatically assigns a 
confidence value to each asset in the list based on the asset’s position in the list: 
the first asset on the list gets a value of 100%, the second 99%, the third 98% and 
so on, in descending order.

- For Static Lists recommendations in Recommendation mode, you manually assign 
confidence values to assets for each segment in the recommendation via the 
recommendation’s “New” or “Edit” forms.

- For Related Items recommendations, you manually assign confidence values to 
assets for each segment in the recommendation via the parent asset’s “New” or 
“Edit” form.

- For Dynamic Lists recommendations, confidence values are returned to Engage 
by the selected “CSElement” asset and assigned to the respective assets 
automatically.

Range of Confidence Values
Because confidence is a scaling factor, it is presented as a percentage. The valid range of 
percentage values is 0 through 100. The values of 0% and 100% affect an asset’s rating as 
follows:
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• A confidence value of 0% means the asset will never be returned by that 
recommendation because the asset’s rating is multiplied by 0% (0), which results in a 
rating of 0.

• A confidence value of 100% means the asset’s rating is not scaled or affected by the 
confidence at all because the asset’s rating is multiplied by 100% (1).

Inheritance of Confidence Values
Typically you designate relationships between flex assets and assign a confidence value to 
that relationship at the parent level because assets inherit the confidence value assigned to 
their parents by the recommendation.

If the asset has more than one confidence value for the same recommendation, Engage 
uses the highest value (even if one of those values is 0); it does not average them.

Selection Criteria 

Selection Criteria is a configuration option that allows you to specify how the 
“Recommendation” asset selects assets to be returned to the template that requests them. 

The method that you select for Selection Criteria determines how Engage selects assets 
from the database. There are two Selection Criteria methods:

• Highest – Engage selects the assets with the highest weighted rating for the current 
segments (that is, the segments that the current visitor belongs to). 

• Random – Engage uses a weighted random algorithm (operating on the assets’ 
weighted ratings) to select the assets from the list. Use this selection criterion to 
design a recommendation that rotates its message, keeping the recommended assets 
current or different each time a visitor returns to the site page. The selections are still 
based on the weighted ratings of the assets, however, because this is a weighted 
random algorithm. The higher the asset’s rating for the current segment, the more 
likely it is to be chosen. 

For example, a template is coded to call a recommendation that uses the random 
selection criteria method for one asset. The possibilities include these three products: 

The probability of the product being selected is its rating divided by the sum of all the 
ratings (247). Therefore, “Movie 123” has a 38% chance of being selected, “Movie 
ABC” has a 35% chance, and “Movie RedYellowBlue” has a 26% chance.

Note

List mode Static Lists recommendations do not support the Random selection 
criterion.

Asset Weighted Rating

Movie 123 95

Movie ABC 87

Movie RedYellowBlue 65
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Sort Criteria
Sort Criteria is a configuration option that allows you to specify the order in which the 
template should render the assets returned to it by the recommendation. Sort Criteria are 
applied to the list of returned assets after the Selection Criteria method determines which 
assets to include in the list. 

By default, you can sort the list of selected assets by the following attributes:

• “_ASSETTYPE_” – sorts the assets in the list alphabetically by asset type. For 
example, “Article” assets are first, then Image assets, and then the Product assets. (By 
default, assets are sorted in ascending order; you can reverse the sort order by 
selecting the Descending sort direction.)

• “_CONFIDENCE_” – sorts the returned assets by their confidence values. 

• “_RATING_” – sorts the returned assets by their rating (individual or final, if 
applicable).

For each attribute, you can specify either ascending or descending sort order.

Sort options specific to the asset types available on your site are set up by your 
administrator. As an example, a site could be set up to include the following attribute types 
and corresponding attributes:

• “Product Attribute” – sorts by product attributes such as Price, SKU, or Color, and 
so on (depending on which product attributes are used in your system). 

• “Content Attribute” – sorts by content attributes such as Headline, Filename, or 
Author, and so on (depending on which content attributes are used in your system). 
Note that content attribute means only those attributes that are used to define flex 
assets, not basic assets.

You can add as many sort options as you want to a recommendation. Engage uses these 
options in the order in which they appear on the recommendation form.
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Asset Recommendation Processes
The following section explains how Engage determines which assets to pass to the 
template for each type of recommendation.

Static Lists in List Mode
List mode allows you to create a simple static list with the marketing options (such as selection 
and sort criteria) fixed to specific values (see table on page 295 for this information). When a 
List mode Static Lists recommendation is invoked by a template, all assets in the list will 
always be displayed in the order you specify within the “Recommendation” asset.

• If a template invokes a List mode Static Lists recommendation but it does not ask for a 
specific number of assets, the recommendation examines the ratings of the assets in 
the recommendations and eliminates assets with a rating of 0. The recommendation 
then returns all the assets on its list that are not rated 0, regardless of the segment(s) 
the visitor belongs to.

• When a template invokes a List mode Static Lists recommendation and it requests 
fewer assets than are on the recommendation’s list, Engage recommends the assets 
with the highest weighted ratings (the random weighted algorithm is not supported in 
List mode).

The recommendation calculates the weighted ratings of the assets on its list as follows:

1. It examines each asset on the recommendation’s list to determine whether that asset 
has a “No segment ratings apply” rating.

2. For each asset that has such a rating, Engage multiplies the rating by the confidence 
value for the asset (determined by the asset’s position in the list). This value is the 
asset’s weighted rating. For example, if the rating is 90 and the confidence is 75%, it 
calculates the weighted rating to be 67.5 (that is, 90 x 0.75).

3. Engage recommends the assets using the Highest selection criterion to determine 
which assets to return (the Random selection criterion is not supported in List mode). 
For more information on selection criteria, see the section “Selection Criteria,” on 
page 299.

Static Lists in Recommendation Mode
In contrast to List mode, when a Recommendation mode Static Lists recommendation is 
invoked by a template, the order of the displayed assets is determined by segments and 
ratings, not by the list order. Furthermore, the application of segments and ratings can 
result in some assets in the list being filtered out entirely.

• If a template invokes a Recommendation mode Static Lists recommendation but it 
does not ask for a specific number of assets, the recommendation examines the ratings 
of the assets in the recommendations and eliminates assets with a rating of 0. The 
recommendation then returns all the assets on its list that are not rated 0 for the current 
visitor. 

• When a template invokes a Recommendation mode Static Lists recommendation and 
it requests fewer assets than are on the recommendation’s list, Engage uses the 
Selection Criteria method specified in the recommendation to determine which 
assets to return.
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The recommendation calculates the weighted ratings of the assets on its list as follows:

1. It determines which segments the current visitor belongs to.

2. It examines each asset on the recommendation’s list to determine whether that asset 
has a rating for any of the segments that apply to the current visitor.

3. For each asset that has a rating for the segment(s) the current visitor belongs to, Engage 
multiplies the rating by the confidence value assigned in the recommendation for that 
asset. This value is the asset’s weighted rating. For example, if the rating is 90 and the 
confidence is 75%, it calculates the weighted rating to be 67.5 (that is, 90 x 0.75).

4. If the Selection Criteria method is Highest, Engage recommends the assets with the 
highest weighted ratings. If the Selection Criteria method is Random, Engage uses a 
weighted random algorithm to select and return the recommended assets (based on 
their weighted ratings). For more information on selection criteria, see the section 
“Selection Criteria,” on page 299.

Dynamic Lists
When a Dynamic Lists recommendation is invoked by a template, the order of the 
displayed assets is determined by segments and ratings. Furthermore, the application of 
segments and ratings can result in some assets in the list being filtered out entirely.

• If a template invokes a Dynamic Lists recommendation but it does not ask for a 
specific number of assets, the recommendation returns all the assets it obtains from the 
generated list. Engage does not calculate weighted ratings in this case. 

• If a template invokes a Dynamic Lists recommendation and it requests fewer assets 
than are on the recommendation’s list, Engage uses the Selection Criteria method 
specified in the recommendation to determine which assets to return.

Engage calculates the asset ratings as follows:

1. It determines which segments the current visitor belongs to.

2. It examines each asset returned by the element to determine whether that asset has a 
rating for any of the segments that apply to the current visitor.

3. For each asset that has an appropriate rating, it multiplies the rating by the confidence 
value for that asset (from the element). This value is the asset’s final rating. For 
example, if the rating is 90 and the confidence is 0.75, it calculates the final rating to 
be 67.5 (90 x 0.75). If the element does not return a confidence value, Engage assigns 
a confidence value of 1 to each asset in the list.

4. If the Selection Criteria method is Highest, Engage recommends the assets with the 
highest final ratings. If the Selection Criteria method is Random, Engage uses a 
weighted random selection to return the recommended assets.

Related Items
In this example, a template that displays a product description for a “Movie” asset named 
Movie 123 invokes a Related Items recommendation named “Cross-Sell.” The template 
for “Cross-Sell” asks for five assets that have the “Cross-Sell” relationship with Movie 
123. 

Engage does the following: 

1. Determines which segments the current visitor belongs to.
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2. Examines the Related Items section of the asset form for Movie 123 to determine 
which assets are listed for the “Cross-Sell” recommendation. It also examines the 
related assets for all parents of Movie 123. 

3. Creates a preliminary list of all “Movie” and “Product” assets that have the 
“Cross-Sell” relationship with Movie 123. (This list includes all the “Product” assets 
that inherited this relationship from their parents.) This list also determines the 
confidence value for each asset.

4. Examines the Ratings section on the asset forms for all of the “Movie” and 
“Products” assets on the preliminary list.

5. Constrains the preliminary list to include only those “Movie” and “Product” assets 
that have applicable ratings for the segments that the current visitor belongs to.

6. Multiplies the rating by the confidence for each asset on the constrained list.

7. If the Selection Criteria method is Highest, Engage recommends the five assets with 
the highest final ratings. If the Selection Criteria method is Random, Engage uses a 
weighted random algorithm (operating on the assets’ weighted ratings) to return the 
five recommended assets.

Creating Recommendation Assets

Recommendation Development Overview
The basic steps for setting up recommendations are as follows:

1. Designers and developers meet with the marketing team to define all the 
merchandising messages that you want to display on your site and to plan how to 
represent those messages using recommendation and promotion assets.

2. The designers and developers design and code templates for the recommendations. If 
Dynamic Lists recommendations will be used, they also write “CSElement” assets 
designed to generate dynamic lists. 

3. Marketing then uses Engage Recommendation forms to create “Recommendation” 
assets (that is, name and configure the recommendations).

4. Using the Engage flex asset forms, you rate how important the assets are to each 
segment, and, therefore, to the individual visitors who become members of those 
segments. (Typically, you assign ratings to flex parents instead of to individual flex 
assets.)

For each Related Items recommendation, you assign to flex assets the assets with 
relationships that are defined by that recommendation. (Typically, you specify 
relationships for flex parents instead of for individual flex assets.)

Note

Typically, marketing people create “Recommendation” assets and set confidence 
values for assets referenced by Static Lists and Related Items recommendations. 
(Confidence for Dynamic Lists recommendations is coded into the template that 
renders the assets being recommended). 

Business users assign individual ratings to assets referenced by recommendations 
created by marketing.
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This section describes how to create and configure “Recommendation” assets (step 3 
above). The section “Configuring Assets to Be Recommended,” on page 325 describes 
how to assign ratings to assets and how to assign flex assets to flex parent assets via the 
relationships defined in a Related Items recommendation (step 4 above).

This section covers the following procedures:

• Creating Static Lists Recommendations in List Mode

• Creating Static Lists Recommendations in Recommendation Mode

• Creating Dynamic Lists Recommendations

• Creating Related Items Recommendations

Creating Static Lists Recommendations in List Mode
List mode allows you to create a simple static list with the marketing options (such as 
selection and sort criteria) fixed to specific values (see table on page 295 for this 
information). When a List mode Static Lists recommendation is invoked by a template, all 
assets in the list will always be displayed in the order you specify within the 
“Recommendation” asset.

To create a Static Lists recommendation in List mode

Before you can assign assets to a recommendation, it is suggested that you add the source 
asset(s) to your bookmarks for easy retrieval during the creation of the recommendation.

1. Log in to WebCenter Sites, select the site you want to work with (FirstSite II in this 
example) and the icon for the WebCenter Sites Contributor interface.

2. Find the assets to be included in the recommendation and bookmark them (which adds 
them to the Bookmarks node in the My Work tree):

a. In the Search field, enter the desired search criteria (if any) and click the 
magnifying glass ( ) button.

b. If you want to narrow your search down to a specific type of asset, in the Search 
field, click the down-arrow to render the “Search Type” drop-down box. Select 
the asset type to which you want to limit your search. 

c. In the search results list, select (Ctrl+click) the assets you wish to bookmark. In 
the “Search” tab’s toolbar, click the Bookmark ( ) icon. 

For more information on searching for and bookmarking assets, see Chapter 6, 
“Finding and Organizing Assets.”

3. In the menu bar, select Content > New > New Recommendation.

a. If the administrator configured the asset type such that all new assets of that type 
are placed into workflow upon creation, a tab opens displaying the “Choose 
Assignees” form.

Note

You can click Save as you progress through the sections of the “Recommendation” 
form in this procedure to save the changes you have made up to and in that section.
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Select at least one user for each required role and click Set Assignees. Any of 
these users can complete the next step in the workflow process. For more 
information, see Chapter 14, “Workflow.”

b. If the Create view of the “Recommendation” asset is displayed in Web Mode, 
switch to Form Mode by clicking the Mode switch in the asset’s toolbar.

The tab displays the “Recommendation” asset’s Create view in Form Mode. Notice 
the names of the form’s sections, Name, Options, and Build, near the top. When you 
create a new Recommendation asset, the Name section of the form is displayed. 

4. In the Name section of the “Recommendation” form, do the following:

a. In the Name field, enter a unique, descriptive name for the list. You can enter up 
to 64 alphanumeric characters, including spaces. The first character must be a 
letter.

b. In the Description field, enter a brief description of the list. You can enter up to 
128 alphanumeric characters.

Note

When creating or editing a “Recommendation” asset, you can switch between 
the sections of the form by clicking the name of the section you want to switch 
to.
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c. In the “Subtype” drop-down list, select a subtype for the recommendation. A 
subtype is a method of categorizing lists. If the design team did not define 
subtypes for this type of recommendation, the drop-down list is empty. Consult 
your developers for information on available recommendation subtypes (if any).

d. In the “Template” drop-down list, select a template for the recommendation. 

e. In the Locale field, select the location that the asset will display in online.

f. In the Start Date and End Date fields, select a date range in which the asset will 
display online. For more information on Start/End dates, see “About Start and End 
Dates,” on page 146.

g. In the Mode field, select the List radio button.

h. Click Continue.

The tab displays the “Options” section of the “Recommendation” form:

5. In the Options section, set the options appropriate for the list’s intended purpose. 
When you are done, click Continue.

Note

If the Template field does not include a drop-down list, it means that no 
templates have been created for recommendations on your site. Consult your 
developers for information on recommendation templates.
Oracle WebCenter Sites User’s Guide



Chapter 17.  Creating and Configuring Recommendations

Creating Recommendation Assets
307
The tab displays the Build section of the “Recommendation” form:   

6. In the “Static Lists” Drop zone, add the assets (which you bookmarked in step 2 on 
page 308) that you want to include in this segment’s list. Do the following:

a. In the My Work tree, expand the Bookmarks node. (If the My Work tree is 
collapsed, expand it by clicking the My Work bar in the navigation pane). 

b. In the list of bookmarked assets (displayed under the Bookmarks node) click the 
name of the desired asset and then drag it to and drop it into the field.

7. (Optional) You can change the order in which the assets in the list are organized by 
selecting an asset in the list and dragging within the list to move the asset up or down 
the list. 

8. Save the asset. Do one of the following:

- In the asset’s toolbar, click the Save ( ) icon.

- In the menu bar, select Content > Save.

9. Inspect the asset. Do one of the following:

- In the asset’s toolbar, click the Inspect ( ) icon.

- In the menu bar, select Edit > Inspect.

The tab displays the asset’s Inspect view in Form Mode. You cannot modify the 
asset’s content when the asset is displayed in the Inspect view.

Creating Static Lists Recommendations in Recommendation 
Mode

In contrast to List mode, when a Recommendation mode Static Lists recommendation is 
invoked by a template, the order of the displayed assets is determined by segments and 
ratings, not by the list order. Furthermore, the application of segments and ratings can 
result in some assets in the list being filtered out entirely.

Keep the following in mind:

• If you are going to use segments, make sure you know which assets belong in which 
segments.

• If the segments you need do not exist, you can create them (assuming you have the 
appropriate permissions). See Chapter 16, “Grouping Visitors into Segments” for 
information on creating and configuring segments.

• You should know in advance the confidence values (in segment, out of segment, and 
when no segments apply) you will assign to the assets you are adding to the list.
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Before you can assign assets to a recommendation, you should add the source asset(s) to 
your bookmarks for easy retrieval during the creation of the recommendation.

To create a Static Lists recommendation in Recommendation mode

1. Log in to WebCenter Sites, select the site you want to work with (FirstSite II in this 
example) and the icon for the WebCenter Sites Contributor interface.

2. Find the assets to be included in the recommendation and bookmark them (which adds 
them to the Bookmarks node in the My Work tree):

a. In the Search field, enter the desired search criteria (if any) and click the 
magnifying glass ( ) button.

b. If you want to narrow your search down to a specific type of asset, in the Search 
field, click the down-arrow to render the “Search Type” drop-down box. Select 
the asset type to which you want to limit your search. 

c. In the search results list, select (Ctrl+click) the assets you wish to bookmark. In 
the “Search” tab’s toolbar, click the Bookmark ( ) icon. 

For more information on searching for and bookmarking assets, see Chapter 6, 
“Finding and Organizing Assets.”

3. In the menu bar, select Content > New > New Recommendation.

a. If the administrator configured the asset type such that all new assets of that type 
are placed into workflow upon creation, a tab opens displaying the “Choose 
Assignees” form.

Select at least one user for each required role and click Set Assignees. Any of 
these users can complete the next step in the workflow process. For more 
information, see Chapter 14, “Workflow.”

b. If the Create view of the “Recommendation” asset is displayed in Web Mode, 
switch to Form Mode by clicking the Mode switch in the asset’s toolbar.

Note

You can click the Save ( ) icon (located in the asset’s toolbar) as you progress 
through the sections of the “Recommendation” form in this procedure to save the 
changes you have made up to and in that section.
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The tab displays the “Recommendation” form. Notice the names of the form’s 
sections near the top. When you create a new “Recommendation” asset, the Name 
section of the form is displayed first: 

4. In the Name section of the “Recommendation” form, do the following:

a. In the Name field, enter a unique, descriptive name for the recommendation. You 
can enter up to 64 alphanumeric characters, including spaces. The first character 
must be a letter.

b. In the Description field, enter a brief description of the recommendation. You can 
enter up to 128 alphanumeric characters.

c. In the “Subtype” drop-down list, select a subtype for the recommendation. A 
subtype is a way of categorizing lists. If the design team did not define subtypes 
for this type of recommendation, the drop-down list is empty. Consult your 
developers for information on available recommendation subtypes (if any).

d. In the “Template” drop-down list, select a template for the recommendation.

Note

When creating or editing a “Recommendation” asset, you can switch between 
the sections of the form by clicking the name of the section you want to switch 
to.

Note

If the Template field does not include a drop-down list, it means that no 
templates have been created for recommendations. Consult your developers 
for information on creating templates for recommendations.
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e. In the Start Date and End Date fields, select a date range in which the asset will 
display online. For more information on Start/End dates, see “About Start and End 
Dates,” on page 146.

f. In the Mode field, select the Recommendation radio button.

g. Click Continue.

The tab displays the Type section of the “Recommendation” form: 

5. In the Type section of the “Recommendation” form, do the following:

a. Select Static Lists.

b. Click Continue.

The tab displays the Options section of the “Recommendation” form:

6. In the Options section of the “Recommendation” form, do the following:

a. Set the options appropriately for the recommendation’s intended purpose.

b. Click Continue.
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The tab displays the Build section of the “Recommendation” form:

7. In the Build section of the “Recommendation” form, do the following:

a. In the “New Static List” drop-down menu, select a segment.

Sites creates a new static list for the segment and displays it in the form.

b. In the “Drag Products” Drop Zone, add the assets (which you bookmarked in 
step 2 on page 308) that you want to include in this segment’s list. Do the 
following:

1) In the My Work tree, expand the Bookmarks node. (If the My Work tree is 
collapsed, expand it by clicking the My Work bar in the navigation pane). 

2) In the list of bookmarked assets (displayed under the Bookmarks node) click 
the name of the desired asset and then drag and drop it into the field.

c. Assign a confidence value for each asset, both In Segment and Out of Segment. 
Confidence is a weighting factor for the recommendation to use in determining 
which assets to return for the current visitor when that visitor is a member of the 
segment and when that visitor is not a member of the segment. The defaults are 
100% and 0% respectively.

If the asset is not added to a segment, then only one Confidence field appears.
For additional information, see “Confidence,” on page 298.

d. Repeat steps a – c for as many segments as you want to include. After you select a 
segment, it no longer appears in the drop-down list.

e. (Optional) Repeat steps b – c for the If No Segments Apply category and assign 
confidence values as appropriate.
Oracle WebCenter Sites User’s Guide



Chapter 17.  Creating and Configuring Recommendations

Creating Recommendation Assets
312
The completed form will look similar to the following:

f. Click Continue.

The tab displays the Selection section of the “Recommendation” form:

8. In the Selection section of the “Recommendation” form, do the following:

a. Choose the selection criterion for the recommendation. For more information, see 
the section “Selection Criteria,” on page 299.

b. Click Continue.
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The tab displays the Sort section of the “Recommendation” form:

9. In the Sort section of the “Recommendation” form, do the following:

a. In the “Attribute Type” drop-down list, select the type of attribute by which you 
want to sort the asset list. By default, only the Special attribute type is available, 
allowing you to sort by asset type, confidence, and rating. Attribute types specific 
to the nature of the assets on your site are set up by the administrator and 
developers.

For more information, see the section “Sort Criteria,” on page 300.

b. In the “Attribute” drop-down menu, select the attribute by which you want to sort 
the asset list. The contents of the list depend on the option that you selected in the 
Attribute Type field. For example, if you selected the Special attribute type in 
step a, the Attribute field will contain the options, _ASSETTYPE_, 
_CONFIDENCE_, and _RATING_.

Note that attributes specific to the nature of the assets on your site must be set up 
by the administrator and developers before you can use them.

c. In the Direction field, choose whether the sort direction should be ascending or 
descending.

d. Click Add Sort Criteria. Your criteria appear at the bottom of the form.

e. (Optional) To add more sort criteria, repeat steps a – d. Be sure to add the new sort 
criteria in the order in which you want Engage to sort the assets in the list. For 
example, you might want to sort assets first by asset type, and then by rating.

10. Save the asset. Do one of the following:

- In the asset’s toolbar, click the Save ( ) icon.

- In the menu bar, select Content > Save.

11. Inspect the asset. Do one of the following:

- In the asset’s toolbar, click the Inspect ( ) icon.

- In the menu bar, select Edit > Inspect.

The tab displays the asset’s Inspect view in Form Mode. You cannot modify the 
asset’s content when the asset is displayed in the Inspect view.
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Creating Dynamic Lists Recommendations

To create a Dynamic Lists recommendation

1. Log in to WebCenter Sites, select the site you want to work with (FirstSite II in this 
example) and the icon for the WebCenter Sites Contributor interface.

2. In the menu bar, select Content > New > New Recommendation.

a. If the administrator configured the asset type such that all new assets of that type 
are placed into workflow upon creation, a tab opens displaying the “Choose 
Assignees” form.

Select at least one user for each required role and click Set Assignees. Any of 
these users can complete the next step in the workflow process. For more 
information, see Chapter 14, “Workflow.”

b. If the Create view of the “Recommendation” asset is displayed in Web Mode, 
switch to Form Mode by clicking the Mode switch in the asset’s toolbar.

The tab displays the “Recommendation” asset’s Create view in Form Mode. Notice 
the names of the form’s sections near the top. When you create a new 
“Recommendation” asset, the Name section of the form is displayed first: 

Note

Before beginning this procedure, Consult your developers to find out which 
“CSElement” asset(s) should be used with the Dynamic Lists 
recommendation(s) you want to create.
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3. In the Name section of the “Recommendation” form, do the following:

a. In the Name field, enter a unique, descriptive name for the recommendation. You 
can enter up to 64 alphanumeric characters, including spaces. The first character 
must be a letter.

b. In the Description field, enter a brief description of the recommendation. You can 
enter up to 128 alphanumeric characters.

c. In the “Subtype” drop-down list, select a subtype for the recommendation. 
A subtype is a way of categorizing lists. If the design team did not define subtypes 
for this type of recommendation, the drop-down list is empty.

d. In the “Template” drop-down list, select a template for the recommendation.

e. In the Start Date and End Date fields, select a date range for the asset to display 
in Site Preview. For more information on Start/End dates, see “About Start and 
End Dates,” on page 146.

f. In the Mode field, select the Recommendation radio button.

g. Click Continue.

The tab displays the Type section of the “Recommendation” form:

4. In the Type section of the “Recommendation” form, do the following:

a. Select Dynamic Lists.

b. Click Continue.

Note

When creating or editing a “Recommendation” asset, you can switch between 
the sections of the form by clicking the name of the section you want to switch 
to.

Note

If the Template field does not include a drop-down list, it means that no 
templates have been created for recommendations. Consult your developers 
for information on creating templates for recommendations.
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The tab displays the Options section of the “Recommendation” form:

5. In the Options section of the “Recommendation” form, do the following:

a. Set the options appropriately for the recommendation’s intended purpose.

b. Click Continue.

The tab displays the Build section of the “Recommendation” form:

6. In the Build section of the “Recommendation” form, do the following:

a. In the “CSElement” Type Ahead field, type the first characters of the CSElement 
you want the recommendation to use to generate a drop-down list of elements that 
match. 
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When you select an asset from the drop-down list, WebCenter Sites refreshes the 
form to display the added “CSElement” asset:

b. If you want to replace the currently chosen “CSElement” asset, repeat step a. The 
“CSElement” you select replaces the current one.

c. Click Display Results to view the list that the element will currently generate.

The element is required to return a list of a specific type containing these columns:

- Asset Name – the name of the asset, which is guaranteed to be unique for the 
site

- Asset ID – generated identifier of the asset

- Asset Type – the name of the asset type (for example, “Products”)

- Confidence – a value that is either calculated by the developer, or assigned by 
Engage as 1 (100%)

Remember that the list is dynamic, so the list contents are likely to change if 
assets have changed in your database when the recommendation is invoked by the 
template. If you select another “CSElement” asset from the tree, the currently 
displayed list results will be cleared.
When you click Display Results, several other outcomes are possible:

- The element fails to return the expected list type.

- The returned list is missing a required column.

- The element encountered the displayed error condition.

- The element fails to return any assets (not necessarily an error; the expected 
assets may not yet exist, in which case, you should contact your 
administrator).

If you encounter any of these conditions, select another “CSElement” asset and 
try again or consult your developers to troubleshoot the faulty “CSElement” asset.

d. Click Continue.
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The tab displays the Selection section of the “Recommendation” form:

7. In the Selection section of the “Recommendation” form, do the following:

a. Choose the selection criterion for the recommendation. For more information, see 
the section “Selection Criteria,” on page 299.

b. Click Continue.

The tab displays the Sort section of the “Recommendation” form:

8. In the Sort section of the “Recommendation” form, do the following:

a. In the “Attribute Type” drop-down list, select the type of attribute by which you 
want to sort the asset list. By default, only the Special attribute type is available, 
allowing you to sort by asset type, confidence, and rating. Attribute types specific 
to the nature of the assets on your site are set up by the administrator and 
developers.

For more information, see the section “Sort Criteria,” on page 300.

b. In the “Attribute” drop-down list, select the attribute by which you want to sort 
the asset list. The contents of the list depend on the option that you selected in the 
Attribute Type field. For example, if you selected the Special attribute type in 
steps a, the Attribute field will contain the options, _ASSETTYPE_, 
_CONFIDENCE_, and _RATING_. 

Note that attributes specific to the nature of the assets on your site must be set up 
by the administrator and developers before you can use them.

c. In the Direction field, choose whether the sort direction should be ascending or 
descending.

d. Click Add Sort Criteria. Your criteria appear at the bottom of the form.

e. (Optional) To add more sort criteria, repeat steps a – d. Be sure to add the new sort 
criteria in the order in which you want Engage to sort the assets in the list. For 
example, you might want to sort assets first by asset type, and then by rating.
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9. When you have selected the desired sort criteria, save the asset. Do one of the 
following:

- In the asset’s toolbar, click the Save ( ) icon.

- In the menu bar, select Content > Save.

10. Inspect the asset. Do one of the following:

- In the asset’s toolbar, click the Inspect ( ) icon.

- In the menu bar, select Edit > Inspect.

The tab displays the asset’s Inspect view in Form Mode. You cannot modify the 
asset’s content when the asset is displayed in the Inspect view.

Creating Related Items Recommendations
To create a Related Items recommendation

1. Log in to WebCenter Sites, select the site you want to work with (FirstSite II in this 
example) and the icon for the WebCenter Sites Contributor interface.

2. In the menu bar, select Content > New > New Recommendation.

a. If the administrator configured the asset type such that all new assets of that type 
are placed into workflow upon creation, a tab opens displaying the “Choose 
Assignees” form.

Select at least one user for each required role and click Set Assignees. Any of 
these users can complete the next step in the workflow process. For more 
information, see Chapter 14, “Workflow.”

b. If the Create view of the “Recommendation” asset is displayed in Web Mode, 
switch to Form Mode by clicking the Mode switch in the asset’s toolbar.

The tab displays the “Recommendation” asset’s Create view in Form Mode. Notice 
the names of the form’s sections near the top. When you create a new 
“Recommendation” asset, the Name section of the form is displayed first: 
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3. In the Name section of the “Recommendation” form, do the following:

a. In the Name field, enter a unique, descriptive name for the recommendation. You 
can enter up to 64 alphanumeric characters, including spaces. The first character 
must be a letter.

b. In the Description field, enter a brief description of the recommendation. You can 
enter up to 128 alphanumeric characters.

c. In the “Subtype” drop-down list, select a subtype for the recommendation. A 
subtype is a way of categorizing lists. If the design team did not define subtypes 
for this type of recommendation, the drop-down list is empty. Consult your 
developers for information on available recommendation subtypes (if any).

d. In the “Template” drop-down list, select a template for the recommendation. 

e. In the Start Date and End Date fields, select a date range for the asset to display 
in Site Preview. For more information on Start/End dates, see “About Start and 
End Dates,” on page 146.

f. In the Mode field, select the Recommendation radio button.

g. Click Continue

The tab displays the Type section of the “Recommendation” form:

4. In the Type section of the “Recommendation” form, do the following:

a. Select the Related Items radio button.

b. Click Continue.

Note

When creating or editing a “Recommendation” asset, you can switch between 
the sections of the form by clicking the name of the section you want to switch 
to.

Note

If the Template field does not include a drop-down list, it means that no 
templates have been created for recommendations. Consult your developers 
for information on creating templates for recommendations.
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The tab displays the Options section of the “Recommendation” form:

5. In the Options section of the “Recommendation” form, do the following:

a. Set the options appropriately for the recommendation’s intended purpose.

b. Click Selection at the top of the form (Related Items recommendations have no 
“Build” step). 

c. Click Continue.

The following message appears:

6. In the “Build” section, click Continue to go to the Selection section of the form.

The tab displays the Selection section of the “Recommendation” form:

7. In the Selection section of the “Recommendation” form, do the following:
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a. Choose the selection criterion for the recommendation. For more information, see 
the section “Selection Criteria,” on page 299.

b. Click Continue.

The tab displays the Sort section of the “Recommendation” form:

8. In the Sort section of the “Recommendation” form, do the following:

a. In the “Attribute Type” drop-down list, select the type of attribute by which you 
want to sort the asset list. By default, only the Special attribute type is available, 
allowing you to sort by asset type, confidence, and rating. Attribute types specific 
to the nature of the assets on your site are set up by the administrator and 
developers.

For more information, see the section “Sort Criteria,” on page 300.

b. In the “Attribute” drop-down list, select the attribute by which you want to sort 
the asset list. The contents of the list depend on the option that you selected in the 
Attribute Type field. For example, if you selected the Special attribute type in 
step a, the Attribute field will contain the options, _ASSETTYPE_, 
_CONFIDENCE_, and _RATING_. 

Note that attributes specific to the nature of the assets on your site must be set up 
by the administrator and developers before you can use them.

c. In the Direction field, choose whether the sort direction should be ascending or 
descending.

d. Click Add Sort Criteria. Your criteria appear at the bottom of the form.

e. (Optional) To add more sort criteria, repeat steps a – d. Be sure to add the new sort 
criteria in the order in which you want Engage to sort the assets in the list. For 
example, you might want to sort assets first by asset type, and then by rating.

9. When you have selected the desired sort criteria, save the asset. Do one of the 
following:

- In the asset’s toolbar, click the Save ( ) icon.

- In the menu bar, select Content > Save.

10. Inspect the asset. Do one of the following:

- In the asset’s toolbar, click the Inspect ( ) icon.

- In the menu bar, select Edit > Inspect.

The tab displays the asset’s Inspect view in Form Mode. You cannot modify the 
asset’s content when the asset is displayed in the Inspect view.
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This recommendation now appears in the “Related Items” field (located in the Metadata 
section) of the Create and Edit views for flex assets and flex parent assets. You can now 
configure relationships for flex assets.

For more information, see “Configuring Asset Relationships Using Related Items 
Recommendations,” on page 327.

Editing Recommendation Assets
To edit a “Recommendation” asset

1. Log in to WebCenter Sites, select the site you want to work with (FirstSite II in this 
example) and the icon for the WebCenter Sites Contributor interface.

2. Find and open the “Recommendation” asset you wish to edit:

a. In the Search field, enter the desired search criteria (if any).

b. If you want to narrow your search down to a specific type of asset, in the Search 
field, click the down-arrow to render the “Search Type” drop-down box. Select 
the asset type to which you want to limit your search. 

c. Click the magnifying glass ( ) button.

For more information on searching, see the section “Finding Assets,” on 
page 126.

d. In the search results list, right-click the desired asset and select Edit from the 
context menu.

For more information on searching, see the section “Finding Assets,” on 
page 126.
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A tab opens displaying the asset’s Edit view in Form Mode:

3. Click the Change button next to the section you want to edit. For example, to edit the 
“Options” section, click the Change button next to the “Options” field in the 
recommendation form.
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The tab displays the corresponding section of the recommendation’s form with the 
current configuration options preselected:

4. When you have made the desired changes to the section, save the asset. Do one of the 
following:

- In the asset’s toolbar, click the Save ( ) icon.

- In the menu bar, select Content > Save.

5. Inspect the asset. Do one of the following:

- In the asset’s toolbar, click the Inspect ( ) icon.

- In the menu bar, select Edit > Inspect.

The tab displays the asset’s Inspect view in Form Mode. You cannot modify the 
asset’s content when the asset is displayed in the Inspect view.

Configuring Assets to Be Recommended
The next step is to configure the segment ratings and asset relationships for the assets that 
you want to promote using recommendations. Specifically, you need to use the flex asset 
and flex parent asset forms in Sites’ interface to do the following:

• Rate how important the assets and parent assets are to the members of each segment. 

• Configure the asset relationships that are represented by the Related Items 
recommendations.

Note

Typically, business users configure assets to be recommended.
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Assigning Ratings to an Asset 
You can assign ratings to individual flex assets or to flex parents. However, it is 
recommeded that you use parents to assign ratings, for the following reasons:

• It is much easier to manage the ratings for multiple assets if those assets reside in 
groups. In fact, it is often a good idea to create flex parents whose sole purpose is to 
assign ratings to child assets. You can make all of the assets that have identical rating 
conditions children of the same parent. Then, you can modify the ratings for all the 
child assets by making a single change.

• It is easier to compare the ratings for one group of assets to the ratings of another 
group than it is to compare the ratings of individual assets.

• Ratings are calculated more quickly because there are fewer assets with individual 
ratings; this speeds up system performance.

You should avoid using ratings to try to promote a specific flex asset in a specific 
circumstance. Instead, you should recommend specific assets, using either a Static Lists 
recommendation or a promotion to accomplish your goal.

Before you begin, be sure to complete the following tasks:

• Examine the segments to understand how they are defined and then determine which 
flex parents are significant for which segments.

• Ask your site developers whether they changed the system default rating for unrated 
assets. If they did not override the system default rating, that default rating is 50. This 
rating represents the average or middle point in your rating scale. Make a note of this 
value and keep it in mind while you rate assets. For example, rating an asset at lower 
than the system default rating means that it is unlikely that it would ever be 
recommended to a site visitor.

To assign ratings to an asset

1. Log in to WebCenter Sites, select the site you want to work with (FirstSite II in this 
example) and the icon for the WebCenter Sites Contributor interface.

2. Find the flex asset or flex parent you want to assign ratings to and open its Edit view:

a. In the Search field, enter the desired search criteria (if any).

b. If you want to narrow your search down to a specific type of asset, in the Search 
field, click the down-arrow to render the “Search Type” drop-down box. Select 
the asset type to which you want to limit your search. 

c. Click the magnifying glass ( ) button.

For more information on searching, see the section “Finding Assets,” on 
page 126.

d. In the search results list, right-click the desired asset and select Edit from the 
context menu.

For more information on searching, see the section “Finding Assets,” on 
page 126.
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3. In the asset’s Edit view, Select the Marketing tab and navigate to the Ratings section. 
This section of the form lists all the segments that have been created for this site. For 
example:

4. Using a range of 0 through 100 (100 is the highest value), rate this asset for the 
segments in the list:

- Enter a value in a segment’s In Segment column to rate the asset for members of 
this segment.

- Enter a value in a segment’s Out of Segment column to rate the asset for visitors 
who are not members of this segment.

- Enter a value in the no segment ratings apply field to assign an intrinsic rating to 
the asset; this rating is used when no segments are defined or the asset is assigned 
to a recommendation that does not recognize segments (List mode Static Lists 
recommendation).

For more information about ratings, see “Ratings,” on page 296.

5. When you have selected the desired sort criteria, save the asset. Do one of the 
following:

- In the asset’s toolbar, click the Save ( ) icon.

- In the menu bar, select Content > Save.

6. Inspect the asset. Do one of the following:

- In the asset’s toolbar, click the Inspect ( ) icon.

- In the menu bar, select Edit > Inspect.

Configuring Asset Relationships Using Related Items 
Recommendations

Before you begin, be sure to complete the following tasks:

• Ask the developers to describe each of the Related Items recommendations so that you 
are familiar with the relationships the Related Items recommendations represent.

• Find out whether the recommendation is programmed to display a combination of flex 
assets, for example, “Product” and “Content” assets, so that you can configure the 
relationships correctly.

To configure relationships between assets

1. Log in to WebCenter Sites, select the site you want to work with (FirstSite II in this 
example) and the icon for the WebCenter Sites Contributor interface.
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2. Before you work with the flex parent asset which has Related Items relationship(s) 
that you want to configure, you should find and bookmark the assets that you will 
want to put in these relationships. Bookmarked assets will be available in the 
Bookmarks node in the My Work tree.

a. In the Search field, enter the desired search criteria (if any). 

b. If you want to narrow your search down to a specific type of asset, in the Search 
field, click the down-arrow to render the “Search Type” drop-down box. Select 
the asset type to which you want to limit your search. 

c. Click the magnifying glass ( ) button.

d. In the search results list, select (Ctrl+click) the assets you wish to bookmark. In 
the “Search” tab’s toolbar, click the Bookmark ( ) icon. 

3. Find the flex parent that has the Related Items relationship(s) that you want to 
configure and open its “Edit” form:

a. In the Search field, enter the desired search criteria (if any).

b. If you want to narrow your search down to a specific type of asset, in the Search 
field, click the down-arrow to render the “Search Type” drop-down box. Select 
the asset type to which you want to limit your search. 

c. Click the magnifying glass ( ) button.

d. In the search results list, right-click the desired asset and select Edit from the 
context menu.

For more information on searching, see the section “Finding Assets,” on 
page 126.

4. In the parent asset’s “Edit” form, scroll to the Related Items section, which will look 
similar to the image below:
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5. In the tree, open the Bookmarks node on the My Work tree. Drag and drop the flex 
asset or flex parent into the appropriate recommendation’s Drop Zone.

Engage lists the assets under the recommendation.

6. In the Confidence column next to an asset or parent asset, enter a confidence value 
that represents the weight of this relationship; confidence is expressed as a percentage 
ranging between 0 and 100. If you enter 0 or leave the field empty, the asset is 
excluded from this recommendation.

For more information on confidence, see “Confidence,” on page 298.

7. When you have selected the desired sort criteria, save the asset. Do one of the 
following:

- In the asset’s toolbar, click the Save ( ) icon.

- In the menu bar, select Content > Save.

8. Inspect the asset. Do one of the following:

- In the asset’s toolbar, click the Inspect ( ) icon.

- In the menu bar, select Edit > Inspect.

Note

The Related Items section will only be available if you have created a Related 
Items type of Recommendation that specifies the asset type of the asset you want 
to add. See “Creating Related Items Recommendations,” on page 319 for more 
information.
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Verifying Recommendation Assets
To verify that you configured your “Recommendation” assets correctly, complete the 
following kinds of exercises:

• Create some test segments (see Chapter 16, “Grouping Visitors into Segments” for 
information on creating segments).

• In the flex asset and flex parent asset forms (for example, “Product” and “Product 
Parent”), assign ratings for the segments.

• Browse your site as a visitor and register yourself so that you qualify for the test 
segment.

• Examine the items that the “Recommendation” assets return.

• If you find problems, ask your developers to write test pages that isolate the problem.

Publishing Rated Flex Assets
Since asset ratings and relationships take effect only after they are published, you must 
approve the assets whose ratings and relationships you configured so they can be 
published to your delivery system.

For more information about approving and publishing assets, see Chapter 12, “Approval 
for Publishing.”
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Chapter 18

Creating Promotions
Promotions are merchandising assets that offer some type of value or discount to your site 
visitors based on the products the visitors are buying and the segments they qualify for.

This chapter describes how promotions work and how to create them. It contains the 
following sections:

• About Promotions

• Creating Promotions

• Sample Promotion Asset

• Publishing Promotions
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About Promotions
Promotions offer some type of value to your site visitors and customers based on the 
segments the visitors belong to and products that they buy or view. This value can be 
offered in several ways: 

• A discount off the purchase price of the promoted products.

• A discount off the entire value of the shopping cart.

• A discount off shipping charges.

• A combination discount: a shipping discount with a price or cart discount.

You (the marketers) define your promotions by using the following criteria:

• The segment members who qualify for the promotion. Promotions can be offered to 
everyone or to visitors in selected segments.

• The products to promote.

• The value the customers receive when they purchase the promoted product.

• The duration of the promotion.

• The text or graphics (or both) that appear on the rendered site page that notifies 
visitors of the promotion.

• The location of the notification. Promotions are displayed on the live (public) site 
pages by replacing the recommendation that would normally appear there.

About Promotions and Recommendations
“Recommendation” assets are the delivery mechanism for all promotional content. When 
you create a promotion asset, you determine where you want the promotion to be 
displayed by selecting a “Recommendation” asset. The promotion replaces, or overrides, 
the recommendation and uses the template assigned to that recommendation to render the 
promotion in place of the recommendation that would normally be displayed.

Consequently, when Engage calculates the recommendation that a template asks for, it 
automatically checks whether there are any promotions that should override the 
recommendation. If so, it passes the promotion back to the recommendation’s template 
and the template displays the promotion instead.

When Promotions Overlap
More than one promotion can use the same recommendation. What happens, then, when a 
visitor qualifies for more than one promotion and those promotions are using the same 
recommendation? It is easiest to explain with an example:

Example: Overlapping Promotions

There are two promotions running and both override the same recommendation:

Name: End-of-Summer Sale
Discount: 10% off the entire contents of the visitor’s shopping cart
Segments it 
applies to:

All segments
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Question: How does Engage decide which promotion to display if the visitor is from 
either the Home Office Worker segment or the Back to School segment? And which 
discount is applied? 

Answer: Engage randomly selects which promotion to display (each has a 50/50 chance) 
but it applies both discounts. However, applying both discounts does not mean that 
printers are discounted twice.

Examine the contents of this shopping cart:

Before Engage applies the discounts, it lists and compares the promotions for all the items 
in the cart:

Engage then applies the largest discount to each item. Therefore, on the final bill, the box 
of paper and the toner cartridge are 10% off and the printer is 30% off (not 40%).

Question: Only one of the promotions was displayed: how do the shoppers understand the 
total on the invoices?

Answer: If you (the marketers) created the promotions correctly, you entered a 
meaningful description of the discount in the Engage discount forms. Those descriptions 
are printed on the invoice next to the discounted items.

Name: Printer Sale
Discount: 30% off all printers
Segments it 
applies to:

1) Home Office Worker

2) Back to School

Note

Promotions do not have segment ratings. Either the promotion applies to the 
segment or it doesn’t.

Item in Cart

box of paper
printer
toner cartridge

Item in Cart Summer Sale Printer Sale

box of paper 10%
printer 10% 30%
toner cartridge 10%
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Creating Promotions
To create a promotion

Before you create your promotions, be sure that you complete the following tasks:

• Ask your site developers for a list of all the recommendations in your system and a 
description of where each one is programmed to appear.

• If you are creating promotions that apply to specific segments, you and the other 
marketers must create the segments.

Step 1: Name and Define the Promotion

1. Log in to WebCenter Sites, select the site you want to work with (FirstSite II in this 
example) and the icon for the WebCenter Sites Contributor interface.

2. In the menu bar, select Content > New > New Promotion.

If the administrator configured the asset type such that all new assets of that type are 
placed into workflow upon creation, a tab opens displaying the “Choose Assignees” 
form:

Select at least one user for each required role and click Set Assignees. Any of these 
users can complete the next step in the workflow process. For more information, see 
Chapter 14, “Workflow.”

Note

You can click Save as you progress through the sections of the “Promotion” form in 
this procedure to save the changes you have made up to and in that section.

Note

If New Promotion is not on the list, stop here. You do not have the permissions 
to create promotions. If you have questions about your permissions, contact your 
administrator.
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A tab opens displaying the “Promotion” asset’s Create view. Notice the names of the 
form’s sections near the top. The Name section of the form is displayed:

3. In the Name section of the “Promotion” form, do the following:

a. Click in the Name field and enter a unique, descriptive name for the 
recommendation. You can enter up to 64 alphanumeric characters, including 
spaces. The first character must be a letter.

b. Click in the Description field and enter a brief description of the promotion. You 
can enter up to 128 alphanumeric characters.

c. In the Start Date and End Date fields, select a date range for the asset to display 
in Site Preview. For more information on Start/End dates, see “About Start and 
End Dates,” on page 146.

d. Click Continue.

The tab displays the Goals section of the “Promotion” form, as shown in the next 
step.

Even though you can skip to any section of the “Promotion” form, be sure that you create 
your first promotions in the sequence that takes place when you use the Continue button. 
Remember that the information you enter on any form is not saved to the database until 
you click Save.

Note

When creating or editing a “Promotion” asset, you can switch between the 
sections of the form by clicking the name of the section you want to switch to.
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Step 2: Define the Goals for the Promotion

A statement of goals is useful if your work is to be reviewed by others. Additionally, you 
might want to document why you designed the promotion a certain way after the 
promotion is complete. 

In the Goals section of the “Promotion” form, do the following:

1. Click in the first Goal field and describe a goal.

2. Enter goals in the second and third Goal fields, as needed.

3. Click Continue.

The tab displays the “Segments” section of the “Promotions” form, as shown in the 
next step.

Step 3: Define Which Visitors Are Eligible for the Promotion

Use the Segments section of the “Promotion” form to select the visitors who are eligible 
for the promotion. If you do not make any selections on this form, all visitors to the site 
are eligible for the promotion.

1. Do one of the following:

- To offer the promotion to all visitors to the site, select Apply to all visitors.

- To restrict the promotion to visitors from certain segments, select Apply to 
selected segments and select the segments to whom you want to offer the 
promotion. 
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2. (Optional) If you need to create a new segment for the promotion, complete the 
following steps:

a. Create a new segment. For help with this step, see “Creating Segments,” on 
page 275.

b. Click the Refresh icon in the tab displaying the promotion you are creating. 

c. Repeat the first step in this procedure to include this segment in the promotion.

3. Click Continue.

The tab displays the “Discount” section of the “Promotion” form, as shown in the next 
step.

Step 4: Define the Discount

To define the discount, use the following options:

• Option 1: Discounting the Entire Shopping Cart

• Option 2: Discounting Specific Products

• Option 3: Discounting the Shipping Costs

You can combine either of the first two options with the third option, but you cannot 
combine the first two options.

Note

To configure the discount to be based on the current state of a visitor’s shopping cart, 
create a segment based on the shopping cart. Then, select that segment for the 
promotion. For information about creating segments based on the shopping cart, see 
“Step 4: Define the Segment with Shopping Cart Criteria,” on page 290.
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Option 1: Discounting the Entire Shopping Cart
In the “Discount” section of the “Promotion” form, do the following:

1. Select the second option under Purchases and then set the values that define the 
discount.

For example, to offer $5.00 off, set the values as follows:

To offer 10% off, set the values as follows:

2. Select Every product in the catalog.

3. Click in the Describe purchase discount text box and enter a meaningful description 
of the discount. The text that you enter in this field is displayed on the invoice or 
receipt next to the items that it applies to. Use it to describe to your visitors how their 
bill is calculated. For example:

4. Either click Continue or go to Option 3: Discounting the Shipping Costs.

Option 2: Discounting Specific Products
In the “Discount” section of the “Promotion” form, do the following:

1. Select the second option under Purchases and then set the values that define the 
discount.

For example, to offer $5.00 off, set the values as follows:

To offer 10% off, set the values as follows:

2. Select the products that the discount applies to:

a. Select Specific item(s) from the tree or docked search.

b. Select the products or product categories from the Content Tree, My Work tree, 
or docked search results list, and drag and drop the selected items into the 
“Drag Products” Drop Zone. 
Oracle WebCenter Sites User’s Guide



Chapter 18.  Creating Promotions

Creating Promotions
339
3. Click in the text box and enter a meaningful description of the discount. The text that 
you enter in this field is displayed on the invoice or receipt next to the items that it 
applies to. Use it to describe to your visitors how their bill is calculated. 

For example:

4. Either click Continue or go to the procedure Option 3: Discounting the Shipping Costs.

Option 3: Discounting the Shipping Costs
You can discount shipping in addition to, or instead of, discounting purchases. In the 
Discount section of the “Promotion” form, do the following:

1. Under Shipping Fees, set the values that define the discount.

For example, to offer 15% off shipping set the values as follows:

2. Click in the Describe shipping fee discount for display on invoices or receipts text 
box and enter a meaningful description of the discount. The text that you enter in this 
field is displayed on the invoice or receipt next to the items that it applies to. Use it to 
describe to your visitors how their bill is calculated. For example:

3. Either click Continue or go to the procedure Option 3: Discounting the Shipping Costs.

Option 4: Specifying a Store
You can specify the discount to apply to a certain store, if you have multiple stores. In the 
Store ID section, select the store.

1. Under Store ID, set the values that define the store discount.

2. Click Continue.

The tab displays the “Duration” section of the “Promotion” form, as shown in the next 
step.
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Step 5: Define the Promotion’s Duration

In the Duration section of the “Promotion” form, do the following:

1. Under Duration, set a start date and start time.

2. Specify when the promotion will end. Do one of the following:

- If you want the promotion to run until you delete it or change its duration, select 
Apply until deleted. Use this option if you are designing an ongoing promotion 
with an indefinite duration. When you want to cancel it, you can either delete it or 
you can edit it and apply an end duration date.

- If you want the promotion to run for a certain period of time after the start time 
that you specified in step 1, click Apply for. Enter a whole number (not a fraction 
or decimal) in the text box and choose hours, days, weeks, months, or years from 
the drop-down field.

- If you want the promotion to run until a specific date, select Apply until and enter 
the date and time that you want it to end. The current date and time are displayed 
by default.

3. Click Continue.

The Display section of the “Promotion” form appears, as shown in the next step.

Note

If you do not specify how long the promotion should run, the promotion runs until 
you delete it.
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Step 6: Advertise the Promotion on Your Site

In the Display section of the “Promotion” form, do the following:

1. Find the assets to be included in the recommendation and bookmark them (which adds 
them to the Bookmarks node in the My Work tree):

a. In the Search field, enter the desired search criteria (if any) and click the 
magnifying glass ( ) button.

b. If you want to narrow your search down to a specific type of asset, in the Search 
field, click the down-arrow to render the “Search Type” drop-down box. Select 
the asset type to which you want to limit your search. 

c. In the search results list, select (Ctrl+click) the assets you wish to bookmark. In 
the “Search” tab’s toolbar, click the Bookmark ( ) icon. 

For more information on searching for and bookmarking assets, see Chapter 6, 
“Finding and Organizing Assets.”

2. Drag and drop the asset that you want to use to advertise this promotion from your 
Bookmarks into the Drop Zone. (Typically a promotional banner is stored as either an 
article or an image.)

Note

If you select multiple assets, when the promotion is displayed on your site pages, 
Engage displays the content that was rated the highest for the segments that the 
visitor belongs to. In other words, if you are using this promotion for more than 
one segment, you can use segment-specific ad banners for the promotion.
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Once placed in the Drop Zone, the items appear on a list in the form with a drop-down 
list box of recommendations next to each name. For example:

3. In the Pick recommendation field next to the first item, select the name of the 
recommendation that you want to replace or override with this item. 
(The recommendation provides the location for the text you selected in step 2.)

For example:

4. Repeat step 3 for each item that you selected in step 2.

5. Save the asset. Do one of the following:

- In the asset’s toolbar, click the Save ( ) icon.

- In the menu bar, select Content, then select Save.

6. Inspect the asset. Do one of the following:

- In the asset’s toolbar, click the Inspect ( ) icon.

- In the menu bar, select Edit, then select Inspect.

Sample Promotion Asset
When you work with the FirstSite II sample site, you get a sample promotion asset, 
SummerSale. This promotion is designed to work in concert with the sample “Segment” 
and “Recommendation” assets (also available from the FirstSite II sample site). Use the 
sample promotion as a template for creating promotion assets for your site.

Publishing Promotions
After you create a promotion, it must be approved before it can be published to your 
delivery system. The promotion takes effect only after it is published. Be sure to examine 
or inspect your promotion to verify that you configured it correctly before you approve it 
for publishing.

For more information about approving assets, see Chapter 12, “Approval for Publishing.”
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Appendices
This part contains the following appendix:

• Appendix A, “The Flex Asset Model”

• Appendix B, “Navigational Reference”
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The Flex Asset Model
As a content provider, you do not need to understand all of the details of the flex asset 
model. The purpose of this appendix is to help you develop a general understanding of this 
data model and how it relates to you as a content provider.

This appendix contains the following section:

• Overview of the Flex Asset Model
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Overview of the Flex Asset Model
As mentioned in Chapter 1, “Overview,” WebCenter Sites developers use two asset data 
models to create asset types and define how asset data is stored in the WebCenter Sites 
database: the basic asset model and the flex asset model.

The flex asset model is more complex than the basic asset model. Unlike basic assets, 
where the information for one instance of an asset is stored in one row of a database table, 
the information for one instance of a flex asset is stored in multiple database tables.

Whereas basic asset types are standalone asset types, flex asset types are composed of 
families of asset types. The members of a flex family are:

• flex attribute type (required)

• flex asset type (required)

• flex definition (required)

• flex parent (required)

• flex parent definition (required)

• flex filter type (optional)

The members of a flex family form an asset inheritance tree, where child assets inherit 
various attributes from their parents.

As a content provider, you will not directly work with all of the members of the flex 
family. In fact, you will mainly be working with flex assets, which are the key members of 
flex families (all of the other members of a flex family contribute to the flex asset in some 
way). If you have the appropriate permissions, you may also be responsible for creating 
new flex attributes, which are characteristics of flex assets.
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Navigational Reference
This appendix provides a navigational reference briefly explaining the functions of the 
most commonly used components of the Contributor interface.

This quick reference provides information about the following:

• Menu Bar

• Navigation Pane

• Workspace: Home Tab

• Workspace: Asset Tab

• Search/Browse Tab

• Split View: Asset Tab and Search Results List

• Icons
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Menu Bar

The menu bar contains the following options:

• Content – Opens a menu containing options to manage the assets you are currently 
working with. This includes: Creating an asset, saving an asset, approving an asset for 
publishing, bookmarking an asset, sharing an asset to another site, and setting access 
permissions for a specific asset.

• Edit – Opens a menu containing content management tools to inspect, modify, copy, 
and delete an asset. This menu also allows you to change the layout (template) 
assigned to an asset and work with revision tracking. 

• View – Opens a menu containing tools to view an asset in either Form Mode or Web 
Mode as well as options for previewing an asset in different ways, such as previewing 
an asset using a different layout (template) or site wrapper, or previewing an asset in a 
separate browser window. This menu also contains an option to view an asset’s status 
summary screen, which contains information about the asset’s workflow and approval 
status.
Oracle WebCenter Sites User’s Guide



Appendix B.  Navigational Reference

 Navigation Pane  
349
• Down-arrow icon – Click this icon to open the applications bar. When you first log in 
to WebCenter Sites, the applications bar is already open, in which case you will see an 
up-arrow icon which you can click to close the applications bar. The applications bar 
contains the following:

- Up to five of your most recently used applications. You can switch to a different 
application to which you have permissions without having to log back in to 
WebCenter Sites.

If you have permissions to access the WebCenter Sites Admin interface, the 
Admin application icon will be displayed to you in the applications bar. Clicking 
this icon opens the WebCenter Sites Admin interface.

- Your user name, which you can click to manage your profile (change your profile 
image, email, locale, time zone, and password).

- Sites drop-down menu, which enables you to switch to a different site to which 
you have permissions.

- Logout button, which ends your session and logs you out of WebCenter Sites.

Navigation Pane  

The navigation pane contains the following:

• Site Tree– Provides a hierarchical view of the way the pages on your site are 
organized, which helps you visualize the configuration of pages and allows you to 

Tip

Drag the right edge of the navigation pane to adjust the pane’s width. To hide the 
navigation pane, click the Hide Tree Navigation bar, located on the right edge of the 
navigation pane
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kouts” widget
place and unplace pages in the site’s hierarchy. The Site Plan tree also helps you 
understand the relationships and dependencies that exist for any given page. For 
instructions on placing and unplacing pages, see “Placing and Unplacing Pages,” on 
page 171.

• Content Tree– Shows the asset types and flex relationship hierarchies available in the 
current site. Double-click a parent asset to open a “Browse” tab, and view the 
associated child assets. For more information about flex relationship hierarchies, see 
“Parent-Child Relationships,” on page 161.

• My Work tree – Allows you to work with the My Work and History nodes. For more 
information, see “Organizing Assets,” on page 135. 

Workspace: Home Tab
The workspace is at the center of the Contributor interface. The Home tab is the first tab 
you see when you first log in to the Contributor interface. This tab contains your 
dashboard, as shown below.    

 

Note

You can return to the Home tab at any time by clicking the Home ( ) tab. The 
Home tab cannot be closed.

ookmarks” widget

artLists” widget

“Assign

“Chec
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The dashboard will look different from user to user. This is because your dashboard only 
displays information pertaining to you. You can even reposition the widgets on your 
dashboard by dragging and dropping the widgets into the desired location on the 
dashboard. The following provides information about the widgets you will see on your 
dashboard:

• Bookmarks – When you bookmark an asset for easy retrieval at a future time, the 
asset will be accessible from this widget. Bookmarked assets are also accessible from 
the Bookmarks node in the My Work tree. 

• SmartLists – A SmartList is search criteria that you have saved to use on a later date. 
This widget lists all of the SmartLists you have created and all of the SmartLists other 
WebCenter Sites users have shared with the role(s) you are assigned. 

• Assignments – Provides a summary of your present workload in the current site. 
From this widget you can access an asset that has been assigned to you during its 
workflow process and finish your assignments. 

• Checkouts – Provides a summary of the assets that are presently checked out to you. 

Bookmarks Widget
Bookmarking assets enables you to quickly access those assets at a future time. 
Bookmarked assets are listed under the Bookmarks node in the My Work tree and in the 
“Bookmarks” widget on your dashboard, as shown below:

You can access a bookmarked asset by clicking the asset’s name in the “Bookmarks” 
widget. You can also remove an asset from the list of bookmarked assets by selecting the 
desired asset’s row and clicking Delete Bookmark. The asset is removed from the 
“Bookmarks” widget and from the Bookmarks node in the My Work tree. 

For more information about bookmarking assets, see “Bookmarking Assets,” on page 136.
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SmartLists Widget
You create a SmartList by conducting a search and then saving the search criteria you used 
to render the results of that search. Once a SmartList is created it is automatically made 
accessible in the “SmartList” widget. If another WebCenter Sites user created a SmartList 
and shared it to one or more of your assigned roles you will also see that SmartList in your 
“SmartLists” widget.

For more information about SmartLists, see “Saving Your Search Criteria (Creating 
SmartLists),” on page 131.

Assignments Widget
If workflow is enabled for an asset type on the site you are currently working with, the 
“Assignments” widget lists all of the assets currently assigned to you, as shown below:

In the “Assignments” widget, you can work with an asset that has been assigned to you 
and finish an assignment in order to pass it through to the next step in the workflow 
process. For more information about workflow, see Chapter 14, “Workflow.”
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Checkouts Widget
If revision tracking is enabled for an asset type on the site you are currently working with, 
the “Checkouts” widget displays a list of assets that have been checked out by you, as 
shown below:

For more information about revision tracking, see Chapter 13, “Revision Tracking.”
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Workspace: Asset Tab
When you log in and access an asset, a tab opens in the workspace displaying the asset in 
either Form Mode or Web Mode. Depending on whether you are creating, editing, or 
inspecting the asset determines the view in which the tab displays the asset. There is no 
limit to the amount of tabs that can be opened in the workspace at one time.

• Asset tab displaying the Inspect view of an asset in Form Mode:

set toolbar

rm section 
lector
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As
• Asset tab displaying the Inspect view of an asset in Web Mode:

Asset Toolbar
The asset toolbar is available in both Form Mode and Web Mode and allows you to initiate 
the most commonly used content management functions, such as editing, saving, 
inspecting, and previewing an asset.

The asset toolbar is dynamic; that is, it displays different functions based on the following:

• The content management task you are performing at the time

• Whether you have the permissions necessary to perform a select task

• Whether content management functions, such as revision tracking, are enabled for the 
asset type and site with which you are currently working.

set toolbar
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Form Section Selector
When you work with an asset in Form Mode, the tab displays the content entry form of 
that asset. An asset’s form is divided into sections, accessible via the form section selector. 
Your administrator has the ability to customize asset forms (and their individual sections) 
on your site, as well as grant or deny you permissions to access specific form sections.

Table 7 lists the form sections available by default in a WebCenter Sites implementation.

Table 7: Form sections

This section Allows you to...

Content View and edit the content stored in the asset.

For more information, see Chapter 3, “Creating, Sharing, and 
Editing Assets in Form Mode” and Chapter 4, “Creating, Sharing, 
and Editing Assets in Web Mode.”

Marketing View and edit Engage options for the asset.

For more information, see Part 3, “Using Oracle WebCenter Sites: 
Engage Assets.

Metadata View the asset’s metadata, such as creation date, modification date, 
asset ID, and any asset-specific attributes.

Assign a start and end date (for more information, see “Assigning 
Start and End Dates,” on page 151).

Modify the asset’s Locale setting (for more information, see 
“Setting or Changing an Asset’s Locale Designation,” on 
page 204).
Oracle WebCenter Sites User’s Guide



Appendix B.  Navigational Reference

 Search/Browse Tab  
357

“Searc
toolbar

Search 
results li

“Searc
option
Search/Browse Tab
The “Search” tab opens when you conduct a search or advanced search in the Contributor 
interface and displays a list of assets matching your search criteria, as shown below:  

The “Search” tab consists of the following components:

• Search toolbar  – Enables you to approve, bookmark, and delete assets listed in the 
“Search” tab, as well as to refresh the search results list.

• Search list options bar – Enables you to dock the search results list to the right of 
your workspace, save the search criteria you used to conduct the search, and toggle the 
search results list between thumbnail view and list view. This bar also provides search 
query tips. 

If the search results list is docked to the right of the workspace, you will also see a 
Sort menu that enables you to sort the results of your search.

• Search results list – Displays a list of assets matching your search criteria. Clicking 
an asset’s name in the list opens a tab displaying that asset’s Inspect view. Right-
clicking an asset’s name in the list displays a context menu for that asset containing 
content management options you can perform.

For more information about conducting a search, see Chapter 6, “Finding and Organizing 
Assets.”

The “Browse” tab displays a list of assets returned by performing the following content 
management functions:

• Double-clicking the Bookmarks node in the My Work tree – the “Browse” tab opens 
displaying a list of bookmarked assets. For more information, see “Accessing 
Bookmarked Assets,” on page 137.

h” 
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h” list 
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• Double-clicking a parent asset in the Content Tree – the “Browse” tab opens 
displaying a list of children belonging to the parent. See “Additional Ways of 
Accessing Assets,” on page 60.

The “Browse” tab consists of the same components as the “Search” tab. The only 
difference is that you will not see the Create SmartList option in the Browse list options 
bar. Since this list of assets is returned by either double-clicking a parent asset in the 
Content Tree or double-clicking the Bookmarks node in the My Work tree, there is no 
search criteria to save as a SmartList.
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Split View: Asset Tab and Search Results List
The first time you search for an asset after logging in, the list of returned assets fills the 
workspace in a “Search” tab. When you click an asset in the list, a separate tab opens in 
the worskpace and displays the asset you selected. If you switch back to the “Search” tab 
and click Dock, the search results will be docked to the right of the tab displaying the asset 
(as shown below). This enables you to view the asset and the search results list 
simultaneously. 

Here is an example view of the workspace with the search results list docked to the right of 
a tab displaying an asset’s Inspect view in Form Mode:

Tip: When a tab is open displaying an asset in its Edit view and you perform a search, the 
search results list is automatically docked to the right of the asset’s tab.

• If you want to see the search results in a “Search” tab, click Undock in the search 
results pane.

• If you want to close the search results list, click the X icon.

Asset Tab Docked search 
results list

Split View

Click this icon to display the 
search results in a “Search” tab

Click this icon to close the 
search results list
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Icons
The tables below shows icons you may see in your interface, depending on your 
permissions. 

Table 8: Asset Toolbar Icons 

This icon Allows you to...

Edit:

Click to display the asset in its Edit view, where you can modify the 
asset.

This icon is disabled (grayed out) if you do not have permission to 
edit an asset.

Inspect

Click to display the asset in its Inspect view. 

Preview:

Click to display the preview of the asset.

This icon is disabled (grayed out) if you do not have permissions to 
preview the asset.

Save:

Click to save the changes you have made to an asset so far, but keep 
the asset’s “Edit” form open.

Delete:

Click to manually delete an asset.

This icon is disabled if you do not have permissions to delete assets.

Approve:

Click to approve the asset for publishing.

This icon is disabled (grayed out) if you do not have permissions to 
approve an asset.

Change Template:

Click to select another template for the asset you are working with. 
The template you choose will determine how the asset is rendered on 
the website.

This icon is disabled (grayed out) if you do not have permissions to 
change the template of the asset.
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Check Out:

If revision tracking is enabled for this type of asset, click this icon to 
check the asset out to you. Other users will not be able to make 
changes to this asset until you check the asset back in.

This icon is disabled (not shown) if the asset is not being revision 
tracked. 

Check In:

If revision tracking is enabled for this type of asset, and the asset is 
checked out to you, click this icon to check the asset back in. Now 
other users will be able to work with the asset.

This icon is disabled (not shown) if the asset is not being revision 
tracked and/or the asset is not checked out to you. 

Undo CheckOut:

If revision tracking is enabled for this type of asset, click this icon to 
undo the check out.  

This icon is disabled (not shown) if the asset is not being revision 
tracked.

Rollback:

If revision tracking is enabled for this type of asset, click this icon to 
go roll the asset back to a previous version.

This icon is disabled (not shown) if the asset is not being revision 
tracked.

Show Versions:

If revision tracking is enabled for this type of asset, click this icon to 
display the asset’s revision history report.

This icon is disabled (not shown) if the asset is not being revision 
tracked.

Checkin/Checkout

Displayed in an asset’s toolbar when the asset is displayed in Web 
Mode. Click this icon to perform revision tracking functions on the 
primary asset (asset with which you are working) and all the assets 
displayed in the primary asset’s web page view.

This icon is always displayed, even if revision tracking is disabled.

Table 8: Asset Toolbar Icons  (continued)

This icon Allows you to...
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